IBM Cognos Controller
Version 10.4.1

Installation and Configuration

IBM
Note
Before using this information and the product it supports, read the information in “Notices” on page 137.

Product Information
This document applies to IBM® Cognos Controller version 10.4.1 and may also apply to subsequent releases.

Licensed Materials - Property of IBM

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Chapter 1. Introduction ....................................................................................................................... 1

Chapter 2. What's new? ........................................................................................................................ 3
   New features in version 10.3.1 .............................................................................................................. 3
   Cognos Business Intelligence components removed ............................................................................ 3
   New features in version 10.3.0 .............................................................................................................. 3
   Controller Web .................................................................................................................................... 3
   32-bit and 64-bit version of Cognos Controller client ............................................................................. 3
   New features in version 10.2.1 .............................................................................................................. 3
   Load balancing ...................................................................................................................................... 4
   New features in version 10.2 .................................................................................................................. 4
   Fewer prerequisites .............................................................................................................................. 4
   64-bit and .NET Framework technology on Controller server .............................................................. 4
   Multi-threaded batch service .................................................................................................................. 4
   Support for additional software environments .................................................................................... 4
   Changed features in version 10.2 ......................................................................................................... 5
   Changes to web server configuration ................................................................................................... 5
   Automatic COM+ server configuration ................................................................................................. 5
   Deprecated features in version 10.2 ...................................................................................................... 5
   Support for Microsoft Windows platforms ............................................................................................ 5
   Support for Microsoft Windows Excel versions .................................................................................... 5

Chapter 3. Components Used by IBM Cognos Controller ................................................................. 7
   Server Components ............................................................................................................................. 7
   Interfaces .............................................................................................................................................. 7
   Gateway Components .......................................................................................................................... 8
   Application Tier Components ............................................................................................................ 8
   Content Manager Components .......................................................................................................... 8
   Cognos Controller Web ........................................................................................................................ 9
   Other Components ............................................................................................................................... 9

Chapter 4. Installation Options .......................................................................................................... 11
   All Components on One Computer ...................................................................................................... 11
   Components Distributed on Multiple Computers .............................................................................. 12
   Distributing Components in a Role-based Configuration .................................................................... 12
   Distributing Components for Load Balancing of the Consolidation Functions ................................... 14
   Integrating Cognos Controller with other IBM Cognos products ....................................................... 16

Chapter 5. Workflow for Installing and Configuring Cognos Controller ........................................... 17
   Prepare for Implementation ................................................................................................................ 17
   Set up the Environment ........................................................................................................................ 17
   Install IBM Cognos Controller .......................................................................................................... 17
   Configure IBM Cognos Controller .................................................................................................... 18
   Configure Security .............................................................................................................................. 18
   Test IBM Cognos Controller .............................................................................................................. 18
   Administer IBM Cognos Controller ................................................................................................... 18

Chapter 6. Setting Up the Environment ............................................................................................... 21
   Review the release notes before you install ...................................................................................... 21
   Review Supported Environments ....................................................................................................... 21
System requirements......................................................................................................................... 21
Verifying supported software versions and hardware requirements................................................. 24
Create an IBM Cognos Controller Database...................................................................................... 24
Create an IBM Cognos Controller Database for DB2........................................................................... 25
Create an IBM Cognos Controller Database for Microsoft SQL Server........................................... 26
Create an IBM Cognos Controller Database for Oracle..................................................................... 26
Configure your web browser.................................................................................................................. 27
Cookie settings..................................................................................................................................... 27
Install and Configure Microsoft .NET Framework.................................................................................. 28
Install server roles and features............................................................................................................ 28

Chapter 7. Upgrading IBM Cognos Controller.............................................................................. 31
Planning the Upgrade.......................................................................................................................... 31
Review the Documentation................................................................................................................... 32
Consolidation Model............................................................................................................................... 33
Recommendation - Assess Applications in the Source Environment.................................................. 33
Recommendation - Perform a Trial Upgrade........................................................................................ 34
Create the Test Environment.............................................................................................................. 35
Plan Your Deployment......................................................................................................................... 35
Create an Export Deployment Specification.......................................................................................... 37
Copy the Deployment Specification to the Test Environment.............................................................. 38
Include Configuration Objects in Import of Entire Content Store...................................................... 39
Import to the Test Environment.......................................................................................................... 39
Test the Deployed Content.................................................................................................................. 40
Recommendation - Test the Upgraded Content.................................................................................. 40
Moving to the Production Environment................................................................................................ 41
Install or Upgrade Other Products........................................................................................................ 42
Back Up Your Application Data............................................................................................................ 42
Uninstall the Older Version of IBM Cognos Controller........................................................................ 43
Install the New Version of IBM Cognos Controller............................................................................. 43
Apply the New Configuration................................................................................................................ 44
Upgrading your application databases.................................................................................................. 44
Optimizing Oracle database.................................................................................................................. 45
Upgrading to a New Computer............................................................................................................ 45

Chapter 8. Installing and Configuring IBM Cognos Controller on One Computer..... 47
Install Cognos Controller...................................................................................................................... 48
Installing fix packs................................................................................................................................. 48
Update the Java Environment............................................................................................................... 49
Set Up Database Connectivity for the Controller Database............................................................... 50
Using JDBC drivers for IBM Cognos Controller.................................................................................. 51
Set Up Database Connectivity for the Controller Data Mart................................................................ 51
Start IBM Cognos Configuration......................................................................................................... 52
Configure the web server ...................................................................................................................... 52
Connecting Cognos Controller to Cognos Analytics or Cognos Business Intelligence....................... 53
Set Database Connection Properties for the Controller Data Source................................................ 53
Verifying connectivity to the Controller database............................................................................... 55
Default Settings for IBM Cognos Controller........................................................................................ 55
Default Settings for the Gateway, Content Manager, and Report Server......................................... 55
Default Settings for Controller Web Services Server and Controller Client Distribution Server........... 56
Installing the client interfaces.............................................................................................................. 56
Enabling access to Cognos Controller from Cognos Business Intelligence......................................... 57
Install the IBM Cognos Controller Link for Microsoft Excel ................................................................ 57
Set Up the Data Source Environment for Framework Manager.......................................................... 58
Installing Cognos Controller Financial Analytics Publisher................................................................. 60
Enable Access to the COM+ Server..................................................................................................... 65
Test the IBM Cognos Controller Installation and Configuration.......................................................... 65
Chapter 9. Load balancing in IBM Cognos Controller ............................................. 71

Chapter 10. Configuring Authenticated Access ................................................... 73

Chapter 11. Additional Configuration Options .................................................... 87

Chapter 12. Setting Up an Unattended Installation and Configuration .................. 99
Chapter 13. Financial Statement Reporting integration for IBM Cognos Controller ................................................................. 105
  IBM Cognos FSR access to IBM Cognos Controller .......................................................................................................................... 105
  Integration of Controller with Cognos FSR using anonymous access authentication ................................................................. 106
  Integration of Controller with Cognos FSR using Cognos Access Manager authentication ................................................................. 107
  Integration of Controller with Cognos FSR using Cognos Controller native authentication ................................................................. 109

Chapter 14. Configuring Cognos Controller Web ................................................................................................................................. 111
  Modifying UDL files ........................................................................................................................................................................ 112
  CAM Authentication ........................................................................................................................................................................ 112

Chapter 15. Cognos Disclosure Management integration for Cognos Controller ........................................................................... 115
  IBM Cognos Controller and IBM Cognos Disclosure Management ................................................................................................... 116
  OLAP data sources in Cognos Disclosure Management ................................................................................................................ 116
  Adding a TM1 data source in IBM Cognos Disclosure Management ................................................................................................. 116
  Loading data into Excel objects from Cognos Controller ................................................................................................................ 118

Appendix A. Accessibility features .................................................................................................................................................. 121
  Keyboard Shortcuts for the Installation Wizard ................................................................................................................................. 121

Appendix B. Troubleshooting .................................................................................................................................................................. 123
  Troubleshooting checklist ......................................................................................................................................................... 123
  Troubleshooting resources ........................................................................................................................................................ 124
  Support Portal ........................................................................................................................................................................ 124
  Problems Starting IBM Cognos Controller ........................................................................................................................................ 128
    The Controller Link Is Missing in IBM Cognos Connection .......................................................................................................... 128
    Warning! You Are About to Navigate Away from This Page ....................................................................................................... 128
    You Receive No Response When Starting IBM Cognos Controller ............................................................................................. 128
    Error - Page Cannot Be Found When Starting IBM Cognos Controller ...................................................................................... 129
    After Upgrading, You Cannot Start IBM Cognos Controller .................................................................................................. 129
    Error - VMWare Can't Run the ccr.exe File ........................................................................................................................................ 129
    An Error Occurred While Trying to Access the Server .................................................................................................................. 130
    Error - No Database Configured .................................................................................................................................................. 131
    Error - The File Is Not a Valid Compound File .............................................................................................................................. 131
    Error - Another Session of IBM Cognos Controller Is Already Running .......................................................................................... 131
    Error QE-DEF-0288 - Unable to find the data source .................................................................................................................. 132
  Problems Starting the IBM Cognos Controller Link for Microsoft Excel .................................................................................................. 132
    After Upgrading, ControllerXLPusher Error Occurs When Starting Microsoft Excel ................................................................. 132
  Problems configuring IBM Cognos Controller Financial Analytics Publisher .......................................................................................... 133
    JCAM_Crypto_JNI-dll is not a valid Win32 application ............................................................................................................... 133
    NGTM1JNI.dll is not a valid 32-bit application .............................................................................................................................. 133
  Slow performance of Cognos Controller ........................................................................................................................................ 133
    Disabling .NET certificate checking for all applications .................................................................................................................. 134
    Disabling certificate checking for Microsoft Excel ....................................................................................................................... 134
    Disabling certificate checking for Cognos Controller .................................................................................................................. 134
    Disabling certificate checking for Microsoft ASP.NET ............................................................................................................. 135

Notices ................................................................................................................................................................................................. 137
  Trademarks .................................................................................................................................................................................. 138

Glossary .................................................................................................................................................................................................. 141
  A ................................................................................................................................................................................................. 141
  B ................................................................................................................................................................................................. 141
  C ................................................................................................................................................................................................. 142
  D ................................................................................................................................................................................................. 142
  E ................................................................................................................................................................................................. 142
<table>
<thead>
<tr>
<th>Letter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>143</td>
</tr>
<tr>
<td>G</td>
<td>143</td>
</tr>
<tr>
<td>I</td>
<td>143</td>
</tr>
<tr>
<td>J</td>
<td>143</td>
</tr>
<tr>
<td>L</td>
<td>143</td>
</tr>
<tr>
<td>M</td>
<td>144</td>
</tr>
<tr>
<td>O</td>
<td>144</td>
</tr>
<tr>
<td>P</td>
<td>144</td>
</tr>
<tr>
<td>R</td>
<td>144</td>
</tr>
<tr>
<td>S</td>
<td>144</td>
</tr>
<tr>
<td>T</td>
<td>145</td>
</tr>
<tr>
<td>W</td>
<td>145</td>
</tr>
</tbody>
</table>

**Index** ................................................................................................................................. **147**
Chapter 1. Introduction

This document is intended for use with IBM Cognos® Controller. This guide contains instructions for installing, configuring, and testing IBM Cognos Controller.

IBM Cognos Controller is a Web-based financial consolidation tool that provides standard reports to support both statutory and management reporting.

Audience
To use this guide, you should be familiar with
• database and data warehouse concepts
• security issues
• basic Windows administration
• the existing server environment and security infrastructure in your organization

Finding information
To find product documentation on the web, including all translated documentation, access IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Forward-looking statements
This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Accessibility features
Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. This product has accessibility features. For information on these features, see the accessibility section in this document.
Chapter 2. What's new?

This section contains a list of new, changed, and deprecated installation and configuration features for this release.

It also contains a cumulative list of similar information for previous releases. It will help you plan your upgrade and application deployment strategies and the training requirements for your users.

For information about upgrading, see the installation and configuration guide for your product.

For an overview of new IBM Cognos Controller functionality for this release, see the Controller New Features.

To see an up-to-date list of environments supported by Cognos Controller, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, run the Software Product Compatibility Reports (http://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/prereqsForProduct?deliverableId=AF89C710264211E98D5DA703D189F003).

New features in version 10.3.1

The following features are new in the 10.3.1 version of IBM Cognos Controller.

**Cognos Business Intelligence components removed**

The IBM Cognos Controller installation kit no longer includes IBM Cognos Business Intelligence components.

You must install your own version of IBM Cognos Business Intelligence or IBM Cognos Analytics, including the components that are required for Cognos Controller. For more information, see “System requirements” on page 21.

New features in version 10.3.0

The following features are new in the 10.3.0 version of IBM Cognos Controller.

**Controller Web**

As of IBM Cognos Controller version 10.3, you can use Cognos Controller Web.

Cognos Controller Web is a web application designed for a reporting site user who needs to report for one or more subsidiaries into the group’s financial consolidation. Controller Web is installed together with the IBM Cognos Controller client. All configuration and maintenance will be done in the Cognos Controller rich client. Cognos Controller is integrated with various IBM Cognos products to provide a complete solution for analysis and reporting.

**32-bit and 64-bit version of Cognos Controller client**

As of IBM Cognos Controller 10.3.0, you can use a 32-bit or 64-bit version of the Controller client.

Use one of the following versions:

- ccrlocalclient64.msi for installation on Microsoft Windows 64-bit
- ccrlocalclient32.msi for installation on Microsoft Windows 32-bit

New features in version 10.2.1

The following features are new in the 10.2.1 version of IBM Cognos Controller.
Load balancing

As of IBM Cognos Controller 10.2, you can use multiple Cognos Controller application servers to balance the load.

If you balance the load, then the work of the Cognos Controller Server is divided between separate Microsoft Windows servers.

Load balancing can be achieved in the following ways:

• Scaling up: If you add more CPU cores or more memory to a Cognos Controller application server, then the Cognos Controller application server uses the improved hardware.

• Scaling out: If you add more separate Cognos Controller application servers, then you can spread the load between these separate servers. For more in formation, see “Load balancing with multiple IBM Cognos Controller application servers” on page 71.

New features in version 10.2

The following features are new in the 10.2 version of IBM Cognos Controller.

Fewer prerequisites

You no longer need to install two of the prerequisites that were required in releases prior to IBM Cognos Controller 10.2.

The following components are not required in Controller 10.2:

• SOAP toolkit
• Microsoft SQL Server 2005 Backward Compatibility Components

64-bit and .NET Framework technology on Controller server

In IBM Cognos Controller 10.2, the Controller server leverages 64-bit and .NET Framework technology.

64-bit technology makes the Controller server more stable because it is less likely to run out of memory. It also allows more users to access the Controller server simultaneously.

The majority of the Controller server code has moved from COM+ into Microsoft Internet Information Services (IIS). This has resulted in improved performance and throughput and has simplified configuration.

For more information, see “Automatic COM+ server configuration” on page 5.

Multi-threaded batch service

In IBM Cognos Controller 10.2, the four previous batch services have been replaced with one, multi-threaded batch service.

By using a single service, batch processes can no longer be run mistakenly by two or more services. Also, customers can now modify the polling frequency of the batch queue, allowing scheduled jobs to run more quickly.

For more information, see “Enabling the batch service” on page 95.

Support for additional software environments

IBM Cognos Controller 10.2 supports additional software environments.

For example, the following operating systems and software are now supported:

• Microsoft Excel 2013
• Microsoft Windows 8.1 64-bit
• Microsoft Windows Server 2012 EE 64-bit
• SQL Server 2012
Note: To review an up-to-date list of environments supported by IBM Cognos Controller 10.2, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, see the IBM Cognos Controller 10.2 Supported Software Environments site (http://www.ibm.com/support/docview.wss?uid=swg27041444).

**Changed features in version 10.2**

The following features are changed in the 10.2 version of IBM Cognos Controller.

**Changes to web server configuration**

In IBM Cognos Controller 10.2, there are mandatory new settings in Microsoft Internet Information Services (IIS).

In IIS, the application pool used for Controller must have the following settings:

- The Enable 32 bit applications field must be set to False
- The .NET framework version field must be set to v4.5
- The Process model identity must be set to LocalSystem

For more information, see “Configure the web server ” on page 52.

**Automatic COM+ server configuration**

In IBM Cognos Controller 10.2, configuration of the COM+ server is done automatically.

In previous versions of IBM Cognos Controller, you were required to manually configure the COM+ server in Controller Configuration. In 10.2, this configuration is done automatically. Also in 10.2, the Controller server code has been converted from Microsoft Visual Basic 6.0 (VB6) to Microsoft Visual Basic .NET (VB.NET). Most of the dynamic link libraries (dlls) that previously ran in COM+ now run in Microsoft Internet Information Services (IIS).

**Deprecated features in version 10.2**

A deprecated feature is one that is being replaced by a newer version or a better implementation. The intention is to discontinue the use of the feature and provide recommendations for adapting to this change over multiple releases.

The following features are deprecated.

**Support for Microsoft Windows platforms**

IBM Cognos Controller no longer supports Microsoft Windows Server 2003 (32-bit), Microsoft Windows Vista, or Microsoft Windows XP.

**Support for Microsoft Windows Excel versions**

IBM Cognos Controller no longer supports Microsoft Excel 2003 or Microsoft Excel XP 2002 SP3.
IBM Cognos Controller is a Web-based solution designed to address financial consolidation needs and to support statutory and management reporting requirements.

IBM Cognos Controller integrates easily into your existing infrastructure by using resources that are in your environment. Some of these existing resources are required, such as a Java™ Virtual Machine or other databases for the content store. Other resources are optional, such as using other security providers for authentication.

You must also have IBM Cognos Business Analytics or IBM Cognos Business Intelligence installed.

By default, the IBM Cognos Controller reporting components use the IBM Websphere application server.

Server Components

Server components provide the user interfaces for reporting and product configuration, as well as the server functionality for routing and processing user requests. Server components are organized into five functional groups: interfaces, gateway components, application tier components, content manager components, and Controller Web.

Interfaces

The following user interfaces are available for using and configuring IBM Cognos Controller.

IBM Cognos Controller

IBM Cognos Controller provides the user interface for financial consolidation. IBM Cognos Controller is accessible through IBM Cognos Connection, and by using a URL.

To access IBM Cognos Controller, click the Controller link that appears in the IBM Cognos Welcome page. You can also click the Controller link that appears on your home page, if one is defined. When you click the Controller link, the Controller Client Distribution Server uploads Controller client components to your computer and then IBM Cognos Controller runs.

Within IBM Cognos Controller, the IBM Cognos Controller Link for Microsoft Excel extends the functionality of Microsoft Excel for creating individual forms and provides templates for manual data entry.

For information about using IBM Cognos Controller, see Using Controller.

IBM Cognos Controller Configuration

IBM Cognos Controller Configuration is a Microsoft Windows operating system interface that you use to configure IBM Cognos Controller data sources, set security, and administer system-wide IBM Cognos Controller settings.

Cognos Controller Financial Analytics Publisher client

With IBM® Cognos® Controller Financial Analytics Publisher you can connect the IBM Cognos Controller database to the IBM Cognos Controller Financial Analytics Publisher client so that you can publish data in a TM1® cube and access IBM Cognos Controller values from TM1®.
**Gateway Components**

The IBM Cognos Controller gateway components provide web communication and access for client computers and connect the Cognos Controller installation to an existing Cognos Business Intelligence or Cognos Analytics server.

**Controller Client Distribution Server**

Controller Client Distribution Server provides access to IBM Cognos Controller for client computers. The client components are downloaded from the Controller Client Distribution Server when IBM Cognos Controller is launched through a web browser on a client machine.

**Gateway Integration Enabler**

The Gateway Integration Enabler updates the gateway to make it aware of both the IBM Cognos Controller and reporting components.

**Application Tier Components**

Application tier components provide the server functionality for processing and routing requests to an IBM Cognos Business Intelligence or IBM Cognos Analytics reporting server.

**Controller Web Services Server**

Controller Web Services Server handles requests for activities within IBM Cognos Controller, such as working with accounts, consolidations, companies, and dimensions. Controller Web Services Server also manages data source connections and security information, as well as preparing data in the IBM Cognos Controller database for reports.

Depending on how you have configured security, the Web Services Server may access other components before processing requests, such as authenticating users.

A COM+ application is created when the Web Services Server is installed. This application runs within the Microsoft component services and provides most of the IBM Cognos Controller business logic, such as retrieving report templates and preparing data in the Controller database for reports.

**IBM Cognos Connection Integration Enabler**

The IBM Cognos Connection Integration Enabler activates the links in IBM Cognos Connection that users click to access IBM Cognos Controller. These links are available from the IBM Cognos Connection Welcome page and the home page.

**Content Manager Components**

The IBM Cognos Controller Content Manager components support the data functionality for the IBM Cognos Business Intelligence or IBM Cognos Analytics Content Store and the Controller database.

**Controller Standard Reports Package**

Report Server uses information in the Controller standard reports package, a Framework Manager package provided with IBM Cognos Controller, to determine the structure of data in the Controller database. The package contains preformatted templates that are used to obtain the data necessary for rendering the standard reports that are available with IBM Cognos Controller. You do not need to install IBM Cognos Framework Manager to use the standard reports package.
Controller Framework Manager Model

You can use the Framework Manager model provided with Controller to author custom reports. This Publish to Data Mart Framework Manager model is provided as a template for reporting against a Controller data mart database. You can also customize the model in IBM Cognos Framework Manager before creating the reports in IBM Cognos Report Studio.

To use this model, you must use Framework Manager from your IBM Cognos Business Intelligence or IBM Cognos Analytics installation.

Cognos Controller Web

IBM Cognos Controller Web is a web application specifically designed for users who support the financial consolidation process of the group by entering reconciled data on subsidiary level.

Other Components

In addition to the tools provided with IBM Cognos Controller, the following components use other resources.

Controller Database

Data sources, such as relational databases or other physical data stores, are used as the Controller database, which contains the data that the clients work with in IBM Cognos Controller.

Application Tier Components use data source connections to access the Controller database.

At least one database and its data source connection must be available before users can use IBM Cognos Controller. If more than one Controller database is available, each database must be the same Controller database version. For more information about database versions, see Installing and Configuring Controller.

If more than one Controller database is available, the administrator determines whether users can select the database they want to use or whether one is provided by default. Administrators can choose to let users select a database from a list that appears when IBM Cognos Controller starts. If no selection is allowed, users can access only the default database.

To enable the Web Services Server to connect to the Controller database, ensure that you install the database API software on each Web Services Server computer.

Controller Data Mart Database

A Controller data mart database is required if you use the Publish to Data Mart Framework Manager model provided with IBM Cognos Controller. By using the Publish to Data Mart functionality in Controller, you can publish data and structures from a Controller database to the data mart database. After it is populated, you can use the Controller data mart database for custom reporting using the Controller Publish to Data Mart Framework Manager model.
Chapter 4. Installation Options

Before implementing IBM Cognos Controller, decide how you will install and configure it to provide the best possible performance. The installation and configuration choices that produce the best performance depend on your requirements, resources, and preferences.

Before you install Cognos Controller you must have either IBM Cognos Analytics or IBM Cognos Business Intelligence installed.

When you assess your installation options for Cognos, you must consider whether you are installing the product for the first time or upgrading. For information, see Chapter 7, “Upgrading IBM Cognos Controller,” on page 31.

If your environment includes other IBM Cognos products, you must consider how Cognos Controller fits into that environment.

All Components on One Computer

Install all server components on one computer only for proof of concept or in demonstration environments where the user load is small. Because the gateway must be located with the Web server, the single computer must also be running a Web server.

This section refers to the gateway, application tier components, Content Manager, and Content store. These components are all part of IBM Cognos Business Intelligence or IBM Cognos Analytics and must be installed as part of those products.

In the following diagram, all Controller server components are installed on one computer, and the client applications are installed on another.

The following diagram provides a more detailed view of a IBM Cognos Controller installation in which all server components are installed on a single computer. The client components, content store, IBM Cognos Controller databases, and Controller data mart database are located on separate computers.
Components Distributed on Multiple Computers

You can distribute components on multiple computers to improve performance, availability, capacity, and security. You can use two or more computers and start the distribution by first distributing the gateway, then the Content Manager components, then the Application Tier components, and finally adding multiple Controller Web Services servers until you achieve optimal performance.

This section refers to the gateway, application tier components, Content Manager, and Content store. These components are all part of IBM Cognos Business Intelligence or IBM Cognos Analytics and must be installed as part of those products.

Distributing Components in a Role-based Configuration

As shown in the following diagram, you can distribute the gateway, the reporting components, and the IBM Cognos Controller data calculation and consolidation components on separate computers.
The gateway is on a separate Web server computer. If the gateway is located outside the firewall, as in this configuration, you must also install the Controller Client Distribution Server on the gateway computer so it can communicate with the external clients. A separate computer serves as the reporting services server with Content Manager, Report Server, and related IBM Cognos components installed. Another computer serves as the Controller Web server with the Controller Web Services Server installed to do the data consolidations, and the Controller Client Distribution Server installed to communicate with the internal clients.

The report modeler computer has IBM Cognos Framework Manager installed for using or customizing the Publish to Data Mart model provided with Controller.

The following diagram provides a more detailed view of this configuration.
Distributing Components for Load Balancing of the Consolidation Functions

You can build on the previous distribution example and further balance the load for the calculation and consolidation functions of IBM Cognos Controller.

In the following diagram, the components are distributed across several computers, and two computers are set up for consolidation load balancing.
In this example, you install Controller Web Services Server on two computers and then move the COM+ components that are used for consolidation to the second computer. The first computer serves as a request server and accepts user requests, but it does not perform consolidation tasks. You also install the Controller Client Distribution Server on this computer to communicate with the internal clients. The second computer serves as the consolidation server and does all the data calculations.

The following diagram provides a more detailed view of this configuration.
Integrating Cognos Controller with other IBM Cognos products

You can install IBM Cognos Controller in an environment with other IBM Cognos products by configuring a specific installation of IBM Cognos Business Intelligence or IBM Cognos Analytics or integrating it with an existing installation of IBM Cognos Business Intelligence or IBM Cognos Analytics. This allows the environments to share security settings and tools such as Report Studio.

IBM Cognos Business Intelligence users can access published Controller data and structures for analysis and reporting using Framework Manager and Report Studio. The Publish to Data Mart feature in IBM Cognos Controller publishes Controller data to the Controller data mart for access by a Framework Manager model.

IBM Cognos Controller users can import published data from IBM Cognos BI applications by using the Import from Framework Manager function in IBM Cognos Controller.

With the IBM Cognos Controller OLAP extension, you can create an OLAP cube of Controller data that can be used by IBM Cognos Business Intelligence users.

IBM Cognos Controller users can prepare actual values for export to IBM Cognos Planning – Contributor so that the data can be used in the planning process. The Send to Application function in IBM Cognos Controller creates a Microsoft Excel spreadsheet for import to external applications.

IBM Cognos Controller users can also import plans from Contributor so that the data can be consolidated. The necessary stored procedures and staging tables to do this import are in the Controller database and are delivered with IBM Cognos Controller. The Import from Flat Files feature in IBM Cognos Controller imports data from spreadsheets and text files.
Chapter 5. Workflow for Installing and Configuring Cognos Controller

You can use this workflow for installing and configuring IBM Cognos Controller.

**Procedure**

1. Prepare for implementation.
   
   This task is typically carried out by a team assembled and led by the business intelligence and solutions architect.

2. Install a supported version of IBM Cognos Business Intelligence or IBM Cognos Analytics.

3. Install and configure IBM Cognos Controller components.

4. Test IBM Cognos Controller installation and configuration.

5. Administer IBM Cognos Controller.

   Administrators establish and maintain security, and perform ongoing administration tasks.

---

**Prepare for Implementation**

Implementing IBM Cognos Controller means installing and configuring it to integrate effectively with your existing infrastructure.

To ensure that IBM Cognos Controller is implemented effectively, it is important to carefully outline your implementation using an implementation checklist.

**Note:** We recommend that you contact your IBM Cognos consultant before finalizing any server deployment. You can also visit IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter/SS9S6B/welcome).

---

**Set up the Environment**

You must set up resources in your environment so that the components can operate.

For more information, see Chapter 6, “Setting Up the Environment,” on page 21.

---

**Install IBM Cognos Controller**

Installing IBM Cognos Controller is typically done by information technology personnel under the direction of the business intelligence solutions architect.

When you install IBM Cognos Controller using the **Installation** wizard, you specify where to install these components:

- Gateway components, which includes Controller Client Distribution Server and Gateway Integration Enabler
- Application tier components, which includes Controller Web Services Server and IBM Cognos Connection Integration Enabler
- Content Manager components, which includes Controller Standard Reports Package and Controller Framework Manager Model
To deploy the Publish to Data Mart Framework Manager model that is provided with IBM Cognos Controller, you must also install Framework Manager.

You can install the components on one computer, or distribute them across a network. Before installing IBM Cognos Controller, choose the appropriate installation and configuration option Chapter 4, “Installation Options,” on page 11.

**Configure IBM Cognos Controller**

You use IBM Cognos Controller Configuration to do the initial configuration of Cognos Controller.

If you are using a computer with Microsoft Windows installed and the User Account Control (UAC) is turned on, IBM Cognos Controller Configuration is identified as an administrative application. You must run it with elevated administrative privileges. To properly save the configuration settings, the UAC prompts for credentials if you are using a standard account.

You configure the following items using IBM Cognos Controller Configuration:

**Security**

By default, native security is configured for the Controller database. If you want to set up security, configure security settings immediately after installing IBM Cognos Controller. For more information, see Chapter 10, “Configuring Authenticated Access,” on page 73.

**Data access**

Specify database connection information for at least one Controller database.

**Cognos Business Intelligence or Cognos Analytics integration**

Specify URIs for connecting to the gateway and dispatcher in Cognos Business Intelligence or Cognos Analytics.

**Configure Security**

IBM Cognos Controller can provide security by using native security, by integrating with an existing security infrastructure to provide user authentication, or by using Windows authentication. IBM Cognos Controller can secure content by using the user and group definitions from your security system, without any changes required. A Cognos namespace is included to provide the optional ability to define additional groups for securing content. These groups can simplify security administration by including users and groups from one or more authentication providers.

IBM Cognos Controller also provides an authorization facility for assigning permissions to users defined in the authentication provider. It also provides a standard certificate authority (CA) for setting up encryption. Enhanced capabilities are available separately from Cognos, an IBM company.

If you intend to set up security for IBM Cognos Controller, it should be the first thing you do after installation Chapter 10, “Configuring Authenticated Access,” on page 73. For information about setting up and maintaining security, see the IBM Cognos Business Intelligence Administration and Security Guide.

**Test IBM Cognos Controller**

You can test your IBM Cognos Controller installation and configuration on a client computer by starting IBM Cognos Controller from IBM Cognos Connection or from a URL, and by running the IBM Cognos Controller Link for Microsoft Excel, and by running a standard system report. You can test from IBM Cognos Connection only if you are using IBM Cognos Controller native authentication.

**Administer IBM Cognos Controller**

After IBM Cognos Controller is installed and configured, you can use the IBM Cognos Business Intelligence or IBM Cognos Analytics software portal to do the following things:
• Back up data
• Maintain security
• Deploy IBM Cognos Business Intelligence or IBM Cognos Analytics from one environment to another

For information about administration, see the *IBM Cognos Business Intelligence Administration and Security Guide*. 
Chapter 6. Setting Up the Environment

You must set up resources in your environment so that the components can operate. You must ensure that a web browser and a web server are set up to provide access to IBM Cognos components. If you use a router, you must configure it to support IBM Cognos features. IBM Cognos Business Intelligence or IBM Cognos Analytics must also be installed and configured.

Use the following checklist to guide you through the set up process:

- Review the Release Notes.
- Review the supported environments.
- Verify system requirements.
- Create an IBM Cognos Controller database.
- Configure the Web browser.
- Install and configure Microsoft .NET Framework.

You must complete these tasks before you install and configure the IBM Cognos components Chapter 11, “Additional Configuration Options,” on page 87 to work in your environment.

Review the release notes before you install

Before you install your IBM Cognos product, it is important to be aware of all issues that may affect your installation strategy.

There may be late-breaking issues that were not known when this installation guide was created.

Review the release notes before you install your product. The release notes contain late-breaking information about known issues as well as documentation updates and deprecation notices. For more information, see Cognos Controller 10.4.1 release notes.

Review Supported Environments

To ensure your product works properly, apply all required operating system patches and use only the versions of other software that are supported for an IBM Cognos product.

To see an up-to-date list of environments supported by Cognos Controller, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, run the Software Product Compatibility Reports (http://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/prereqsForProduct?deliverableId=AF89C710264211E98D5DA703D189F003).

System requirements

Use this information to ensure that your computer meets the minimum hardware and software requirements to run IBM Cognos Controller. The hardware requirements depend on your IBM Cognos environment. You may require additional resources, such as disk space.
### Table 1. Client installation requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>Recommended: 4 GB</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Although it is possible to run Controller using the minimum specifications, unless there are exceptional circumstances it is best to use at least the recommended specifications.</td>
</tr>
</tbody>
</table>

### Table 2. Server installation requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows 2008 R2 Enterprise Edition</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 8 GB</td>
</tr>
<tr>
<td>Disk space</td>
<td>Minimum: 4 GB</td>
</tr>
<tr>
<td>CPU Cores</td>
<td>4</td>
</tr>
<tr>
<td>Web server</td>
<td>Microsoft Internet Information Services (IIS)</td>
</tr>
<tr>
<td>Database for IBM Cognos Business Intelligence Content Store</td>
<td>Must be one of the following types:</td>
</tr>
<tr>
<td></td>
<td>• Oracle</td>
</tr>
<tr>
<td></td>
<td>• DB2®</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server</td>
</tr>
<tr>
<td></td>
<td>• TCP/IP connectivity to Microsoft SQL Server</td>
</tr>
<tr>
<td></td>
<td>• Sybase</td>
</tr>
<tr>
<td>Database for IBM Cognos Controller data</td>
<td>Must be one of the following types:</td>
</tr>
<tr>
<td></td>
<td>• DB2</td>
</tr>
<tr>
<td></td>
<td>• Oracle</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server</td>
</tr>
<tr>
<td>Database for IBM Cognos Controller datamart</td>
<td>Must be one of the following types:</td>
</tr>
<tr>
<td></td>
<td>• DB2</td>
</tr>
<tr>
<td></td>
<td>• Oracle</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server</td>
</tr>
<tr>
<td>Oracle Client Database</td>
<td>If you are using Oracle Client as a database, the following components are the minimum requirements:</td>
</tr>
<tr>
<td></td>
<td>• Oracle Network Utilities</td>
</tr>
<tr>
<td></td>
<td>• Oracle Database Utilities</td>
</tr>
<tr>
<td></td>
<td>• SQL® Plus</td>
</tr>
<tr>
<td></td>
<td>• Oracle JDBC/OCI Interface</td>
</tr>
<tr>
<td></td>
<td>• Oracle Windows Interface</td>
</tr>
<tr>
<td><strong>Note:</strong> You must install both the 32-bit and 64-bit client on the server.</td>
<td></td>
</tr>
</tbody>
</table>
Table 2. Server installation requirements (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database for Financial Analytics Publisher</td>
<td>If you use Financial Analytics Publisher, then one of the following databases is required:</td>
</tr>
<tr>
<td></td>
<td>• DB2</td>
</tr>
<tr>
<td></td>
<td>• Oracle</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server</td>
</tr>
<tr>
<td>Web browser</td>
<td>Microsoft Internet Explorer</td>
</tr>
<tr>
<td></td>
<td>The following settings must be enabled:</td>
</tr>
<tr>
<td></td>
<td>• cookies</td>
</tr>
<tr>
<td></td>
<td>• JavaScript</td>
</tr>
<tr>
<td></td>
<td>• Active scripting</td>
</tr>
<tr>
<td></td>
<td>• Allow META REFRESH</td>
</tr>
<tr>
<td></td>
<td>Apple Safari requires JavaScript to be enabled</td>
</tr>
<tr>
<td>Reporting tool for Financial Analytics Publisher</td>
<td>• IBM Cognos BI Studios</td>
</tr>
<tr>
<td></td>
<td>• Other TM1® supported viewers</td>
</tr>
<tr>
<td>OLAP Engine</td>
<td>IBM Cognos TM1</td>
</tr>
<tr>
<td>Other</td>
<td>Microsoft .NET Framework 4.5 must be installed on the following computers:</td>
</tr>
<tr>
<td></td>
<td>• Controller Web Services Server computer</td>
</tr>
<tr>
<td></td>
<td>• Controller Client Distribution Server computer</td>
</tr>
<tr>
<td></td>
<td>• Client computer</td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel must be installed on IBM Cognos Controller client computers.</td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel is required only to use the IBM Cognos Controller Link for Microsoft Excel.</td>
</tr>
<tr>
<td></td>
<td>An SMTP server must be set up if Controller users want to use the automatic e-mail feature.</td>
</tr>
<tr>
<td></td>
<td>Adobe Acrobat Reader must be installed on IBM Cognos Controller client computers.</td>
</tr>
</tbody>
</table>

You must install one of IBM Cognos Business Intelligence or IBM Cognos Analytics. The version must be as specified in the Controller Software Product Compatibility Report (http://www.ibm.com/support/docview.wss?uid=swg27050385).

The specific required components are listed in the following two tables:

Table 3. Cognos Business Intelligence server requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Manager</td>
<td>Contains content manager services that connect to the content store database</td>
</tr>
<tr>
<td>Application Tier components</td>
<td>Contains report services</td>
</tr>
</tbody>
</table>
### Table 3. Cognos Business Intelligence server requirements (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway tier</td>
<td>Used for web communication and reporting functionality</td>
</tr>
</tbody>
</table>

### Table 4. Cognos Analytics server requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content repository</td>
<td>Contains content manager services that connect to the content store database</td>
</tr>
<tr>
<td>Application services</td>
<td>Contains report services and batch report services</td>
</tr>
</tbody>
</table>

### Prerequisites

Before you begin configuration, ensure the following:

- Microsoft .NET Framework 4.5 is installed on all client computers that run IBM Cognos Controller.
- SQL 2010 client components are installed for the data mart functionality on all computers where Controller Web Services Server is installed.
- Appropriate jdbc drivers are installed for both the content store and the Cognos Controller database.

### Verifying supported software versions and hardware requirements

To ensure that the correct supported software versions are available for the IBM Cognos Business Intelligence server components, test the space allocations for IBM Cognos Controller, and test the versions of the installed software.

### About this task

Some of the server components are installed automatically with the installation of IBM Cognos Controller. For example, the Java Runtime Environment (JRE) is automatically installed with IBM Cognos Controller Financial Analytics Publisher and IBM Cognos Controller Web Services Server. This means that you no longer need to define the JAVA_HOME or CCR_JAVA_HOME environment variables.

**Tip:** In most cases, you should not set any JAVA_HOME variable. It is only when the JRE does not exist in the default location that IBM Cognos Configuration and other IBM Cognos BI components require that the JRE is referenced by the JAVA_HOME environment variable. On Microsoft Windows operating system, if JAVA_HOME is not set, the JRE that is packaged with IBM Cognos Controller is used by default.

You can use the Windows Add or Remove Programs utility to verify the version for software, such as Microsoft .NET Framework. Other vendor software, such as Microsoft Data Access Component (MDAC), are not listed in the Windows Add or Remove Programs utility. You must verify the installation and version through other methods.

### Create an IBM Cognos Controller Database

If you are installing IBM Cognos Controller for the first time, you must create an empty Controller database. This is because IBM Cognos Controller requires a configured Controller database to run.

If you installed previous versions of IBM Cognos Controller and have established Controller databases, you do not need to create an empty database for IBM Cognos Controller to run. You can configure the Controller database connections using an existing Controller database.
Important: Before you configure existing Controller databases for use with IBM Cognos Controller, contact your IBM Cognos consultant. Your IBM Cognos consultant will discuss the IBM Cognos Controller consolidation models and possible database upgrade procedures.

Before you begin
IBM Cognos Controller databases must be created using DB2, Oracle or Microsoft SQL Server.
To see an up-to-date list of environments supported by Cognos Controller, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, run the Software Product Compatibility Reports (http://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/prereqsForProduct?deliverableId=AF89C710264211E98D5DA703D189F003).

Create an IBM Cognos Controller Database for DB2
If you are installing IBM Cognos Controller for the first time, you must create an empty Controller database. This is because IBM Cognos Controller requires a configured Controller database to run.

Procedure
1. Determine whether the database is Unicode.
   To check if the database is Unicode, type the following at the command prompt:
   \texttt{Db2 get db cfg for <databasename here> | find "code set"}
   2. If the result set returns a code set that is not Unicode, create a new database that uses a Unicode code set.
   3. Set the territory identifier to the correct language.
   4. In Windows, add the user account to both the DB2ADMNS and DB2USERS groups.
   5. The user account that accesses the data should be the same that owns the database objects (tables, indexes).
   6. Grant the following privileges to the user account that owns and accesses the database:
      \begin{itemize}
      \item dbadm
      \item createtab
      \item bindadd
      \item connect
      \item create_not_fenced Routine
      \item implicit_schema
      \item load
      \item create_external Routine
      \item quisce_connect
      \end{itemize}
   7. From the application server where the DB2 client is installed, the database server has to be cataloged.
      Type the following at the command prompt:
      \begin{itemize}
      \item catalog the server;
      \item catalog tcpip node <Node name> remote <hostname> server <port>;
      \item catalog the database;
      \item catalog database <databasename> as <alias> at node <node name> authentication server
      \end{itemize}
      To list nodes and databases, type the following at the command prompt:
      \begin{itemize}
      \item Db2 list node directory
      \item Db2 list database directory
      \end{itemize}
For more information about cataloging the database, see the DB2 Database Administration Concepts and Configuration Reference.

Results
Performance in a DB2 database will often change over time, and it is crucial to keep track of this. For database maintenance, contact your database administrator.

Create an IBM Cognos Controller Database for Microsoft SQL Server
If you are installing IBM Cognos Controller for the first time, you must create an empty Controller database. This is because IBM Cognos Controller requires a configured Controller database to run.

Procedure

1. If you performed a typical installation of Microsoft SQL Server, after you install you must change the authentication mode to SQL Server and Windows.
   For more information, see the related knowledge base article on the Microsoft Web site.
2. Create the database.
   Ensure that the database collation sequence is case insensitive, and is the same for both the server and the Controller database.
3. Determine which user account Controller Web Services Server will use to access the database.
4. Grant create table privileges for the database to the user account.
   Ensure that the user account is a member of the db_owner role.

Results
Note: In Microsoft SQL 2005, if you do not specifically make another selection, dbo will be the default table owner. Controller tables owned by dbo are not supported. If you have dbo as the default table owner you must change it.

Create an IBM Cognos Controller Database for Oracle
If you are installing IBM Cognos Controller for the first time, you must create an empty Controller database. This is because IBM Cognos Controller requires a configured Controller database to run.

Procedure

1. Determine whether the database is Unicode.
   Tip: One method is to type the following select statement:
   ```
   select * from NLS_DATABASE_PARAMETERS
   ```
2. If the result set returns an NLS_CHARACTERSET that is not Unicode, create a new database that uses a Windows 1252 character set such as WE8MSWIN1252.
3. Determine which user account Controller Web Services Server will use to access the database.
4. Grant the following privileges to the user account that accesses the database:
   - create session
   - alter session
   - create table
   - create database link
   - create sequence
   - create trigger
   - create view
• create procedure
• create materialized view
• create synonym
• create job
• select_catalog_role
• unlimited tablescape

5. Connect as sys and grant execute privileges to the user account for the DBMS_LOCK procedure.

6. Create a single tablespace and set it as the default tablespace for exclusive use by the user account that accesses the Controller database.

Results

Tip: You can increase the performance of your Oracle database by changing the default setting of the optimizer_index_cost_adj parameter in the init.ora file. We recommend that you change the default setting of 100 to a much smaller number, for example: set optimizer_index_cost_adj = 5

Note: When using Oracle, the location of the TNSNAMES.ORA file must be specified in the ccr-system-properties.properties file in the C:\Program Files\IBM\Cognos\c10\Server\integration directory. For Oracle, the location is usually the directory C:\oracle\product\<Oracle_version>\client_1\NETWORK\ADMIN. In this case you need to modify the file accordingly.

For example, # Oracle Network admin directory path, the location of the TNSNAMES.ORA file oracle.net.tns_admin=C:\oracle\product\10.3.0\client_1\NETWORK\ADMIN.

You need to perform database maintenance on the Oracle database. For information on how to optimize your Oracle database, contact your database administrator.

Configure your web browser

IBM Cognos Controller uses the default browser configurations provided by Microsoft. Additional required settings are specific to the browser.

Before you begin

Ensure that the following settings are enabled in your web browser.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Setting</th>
<th>IBM Cognos component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer</td>
<td>Allow Cookies, Active Scripting, Allow META REFRESH, Enable JavaScript</td>
<td>IBM Cognos Connection, Cognos Viewer</td>
</tr>
<tr>
<td>Apple Safari</td>
<td>Enable JavaScript</td>
<td>Controller Web</td>
</tr>
</tbody>
</table>

Cookie settings

IBM Cognos Controller uses the following cookies to store user information.
### Table 6. Cookie settings Controller uses to store user information

<table>
<thead>
<tr>
<th>Cookie</th>
<th>Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS_TICKET</td>
<td>Session temporary</td>
<td>Created if IBM Cognos is configured to use an IBM Cognos Series 7 namespace</td>
</tr>
<tr>
<td>Cam_passport</td>
<td>Session temporary</td>
<td>Stores a reference to a user session stored on the Content Manager server</td>
</tr>
<tr>
<td>cc_session</td>
<td>Session temporary</td>
<td>Holds session information that is specific to IBM Cognos Connection</td>
</tr>
<tr>
<td>cea-ssa</td>
<td>Session temporary</td>
<td>Stores the setting that specifies whether the user session information is shared with other IBM Cognos products</td>
</tr>
<tr>
<td>qs</td>
<td>Persistent</td>
<td>Stores the settings that the user makes for user interface elements such as menus and toolbars</td>
</tr>
</tbody>
</table>

After upgrading or installing new software, restart the Web browser and advise users to clear their browser cache.

### Install and Configure Microsoft .NET Framework

Microsoft .NET Framework supports smart client technology that allows applications to be started using a URL and downloaded from a server.

Microsoft .NET Framework must be installed on the Controller Client Distribution Server computers, the Controller Web Services Server computers, and on all IBM Cognos Controller client computers.

**Important:** Microsoft .NET Framework must be installed and configured on all client computers that will be running IBM Cognos Controller.

#### Procedure

If you do not already have Microsoft .NET Framework installed, you must enable it on your Microsoft Windows operating system.

### Install server roles and features

You must enable specific server roles and features on all computers where Controller Web Services Server and Controller Client Distribution Server are installed.

#### About this task

#### Procedure

1. Enable the roles for Web Server (IIS) and Application Server on Microsoft Windows Server versions prior to 2016.
2. Install the following features:
• .NET Framework 4.5 and 3.5
• ASP
• ASP.NET,
• CGI
• ISAPI Extensions
• ISAPI Filters
• .NET Extensibility
• IIS Management Console
• IIS Management Scripts and Tools
• HTTP Activation
• HTTP Redirection
• Directory Browsing

Note: Some features will be switched on by default or installed when installing some of the server features.
Chapter 7. Upgrading IBM Cognos Controller

You can upgrade from any previous version of IBM Cognos Controller to the current version.

If you have earlier versions of IBM Cognos Business Intelligence products installed with your existing version of IBM Cognos Controller, you must upgrade IBM Cognos Business Intelligence or IBM Cognos Analytics to a version supported by the version of IBM Cognos Controller you are upgrading to, before you can use IBM Cognos Controller and IBM Cognos Business Intelligence or IBM Cognos Analytics together.

If you installed IBM Cognos Controller with other IBM Cognos products such as IBM Cognos Planning, upgrading is supported when all products are the same version. For information about upgrading IBM Cognos Business Intelligence, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

You can upgrade by replacing components in the same directory or by installing the new version of IBM Cognos Controller in a separate directory on the same computer or on a separate computer.

When you upgrade to the same directory as an older version or when you upgrade to a new directory on the same computer, you back up your data, uninstall the older version, install the new version and configure it to use the same databases as the older version, and then upgrade the databases.

When you upgrade to a new computer, you back up your data, install the new version, configure it to use copies of the databases from the older version, and then upgrade the databases. After the new version is operating, you can uninstall the old version. For more information, see “Upgrading to a New Computer” on page 45.

Procedure

1. Planning an Upgrade
2. Install or upgrade other products
3. Back up your application data
4. Uninstall the older version of IBM Cognos Controller
5. Install the new version of IBM Cognos Controller
6. Apply the configuration
7. Upgrade your application databases

Results

After upgrading, there may be additional installation and configuration required to use new features. For example, if you want to use the Publish to Data Mart Framework Manager model, you must also install and configure IBM Cognos Framework Manager, set up a database “Create a Controller Data Mart Database” on page 89 and define a data source “Define a Data Source for the Controller Data Mart” on page 92 for the Controller data mart, and then extract and publish the Framework Manager model to IBM Cognos Connection “Extract the Publish to Data Mart Model and Publish It to IBM Cognos Connection” on page 93.

Planning the Upgrade

We recommend that you plan your upgrade so that you know what to expect at each stage of the process. In the planning stage, you can review the upgrade documentation for information about expected behavior, new features, deprecated features, compatibility between versions, and requirements for preparing your production environment. When you finish the review, you can then conduct a site survey to identify the BI infrastructure, applications, reports, and custom configuration settings. Finally, you can test the upgrade on a subset of your data so that you can fine tune your reports and data before committing to the full upgrade.
The following diagram shows a high level view of the phases in an upgrade project.

When planning your upgrade, ensure that you

- gather the necessary information, such as the required inputs and expected outputs for each phase
- assess the applications in your reporting environment and group similar reports together
- install the new software in a test environment and deploy the content to the test environment
- test the upgraded applications to ensure reports run as expected

Deployment and testing is usually an iterative process. Assess any differences between the source and target environments to determine actionable activities. Move to your production environment when you are satisfied that the deployed applications meet your business requirements.

We recommend that you do not change security providers, such as changing from an IBM Cognos Series 7 namespace to Active Directory as part of the upgrade process. You should treat that as a separate project.

Before you begin

Ensure that you have the skills available, either internal or using external resources. Also consider the hardware that you will need before you begin.

Procedure

1. Review the documentation.
2. Assess applications in the source environment.
3. Perform a trial upgrade, which includes the following tasks:
   - Create the test environment.
   - Plan the deployment of content from the source environment to the test environment.
   - Create an export deployment specification.
   - Copy the deployment specification to the test environment.
   - Include configuration objects for import, if required.
   - Import the deployment specification to Cognos in the test environment.
   - Test the upgraded content.
4. Move to the production environment.

Review the Documentation

Documentation is provided from a variety of sources to help you achieve a successful upgrade.

To review IBM Cognos Controller product documentation on the web, including all translated documentation, visit IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter/SS9S6B/welcome).

Procedure

1. Read the "What’s new" section in this guide Chapter 2, “What’s new?” on page 3.
   It contains a list of new, changed, deprecated, and removed features for this release.
2. Read the rest of the upgrade information in this document.
3. Read the topic about IBM Cognos with other IBM Cognos products “Configuring IBM Cognos Controller to Work with Other IBM Cognos Products” on page 98.
Consolidation Model

IBM® Cognos® Controller 10.3.0 uses the IBM Cognos Controller 8.1 consolidation model (new consolidation model) to consolidate your financial data.

If you used this model in your previous version of IBM Cognos Controller, no changes are required.

If you used the IBM Cognos Controller 2.3 consolidation model (old consolidation model) in your previous version of IBM Cognos Controller, be aware of the fact that Controller 10.3.0 does not support this consolidation model. Plan for an upgrade to the new consolidation model. The CONS_BY_LEVEL server preference is no longer supported. Cognos Controller 10.1.1.x is the last release to support the old consolidation model.

It is not possible to consolidate data that uses the old consolidation model. It is still possible to view consolidated values on periods that are run with the old consolidation model by using the OLKOREP_AC and CONS_BY_LEVELSTART server preferences.

Even though you can upgrade to the new consolidation model in Cognos Controller 10.3, we recommend that you upgrade to the new consolidation model before upgrading to Controller 10.3. Use the latest version of Controller version 10.3.0 to perform the upgrade. For more information, see your IBM Cognos consultant.

Recommendation - Assess Applications in the Source Environment

Preparing to upgrade provides an opportunity to review your current BI investment, and clean up your source environment. Inventory your BI applications to understand the strengths, weaknesses, and areas for improvement in your environment.

For example, you may have a hundreds of reports, packages, public folders and applications in your environment. However, it is not uncommon to find that a number of applications are not used, or no longer meet the company's requirements, or do not work in the source environments.

We recommend that you conduct an audit of your applications to determine which applications you should upgrade. Assessing and reducing the number of reports is a useful exercise. Do not rely only on user feedback to determine which content is used.

An audit of your existing applications may include the following:

__ • Do a site survey.

A survey will help you to assess the current production environment and identify areas that require attention during an upgrade. The site survey should include information about the infrastructure, applications, users, and configuration settings for your IBM Cognos products.

__ • Assess the software that you use in your reporting application.

List software, such as operating systems, Web servers, security, databases, and so on. Compare the list to the supported versions for your target upgrade version, available from the Production Information, Software Environments links at the IBM Cognos Customer Service Center (http://www.ibm.com/software/data/support/cognos_crc.html). Determine whether any components require updating.

__ • List your BI applications, including the following:

  – Framework Manager models
  – published packages
  – reports
  – Transformer models
  – Software Development Kit applications and their dependencies

__ • Complete a detailed assessment of your applications.
The usage, age, size, and complexity of your applications are important factors to consider when planning the upgrade. The total size of the applications may have an impact on the time required to complete the upgrade.

__ • List all the reports contained in your application and do the following:

– Interview the team members to see which cubes, views, or reports are needed and used, which ones can be consolidated, and which ones can be eliminated. Use audit report data to determine report usage.

Upgrade only the reports that work and that users need and use. This reduces the number of applications that you must upgrade.

For more information about audit reports, see the IBM Cognos Business Intelligence Administration and Security Guide.

– Look at the purpose of each report and assign a priority.

This identifies business-critical applications and the functionality that is required in the new environment.

– Flag reports that fail to run or validate in the current environment.

They are unlikely to upgrade successfully. Repair these reports so that they upgrade.

– Consider retiring unused or little-used reports.

– Group the reports into categories, such as upgrade, eliminate, no longer used, and do not upgrade,

__ • List the following information about your configuration:

– configuration settings that you enabled using IBM Cognos Configuration

These settings are preserved through the upgrade. They are stored in two files. For ReportNet v1.1, the files are crnstartup.xml and crnlocale.xml. For IBM Cognos, the files are cogstartup.xml and coglocale.xml.

– changes to other configuration files

You must make changes to other files manually during the upgrade. If you changed other configuration files, you must assess the changes that you want to preserve in the upgraded environment. This may include .xml, .txt, and .css files in the configuration, templates, webapps, and webcontent directories of the installation location.

**Important:** Changes to .ini files are not supported. If you changed .ini files, please contact Customer Support.

__ • Back up all reports, models, and configuration data and files.

__ • Create an upgrade plan.

**Recommendation - Perform a Trial Upgrade**

Pilot upgrade projects are valuable and practical exercises because they ensure that the upgrade produce the expected and required outcome. In addition, an evaluation of the pilot project ensures that the upgrade is successful. If unexpected results occur, you can determine whether the differences are enhancements for your situation or whether you should take action to mitigate the differences.

When you upgrade, applications usually work in the new environment, with little or no intervention. By running an pilot upgrade you can validate selected reports to see if the expected results are produced.

We recommend that you perform a trial upgrade several weeks before upgrading your production system. The trial upgrade identifies components that will upgrade with minimal effort, and components that may require additional actions before or after the upgrade.

Commonly, you upgrade a sample set of reports in an isolated environment, and you compare the appearance and behavior of the reports before and after the upgrade.

Ensure skilled resources are available to perform migration work, especially for mission-critical applications. Also, test and debug all applications prior to deployment.
If you are upgrading from ReportNet 1.1 MR3 or MR4, you can use Upgrade Manager to automate some tasks in the trial upgrade stage.

**Create the Test Environment**

Create a test environment for the new software in preparation for your trial upgrades.

Initially, the new environment does not need to be large, or be the same as your production environment. For example, if it is acceptable, you may use hardware from existing environments, such as development servers.

The environment can be scaled up and out in a phased way after the basic new environment is up and running.

Alternatively, existing environments can remain untouched. If you want the test environment to become the new production environment, configure the test system to match your production environment.

**Procedure**

1. Ensure the infrastructure is in place.
2. Review the supported environments.
3. Install the new software in the test environment.

Having the new version of software in a different location than the earlier version ensures that you run both versions at the same time and confirm that your applications work properly in both environments.

For more information about installing a basic installation, see Chapter 8, “Installing and Configuring IBM Cognos Controller on One Computer,” on page 47.

**Results**

After you have installed the software, use the deployment process to upgrade the content. For more information, see the online help in the IBM Cognos Administration console.

**Plan Your Deployment**

Deployment involves moving applications from one installation to another. In IBM Cognos, you deploy packages, top-level folders, or the entire content store from a source environment to a target environment.

When you deploy, you must consider how to handle security and whether to deploy the entire content store or to deploy selected packages, folders, and directory content. Other considerations relate to the database you use for the content store, bursting reports, and ownership of entries.

For more information about planning the deployment of content to a new environment, see the online help for the Administration console.

The following diagram summarizes the deployment process.

![Deployment Process Workflow](image)

**Security**

Before you deploy, you must consider access permissions and security of deployment archives.

To deploy IBM Cognos Connection entries, you must have the following permissions:

- Execute permissions for the **Administration tasks** secured feature.
• Traverse permissions for the **Administration** secured function.

We also recommend that you belong to the System Administrators group, and have read and write access to the Cognos namespace, so that you can deploy the System Administrators group.

For information about deploying IBM Cognos groups and roles, see the online help in the IBM Cognos Administration console.

**References to Namespaces**

Some entries, such as groups, roles, distribution lists, contacts, data source signons, and some report properties, such as email recipients and report contacts, can refer to entities in namespaces, or authentication providers. When you deploy public folders and directory content, you can deploy these entries with or without the third-party references.

**Deploying the Entire Content Store**

Deploying the entire content store ensures that all packages, folders, and directory content are copied to a new location. For example, if you are changing the computer where IBM Cognos is installed, you can move the entire content store from the old environment to the new environment and keep all the reports and other entries created by administrators and users.

When you import an entire content store, configuration data is included in the export, but excluded from the import by default. We recommend that you do not change this setting. However, if you must import configuration settings “Include Configuration Objects in Import of Entire Content Store” on page 39, you can change the default in the Advanced Settings.

**Deploying Selected Public Folders and Directory Content**

You can choose to do a partial deployment, deploying only selected public folders and directory content. You can choose the packages and folders that you want to deploy by browsing the Public Folders hierarchy and select a package or folder. Once you select a package or folder, its contents are deployed. You cannot select specific entries in the packages or folders. During export, the parent packages and folders are not exported and Content Manager does not create placeholder locations for them in the target environment. During both export and import, you can specify a new target location in the Content Manager hierarchy for each deployed package and folder.

When you do a partial export of public folders and directory content, you must have the following permissions:

• Read and traverse permissions for the entries that you export.

• Write permissions because you create a deployment specification and deployment history when you export.

• Write and set policy permissions for the entries that you import.

**Deploying Packages**

A package is an entry that contains published reports and metadata. Packages are stored in the content store and appear as entries in IBM Cognos Connection.

During a partial deployment, you can deploy one or more packages at a time. A package can reference objects that are outside the package, such as security objects, data sources, and distribution lists. However, referenced objects are not deployed with the package.
Create an Export Deployment Specification
After planning your deployment, the first step in moving content from the one installation to another is to export the content store or the entries that you want to keep in your new environment. To do this, you create an export deployment specification in your source environment.

The entries are exported to an export deployment archive in the source environment. Later, you import the archive entries into the target environment. You can update the entries in the target environment using the entries from the deployment archive.

Before you begin
We recommend that you stop the IBM Cognos service in IBM Cognos Administration before you export and import. For more information, see the IBM Cognos Business Intelligence Administration and Security Guide.

Create a New Export Deployment Specification for the Content Store
After planning your deployment, the first step in moving content from the one installation to another is to export the content store or the entries that you want to keep in your new environment. To do this, you create an export deployment specification in your source environment.

Procedure
1. In IBM Cognos Administration, on the Configuration tab, click Content Administration.
2. On the toolbar, click the new export button and follow the instructions in the New Export wizard.
3. To export the entire content store, click Select the entire content store and select whether to include user account information.
4. Click Next.
5. If you want to secure the archive, under Encryption, click Set the encryption password, type a password, and then click OK, and then click Next.
   The summary information appears.
6. Review the summary information and click Next.
   Tip: If you want to change information, click Back and follow the instructions.
7. Determine how you want to run the export by selecting the action you want.

Results
After you run the export, you can move the deployment archive. You can also see the export run history.

Create a New Export Deployment Specification for Partial Deployments
The entries are exported to an export deployment archive in the source environment. Later, you import the archive entries into the target environment. You can update the entries in the target environment using the entries from the deployment archive.

Procedure
1. In IBM Cognos Administration, on the Configuration tab, click Content Administration.
2. On the toolbar, click the new export button and follow the instructions in the New Export wizard.
3. To export specific folders and directory content, click Select public folders and directory content, and then click Next.
4. In the Select the Public folders content page, click Add.
5. In the Select entries page, in the Available Entries box, select the packages or folders that you want to export.
   You can browse the Public Folders hierarchy and choose the packages and folders you want. Click the right arrow button to move the selected items to the Selected entries box, and click OK.
6. For each package and folder that you export, do one of the following:
• If you want to make any changes to the package or folder in the target environment, click the edit icon to make your changes, and click OK.

• To restrict access to the package or folder and its entries, select the check box in the Disable after import column. This is useful when you want to test the reports before you make them available in the target environment.

7. Under Options, select whether you want to include the report output versions, run history, and schedules and what to do with entries in case of a conflict, and then click Next.

8. In the Select the directory content page, select whether you want to export IBM Cognos groups and roles, distribution lists and contacts, and data sources and connections and what to do with the entries in case of a conflict, and then click Next.

9. In the Specify the general options page, select whether to include access permissions and who should own the entries after they are imported in the target environment.

10. Specify the Recording Level for the deployment history, and then click Next.

11. In the Specify a deployment archive page, under Deployment archive, select an existing deployment archive from the list, or type a new name to create one.

   If you are typing a new name for the deployment archive, we recommend that you do not use spaces in the name. If the name of the new deployment specification matches the name of an existing deployment archive, the existing deployment archive is overwritten.

12. If you want to secure the archive, under Encryption, click Set the encryption password, type a password, and then click OK.

13. Click Next.

   The summary information appears.

14. Review the summary information and click Next.

   Tip: If you want to change information, click Back and follow the instructions.

15. Determine how you want to run the export by selecting the action you want.

Results
After you run the export, you can move the deployment archive. You can also see the export run history.

Run an Export
The entries are exported to an export deployment archive in the source environment. Later, you import the archive entries into the target environment. You can update the entries in the target environment using the entries from the deployment archive.

Procedure
1. In the Actions column, click the run with options button.

2. Click Now to run the export immediately, or click Later, and enter the time that you want the export to run.

   You can also schedule a task to run on a recurring basis, and view a list of scheduled tasks using the Schedule Management tool.

Results
You can now move the deployment archive.

Copy the Deployment Specification to the Test Environment
Move the deployment archive that you created in the source environment to the test environment. You will use the deployment archive to import entries into the target environment.

If the source and test environments use the same content store, you can import without moving the deployment archive.

The default location is ccr_location\deployment.
Before you begin
If you plan to move the deployment archive to a location on a LAN, ensure that there is enough disk space. If you did not encrypt the deployment archive, we recommend that you copy it to a secure location.

Procedure
1. Copy the deployment specification from the source environment to a LAN location or to a CD.
2. Copy the deployment specification from the LAN or CD to the test environment location specified in the configuration tool.

Results
You can now include configuration objects if you are importing an entire content store or import to the target environment.

Include Configuration Objects in Import of Entire Content Store
You can include configuration objects when importing an entire content store. For example, you may want to import the configuration because you have a series of advanced settings for your services that you want from the source environment.

By default, configuration objects are excluded when you import an entire content store, even though they are included in the export. Configuration objects include dispatchers and configuration folders used to group dispatchers.

Procedure
1. In IBM Cognos Administration, on the Configuration tab, click Dispatchers and Services.
2. Click the dispatcher you want.
3. Next to ContentManagerService, click the set properties button.
4. Click the Settings tab.
5. In the Value column, click Edit.
6. Select the Override the settings acquired from the parent entry check box.
7. In the Parameter column that appears, type the following in uppercase:
   
   CM.DEPLOYMENTINCLUDECONFIGURATION
8. In the Value column, type true
9. Click OK to finish.

Import to the Test Environment
You import entries from the deployment archive into the target environment. To import the entries, create an import deployment specification.

When you import, you select from entries that were exported. You can either accept the default options set during the export, or change them. You can only select options that were included in the deployment archive during the export.

If you do a partial deployment of specific public folders and directory content, the import wizard shows whether packages and folders already exist in the target environment and the date and time they were last modified. You can use this information to help you decide how to resolve conflicts. When you redeploy, the wizard also shows whether the packages and folders were in the original deployment.

Procedure
1. In the target environment, in IBM Cognos Administration, on the Configuration tab, click Content Administration.
2. On the toolbar, click the new import button.
   The New Import wizard appears.
3. In the **Deployment archive** box, click the deployment archive that you want to import.
4. If the deployment archive is encrypted, type the password, and then click **OK**.
5. Click **Next**.
6. Type a unique name and an optional description and screen tip for the deployment specification, select the folder where you want to save it, and then click **Next**.
7. Select the content that you want to include in the import.
   
   **Tip:** To ensure that the required target package or folder exists in the target content store, click the edit button next to the package, and check the location. If you want, you can change the target location now.
8. Select the options you want, along with your conflict resolution choice for the options that you select.
9. In the **Specify the general options** page, select whether to include access permissions and who should own the entries after they are imported in the target environment.
10. Specify the **Recording Level** for the deployment history.
11. Click **Next**.
12. The summary information appears.
13. Review the summary information, and click **Next**.
14. Determine how you want to run the import by selecting the action you want.
15. In the **Actions** column, click the run with options button.
16. If you want to upgrade the report specifications, click **Upgrade all report specifications to the latest version**.
   
   You can also use the Schedule Management tool to schedule a task to run on a recurring basis, and view a list of scheduled tasks.

**Results**

You can now test the deployment.

**Test the Deployed Content**

After you import the packages from the deployment archive, you can check that all the entries were deployed successfully in the target environment.

You can test your deployment by doing the following:

- Review the run history for a deployment.
- Ensure that the correct packages and folders were imported, along with their contents.
- Run imported reports and report views.

For more information, see the online help in the IBM Cognos Administration console.

**Recommendation - Test the Upgraded Content**

After you import the packages from the deployment archive, you can check that all the entries were deployed successfully in the target environment.

We recommend that you test your upgraded content by doing the following:

- Test your reports, as follows:
  - In Report Studio, validate each report and note whether the validation was successful.
  - In Report Studio, Query Studio, and Analysis Studio, run the applicable reports and note whether each report ran successfully.
- Test models and PowerCubes in IBM Cognos Transformer, if required:
  - Open models with the appropriate security options and save them.
– Test PowerCubes.

• Test models in Framework Manager.

You can use the same models and projects in Framework Manager for IBM Cognos that you used with the earlier version. When upgrading models, the validation process produces errors for every model. To upgrade a project, open and save it in the new version of Framework Manager. For more information, see the Framework Manager User Guide.

• Repair or exclude reports and models that do not operate correctly.

• Test the repaired reports and models by running them again on the test system.

Troubleshoot any issues, and contact Cognos Software Services about unresolved upgrade issues.

• Revise the upgrade plan to include adaptations that you made during the trial upgrade.

For more information, see the online help in the IBM Cognos Administration console.

Moving to the Production Environment

When all issues that you discovered during the trial upgrade are resolved, you are ready to begin the full upgrade in your production environment. Your upgrade plan will provide the details for each step of the full upgrade.

The following diagram shows the high level steps in the process of moving upgraded applications to a production environment. After preparing the production environment and backing up data and configuration files, you can uninstall the older version of the software, and install the new version in the same location. Then, you can deploy the content from your test environment.

If you want to leverage your existing resources and upgrade in the same directory, you must first back up your configuration data, ensure that Framework Manager models are backed up and checked into a source control system (if applicable), and uninstall the older version of IBM Cognos.

Procedure

1. Prepare the production environment.
   • Back up files and data.
     You may have modified files other than those in the configuration folder. We strongly recommend that you back up the entire installation directory.
     When you back up the configuration data, store it in a secure directory. You must protect the directory from unauthorized or inappropriate access.
   • Install your new release system in the production environment.
     If you install the new software from the test environment to the same location as the existing software, you must first uninstall the existing software.
   • Configure the system.

2. Manually configure customization.
   • If you manually edited any configuration files, the changes will be overwritten during the upgrade. You must reapply the changes. You should keep a record of any customizations to ensure that they can be reapplied after upgrading. You should also back up these files so that you can restore the original version if necessary.
   • The IBM Cognos presentation service supports automatic upgrade of some system.xml files. If you made many customization changes to system.xml files, you can use this automatic upgrade feature.
instead of reapplying the changes manually after upgrading. The system.xml files are overwritten during the installation of IBM Cognos. Therefore, you must back up the customized versions of these files and then copy them to the directory after upgrading IBM Cognos. The automatic upgrade will be applied when you start the IBM Cognos service.

- The system.xml files for which automatic upgrade is supported are in the following directories:
  - `ccr_location/templates/ps`
  - `ccr_location/templates/ps/portal`
  - `ccr_location/templates/ps/qs`

  **Note:** The recommended method to upgrade customized files is to manually reapply changes after the new software is installed. Use automatic upgrade of system.xml files only when you have made a large number of customizations to these files.

3. Deploy the application on the production system.

   When upgrading, you can export the entire content store to a deployment archive and then import the deployment archive into IBM Cognos after upgrading the software.

4. Deploy the reports and models from the test system to the production system.

---

**Install or Upgrade Other Products**

When you upgrade IBM Cognos Controller, you may need to upgrade to new versions of other products or install additional other products to support new features in IBM Cognos Controller.

To view a list of other products that are used by IBM Cognos Controller, see “System requirements” on page 21.

To see an up-to-date list of environments supported by Cognos Controller, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, run the Software Product Compatibility Reports (http://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/prereqsForProduct?deliverableId=AF89C710264211E98D5DA703D189F003).

**Procedure**

If you do not have the supported version of a required other product, install or upgrade the product.

Instructions are provided in this guide for some of the required other products:

- installing Microsoft .NET Framework “Install and Configure Microsoft .NET Framework” on page 28
- installing and configuring ASP.NET “Install server roles and features” on page 28
- configuring a Web server “Configure the web server ” on page 52
- configuring a Web browser “Configure your web browser” on page 27

For instructions to install or upgrade other products, see the instructions provided with each product.

---

**Back Up Your Application Data**

Before you upgrade IBM Cognos Controller, we recommend that you back up your application data and make copies of your application uniform data language (UDL) files in a secure location.

If your normal production procedures include backing up data, you may want to schedule your upgrade after you perform a regular backup.

For information about backing up your database system, see the documentation for your database application.
Uninstall the Older Version of IBM Cognos Controller

You must uninstall the older version of IBM Cognos Controller before you can install a new version. Different versions of IBM Cognos Controller cannot exist on the same computer due to resource conflicts.

You can keep the older version of IBM Cognos Controller if you install the new version on a separate computer. For more information, see “Upgrading to a New Computer” on page 45.

We recommend that you perform a trial upgrade several weeks before upgrading your production system. For more information, see “Recommendation - Perform a Trial Upgrade” on page 34.

Tip: When you uninstall, all IBM Cognos Controller Configuration settings are reverted to the default settings. We recommend that you make a note of all your configuration settings, before you uninstall IBM Cognos Controller. This way you can easily configure the new version of IBM Cognos Controller using the same settings.

Procedure

1. From the Start menu, click Programs, IBM Cognos, Uninstall IBM Cognos, Uninstall IBM Cognos.
2. Follow the instructions to uninstall the components.

   The cognos_uninst_log.htm file, in the Temp directory, records the activities that the Uninstall wizard performs.

Install the New Version of IBM Cognos Controller

The process for installing the new version of IBM Cognos Controller is the same as for a new installation.

Before you begin

We recommend that you install the new components in the same location from which you uninstalled the older version. Ensure that you have uninstalled the older version first. If you want to keep the older version running until you switch over to the new version, you can install the new version on a separate computer. For more information, see “Upgrading to a New Computer” on page 45.

We recommend that you perform a trial upgrade several weeks before upgrading your production system. For more information, see “Recommendation - Perform a Trial Upgrade” on page 34.

Procedure

1. Launch the Cognos Controller installation wizard by double-clicking the /Controller installer package download location/winx64h/issetup.exe file.
   The Welcome page of the installation wizard displays.
2. In the Welcome page of the installation wizard, click Next.
3. Accept the licensing agreement and then click Next.
4. Select the installation directory and then click Next.
   If you receive a warning that you are installing to the same location as a previous installation, click No and then ensure that you select the correct directory and that you uninstalled the older version of IBM Cognos Controller. This warning protects other IBM Cognos products from being overwritten.
5. Follow the directions in the installation wizard to copy the same components to your computer that were installed for the older version.
6. In the Finish page of the installation wizard, choose whether to start IBM Cognos Configuration or view the Release Notes and then click Finish.

Results

You must now apply the new configuration.
Apply the New Configuration

Before you can use the new version of IBM Cognos Controller, you must save the configuration so that the content store is upgraded. Even if you do not change any configuration settings, you must still save the configuration.

Procedure
1. If it is not already running, start IBM Cognos Configuration.
2. If you want to change any settings, do the following:
   • In the Explorer window, click the node for the component that you want to configure.
   • In the Properties window, change the settings as required.
3. From the File menu, click Save.

Upgrading your application databases

When you upgrade from an older version of IBM Cognos Controller, you must upgrade your Controller application databases.

Perform the database upgrade using the database conversion utility to import new data structures into the existing database that is specified in the Controller UDL file.

Tip: After completing the database upgrade on Oracle databases, schedule a performance optimization procedure, prc_analyze_schema, to run on a weekly basis.

Before you begin

To perform the upgrade using the new utility, you must be using a database of version 789 or higher. To upgrade database versions lower than 789 use the old Database Conversion Utility tool in the c10\legacy directory.

Procedure
1. From the Start menu, start Controller Configuration
2. In the Explorer window, expand Database Connections.
3. Select the database that you want to upgrade.
4. Click Actions > Run.
5. If no Java is found, browse to and select the Java 8 JRE in the installdir\bin64\jre\8.0\ directory.
6. If you have more than one Oracle version installed a message appears, select the same Oracle version that you are using with Controller.
7. In the Database Conversion Utility window, click Connect and then click Upgrade.
   The database conversion utility upgrades the existing database with the new data structures.
8. Click Close.

What to do next
If you have an Oracle database installed, perform “Optimizing Oracle database” on page 45.
Optimizing Oracle database

If you are upgrading to IBM Cognos Controller 10.3.1 and have an Oracle database in your system, perform database optimization.

Procedure

1. Log in to Cognos Controller as an administrative user.
2. From the Maintain menu, select Configuration > General.
3. Click the Server Preferences tab.
4. Create an entry in the table with Variable Name = ORA_DYNAMIC_TEMP and Variable Value = OPTIMIZE.
5. Click Save and then close Cognos Controller.
6. Ensure that no users are logged in to Cognos Controller.
7. Log in to Cognos Controller as an administrative user.
8. From the Maintain menu, select User > Single Mode.
9. From the Maintain menu, select Database > Optimize.
10. Select all available options.
11. Click Run.
   A progress bar displays. Wait for the Database Optimized message to display and then click OK.
12. Close the Optimize Database window.
13. Remove the server preference that you created earlier.

Upgrading to a New Computer

You can install a new version of IBM Cognos Controller on a separate computer and configure it to use your existing data. Using this as a staging environment, you can test your reports with the new product. You can continue to run the older version of IBM Cognos Controller in your production environment. When the new version is operating and fully tested, you can switch your production environment to the new version and then uninstall the old version.

To configure the new version of IBM Cognos Controller to use your existing data, you must create copies of the databases and then configure the new version to use the copies. Then you must upgrade your databases.

Procedure

1. Using your database tools, create copies of your existing databases:
   • content store database
   • Controller data source
2. Install the new version of IBM Cognos Controller on the new computer.
   If you do not accept the default installation location, be sure to use only ASCII characters in the name of any new installation directory you create.
3. Configure a new set of Web server aliases for IBM Cognos Controller.
4. Configure IBM Cognos Controller, using the following requirements:
   • Configure the Content Manager computer to use the copy of your content store database.
   • Configure the Controller Web Services Server computers to use the copy of your Controller data source.
5. Upgrade your application databases “Upgrading your application databases” on page 44.
6. Test the new version with existing reports.

**Results**

After upgrading, there may be additional installation and configuration required to use new features. For example, if you want to use the Publish to Data Mart Framework Manager model, you must also install and configure IBM Cognos Framework Manager, set up a database “Create a Controller Data Mart Database” on page 89 and define a data source “Define a Data Source for the Controller Data Mart” on page 92 for the Controller data mart, and then extract and publish the Framework Manager model to IBM Cognos Connection “Extract the Publish to Data Mart Model and Publish It to IBM Cognos Connection” on page 93.
Chapter 8. Installing and Configuring IBM Cognos Controller on One Computer

IBM Cognos Controller requires the installation of server components and client components. You can install IBM Cognos Controller on the same computer where other IBM Cognos products of the same version are installed. This is the typical scenario in a single-computer installation.

If you intend to distribute IBM Cognos Controller, you can start your installation process by installing the server components on a single computer. After you verify that Cognos Controller is running, you can add additional components as required.

Before you begin
You must install either IBM Cognos Business Intelligence or IBM Cognos Analytics. The specific components that are required are listed in “System requirements” on page 21.

You must set up your environment Chapter 6, “Setting Up the Environment,” on page 21 before you install and configure IBM Cognos Controller server and client components.

Ensure that you have administrator privileges for the Windows computer that you are installing on. Also ensure that your computer has a TEMP system variable that points to the directory where you want to store temporary files. During installation, files are temporarily copied to this directory.

Install IBM Cognos components in a directory that contains only ASCII characters in the path name.

Procedure
1. Install IBM Cognos Controller.
2. Install Fix Packs.
3. Set up database connectivity for the content store database. Refer to the IBM Cognos Business Intelligence or IBM Cognos Analytics documentation for information on how to do this.
4. Set up database connectivity for the Controller database.
5. Set up database connectivity for the Controller data mart.
6. Configure the Web server.
7. Test the reporting components.
8. Set database connection properties for the controller data source.
9. Install the client interfaces.
10. Enable the COM+ server.
11. Test the installation and configuration.
12. Enable security.

Results
After you complete these installation and configuration tasks, you can perform additional configuration tasks Chapter 11, “Additional Configuration Options,” on page 87, and change the IBM Cognos Controller default behavior “Changing IBM Cognos Controller Default Configuration Settings” on page 93 to better suit your environment.

If you no longer require IBM Cognos Controller, you can uninstall all IBM Cognos Controller components.
Install Cognos Controller

Use the IBM Cognos Controller installation wizard to select the components that you want to install and the location on your computer where you want to install them. If you plan to install two or more IBM Cognos Controller components on the same computer, we strongly recommend that you install them in the same installation location to avoid conflicts among ports and other default settings.

Before you begin
If you have an old version of Controller on your computer, you must uninstall it and then ensure that all folders in the old installation location are deleted. For more information, see “Uninstall the Older Version of IBM Cognos Controller” on page 43.

About this task
Although the gateway and Controller Client Distribution Server can be installed on separate computers in a distributed installation, we recommend that these two components be installed on the same computer. When Controller Client Distribution Server is installed on a different computer from the gateway or Report Server, additional configuration is required.

Procedure
1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.
2. In the IBM Cognos Controller software package, run issetup.exe.
   The Welcome page of the installation wizard appears.
3. In the Welcome page of the installation wizard, click Next.
4. If you are installing IBM Cognos Controller in the same location as another IBM Cognos installation, the following warning appears:
   You are installing to the same location as a previous installation. Do you want to continue?
   • If this is a single-computer installation, click Yes.
   • If you want the flexibility of managing the IBM Cognos Controller upgrades independently of the IBM Cognos upgrades, click No, and choose a different installation directory.
     Note: If you do not accept the default installation location, be sure to use only ASCII characters in the name of any new installation directory you create.
5. In the Component Selection screen, select all components.
6. Follow the directions in the installation wizard to copy the required files to your computer.
7. In the Finish page of the installation wizard, do one of the following:
   • If you want to change any default settings immediately, click Start IBM Cognos Configuration.
   • If you want to see late-breaking information about IBM Cognos components, click View the Release Notes.

Installing fix packs
IBM provides interim maintenance packages that contain updates to one or more components in your IBM Cognos product. If a fix pack is available when you are installing or upgrading your product, you must install it after you install the IBM Cognos Business Intelligence components.

If a fix pack becomes available after your IBM Cognos product has been deployed, you must stop the service, install the fix pack in the same location as the IBM Cognos BI components, and then start the service.

**Important:** Fix packs are not standalone installations. You must install them on computers that have IBM Cognos BI server components installed. Install the fix pack or packs that are appropriate for your product version. To check your version, open the component list file at `ccr_location\cmplst.txt` and check the line that starts with `C8BISRVR_version=`.

**Before you begin**

Before you install the fix pack, create a backup of the content store database. In addition, back up any customized files from the current installation.

**Procedure**

1. Stop the following services:
   - Internet Information Services (IIS) Manager (the Default Web Site)
   - IBM Cognos Controller Consolidation
2. Back up the content store database.
3. If your IBM Cognos BI environment is customized, back up the entire IBM Cognos BI location.
4. Insert the disk for the Microsoft Windows operating system fix pack or go to the location where you downloaded and extracted the files.
   - If more than one fix pack is available, install the fix pack with the lowest version number first.
5. On the disk or in the download location, go to the `win32` directory and double-click the `issetup.exe` file.
6. Follow the directions in the installation wizard, installing in the same location as your existing IBM Cognos BI server components.
   - The `issetup` program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.
7. If an updater is available, do the following:
   - To install from a disk, insert the updater disk for the Windows operating system.
   - To install from a download, follow the instructions on the support site and then go to the location where you downloaded and extracted the files.
   - In the updater directory on the disk or download location, go to the `win32` directory and double-click the `issetup.exe` file.
   - Follow the directions in the installation wizard.
8. Upgrade your Controller application databases.
9. To return a deployed IBM Cognos BI product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.
10. If you have a distributed environment, repeat these steps for all remaining IBM Cognos BI servers.
11. If you are running the IBM Cognos BI product on an application server other than the default, IBM WebSphere, redeploy the IBM Cognos BI product to the application server.
12. Start the Internet Information Services (IIS) Manager (the Default Web Site).
13. Start the IBM Cognos Controller Consolidation service.

**Update the Java Environment**

The Java Runtime Environment (JRE) is automatically installed with IBM Cognos Controller Financial Analytics Publisher and IBM Cognos Controller Web Services Server. This means that you no longer need to define the `JAVA_HOME` or `CCR_JAVA_HOME` environment variables.

**Tip:** In most cases, you should not set any `JAVA_HOME` variable. It is only when the JRE does not exist in the default location that IBM Cognos Configuration and other IBM Cognos BI components require that the
JRE is referenced by the JAVA_HOME environment variable. On Microsoft Windows operating system, if JAVA_HOME is not set, the JRE that is packaged with IBM Cognos Controller is used by default.

IBM Cognos Controller cryptographic services use specific .jar (Java Archive) files in your Java Runtime Environment (JRE) to determine the allowed strength of the JRE. IBM Cognos Controller provides the necessary jurisdictional policy .jar files in case your JRE does not have the minimum required cryptographic strength.

If you do not have a JAVA_HOME variable already set, the JRE files provided with the installation will be used, and you do not have to update any files in your environment. If JAVA_HOME points to a Java version that is not valid for IBM Cognos Controller, you must update JAVA_HOME with the path to a valid Java version.

If you want to use your own JRE and have JAVA_HOME set to that location, you may have to update the Java environment for the cryptographic services.

**Important:** The JRE you use for Controller must be 64-bit.

The need to update your Java environment depends on the relative strength of jurisdictional policy .jar files in your environment. For example, if you already have stronger files in your environment than are provided with IBM Cognos Controller, you do not have to update the environment. Doing so, in this case, may cause other applications to not work correctly.

If you update your Java environment, it is recommended that you make a backup copy of the files you overwrite. If other applications fail, you may have to replace the original jurisdictional policy .jar files.

You can set JAVA_HOME as a system variable or a user variable. If you set it as a system variable, it may be necessary to restart your computer for it to take effect. If you set it as a user variable, set it so that the environment in which IBM WebSphere is running can access it.

Java 1.6.0 is the minimum supported JRE for IBM Cognos Controller.

Java 1.5.0 is the minimum supported JRE for IBM Cognos. Ensure that you installed the correct JRE for the hardware that you are using.

**Procedure**

1. Ensure that the JAVA_HOME environment variable is set to the JRE location.
   - For example, to set JAVA_HOME to the JRE files provided with the installation, the path is `ccr_location/bin/jre/version`.
2. Copy the bcprov-jdknnn-nnn.jar file from the `ccr_location/bin/jre/version/lib/ext` directory to the `Java_location/jre/lib/ext` directory.

---

**Set Up Database Connectivity for the Controller Database**

For IBM Cognos Controller, both Controller Web Services Server and Report Server access the Controller database. The Web server must be able to connect to the Controller database.

**Procedure**

Ensure that you install the database API software for your reporting sources on each computer where Application Tier Components are installed.

On Windows, Application Tier Components support either native database connectivity or ODBC. On UNIX and Linux, Application Tier Components support the native database connectivity.

On UNIX, for Microsoft SQL Server only, Application Tier Components support the Data Direct ODBC driver. This driver is available from Data Direct.

IBM Cognos requires TCP/IP connectivity with the Microsoft SQL Server.
**Using JDBC drivers for IBM Cognos Controller**

IBM Cognos Controller uses JDBC (Java Database Connectivity) connectivity to access the Controller database. You need to download a suitable JDBC driver from the relevant database provider’s website.

<table>
<thead>
<tr>
<th>Database</th>
<th>JDBC driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>DB2 driver, for example db2jcc.jar</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>JDBC driver, for example sqljdbc4.jar</td>
</tr>
<tr>
<td>Oracle</td>
<td>JDBC thin driver, for example ojdbc5.jar</td>
</tr>
</tbody>
</table>

**Procedure**

1. Copy the downloaded driver jar file to `C:\Program Files\C10\Server\Integration` directory.
2. Edit the `ccr-dbTypes.properties` file to match the copied driver jar file using a text editor such as Notepad. You need the following information depending on which driver file you are using:
   - **IBM DB2**
     ```
     DB2.name = DB2
     DB2.driver = com.ibm.db2.jcc.DB2Driver
     DB2.url = jdbc:db2://%s%s/%s
     ```
   - **SQL Server (MS native)**
     ```
     SQL_SERVER.name = MS SQLServer (Microsoft native)
     SQL_SERVER.driver = com.microsoft.sqlserver.jdbc.SQLServerDriver
     SQL_SERVER.url = jdbc:sqlserver://%s%s;databaseName=%s
     ```
   - **Oracle**
     ```
     ORACLETHIN.name = Oracle thin
     ORACLETHIN.driver = oracle.jdbc.driver.OracleDriver
     ORACLETHIN.url = jdbc:oracle:thin:@%s%s:%s
     ```
     More information is available in the `ccr-dbTypes.properties` file.
3. Restart the IBM Cognos Controller Java Proxy service if it is running.

**Note:** Make a backup copy of the `ccr-dbTypes.properties` file to avoid overwriting it when the system is updated.

---

**Set Up Database Connectivity for the Controller Data Mart**

If you use a different type of database for the Controller data mart than you use for the content store, then you must set up connectivity to the Controller data mart. A Controller data mart database is required only if you intend to use the Publish to Data Mart Framework Manager model that is provided with IBM Cognos Controller.

**Procedure**

Install the appropriate JDBC driver for your Controller data mart, as follows:

<table>
<thead>
<tr>
<th>Database</th>
<th>JDBC Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>DB2 driver, for example db2jcc.jar</td>
</tr>
</tbody>
</table>
Table 8. JDBC drivers for Controller data mart databases (continued)

<table>
<thead>
<tr>
<th>Database</th>
<th>JDBC Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>JDBC thin driver, for example ojdbc5.jar</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>IBM Cognos requires TCP/IP connectivity with Microsoft SQL Server.</td>
</tr>
<tr>
<td>IBM Cognos Content Database</td>
<td>Included with IBM Cognos components. No other software is required.</td>
</tr>
</tbody>
</table>

### Start IBM Cognos Configuration

Use IBM Cognos Configuration to configure IBM Cognos components and to start and stop IBM Cognos services.

**Procedure**

From the **Start** menu, click **Programs, IBM Cognos, IBM Cognos Configuration**.

### Configure the web server

Before you can access the IBM Cognos Controller portal, you must configure your web server. You must set up virtual directories, also known as web aliases, for the directories that contain the HTML and web files for IBM Cognos Controller.

**Before you begin**

You must use Microsoft Internet Information Services (IIS) version 7 or later.

**Procedure**

1. In the **Internet Information Services (IIS) Manager**, expand the node with your server name, and select **Application Pools**.
2. Select **DefaultAppPool** and then from the **Actions** pane, select **Advanced Settings**.
3. Set the **.Net CLR Version** to v.4.0.
4. Set **Enable 32-Bit Applications** to False.
5. Set **Identity** to LocalSystem.
6. Click **OK**.
7. Expand **Sites** and under your web site, create the following virtual directories as shown in the table. If you are installing on the same machine as IBM Cognos Business Intelligence or IBM Cognos Analytics, create the virtual directories under the `ibmcognos` virtual directory.

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>controller</td>
<td><code>controller_install_location\ccrvdir</code></td>
</tr>
<tr>
<td>controllerbin</td>
<td><code>controller_install_location\webcontent\ccr</code></td>
</tr>
</tbody>
</table>

8. Select the controller virtual directory.
9. double click on HTTP redirect.
10. Select **Redirect Requests to this destination** and enter the following path: 
    `/controllerbin/app.publish/CCR.application`
11. Click **Apply**.
12. Right-click your web site and click Add Application.
   a) Set Alias to ControllerServer.
   b) Set Application pool to DefaultAppPool.
   c) In the PhysicalPath field, enter controller_install_location/
      ControllerProxyServer.
   d) Click OK.
13. Click Apply and click OK.

Connecting Cognos Controller to Cognos Analytics or Cognos Business Intelligence

After you have installed IBM Cognos Controller, you must configure it to communicate with IBM Cognos Business Intelligence or IBM Cognos Analytics.

Before you begin
Make sure your IBM Cognos Business Intelligence or IBM Cognos Analytics instance is up and running and accessible from the Cognos Controller server by accessing the IBM Cognos Business Intelligence or IBM Cognos Analytics gateway URI and Dispatcher URI in your web browser.

Procedure
1. Start IBM Cognos Controller Configuration using the Run as administrator option.
2. Under Web Services Server > Report Server point the URI to the IBM Cognos Business Intelligence or IBM Cognos Analytics addresses.
   Configure the following addresses:

<table>
<thead>
<tr>
<th>Server</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report server URI for Cognos Analytics</td>
<td>http://CA_server/bi/v1/disp Dispatcher URI</td>
</tr>
<tr>
<td>Report server URI for Cognos Business Intelligence</td>
<td>http://BI_server/ibmcognos/cgi-bin/ cognos.cgi</td>
</tr>
<tr>
<td>Dispatcher URI for Cognos Analytics and Cognos Business Intelligence</td>
<td>http://BI_OR_CA_Server/p2pd/servlet/ dispatch</td>
</tr>
</tbody>
</table>

Set Database Connection Properties for the Controller Data Source

Before you can run IBM Cognos Controller, you must configure a Controller database connection. IBM Cognos Controller databases must be created using either IBM DB2, Oracle or Microsoft SQL Server.

To run reports against IBM Cognos Controller data sources, the data sources must be configured for Report Server and appear in IBM Cognos Connection.

If you are installing IBM Cognos Controller for the first time, or if you do not want to connect to an existing Controller database, you can create a database connection to an empty Controller database.

Before you begin
If you want to create a connection to an existing Controller database, we recommend that you create a backup of your database before you create the Controller data source connection. This is because the Controller Database Conversion Utility, which runs against the database during the data source connection process, updates the database tables for use with IBM Cognos Controller.
Procedure

1. From the Start menu, start Controller Configuration.
   
   If you are using a Windows 7 or Windows 2008 computer, installed the product to the Program Files directory, and the User Account Control (UAC) is turned on, IBM Cognos Controller Configuration is identified as an administrative application; therefore, you must run it with elevated administrative privileges. To properly save the configuration settings, the UAC prompts for credentials if you are using a standard account.

2. In the Explorer window, click Database Connections, and then click File > New.

3. In the Properties window, click the Database type box, and then use the drop-down arrow to select the database type.
   
   You can choose DB2, Oracle or SQL Server.

4. In the Name box, type a name for the database connection.

5. In the Provider box, type the name of the database provider.
   
   To obtain the database provider information, see the DB2, Oracle or SQL Server documentation.

6. In the User ID and Password boxes, type the user name and password for the Controller database.

7. In the Initial catalog box, type the Controller database name.

8. In the Data source box, type the database server computer name.
   
   Do not use localhost.

9. Click File > Save.

10. In the Explorer window, expand Database Connections.

11. Select the database you want to upgrade.

12. Click Actions > Run.

13. If no Java is found, browse to and select the Java 7 JRE in the installdir\bin64\jre\7.0\ directory.

14. If you have more than one Oracle version installed a message appears, select the same Oracle version that you are using with Controller.

15. If this is an empty Controller database, in the Database Conversion Utility window, click Create Db.
   
   The Database Conversion Utility initializes the database.
   
   Note: When you create a new database, by default the database version is 813. You then need to perform database upgrade to the latest version of IBM Cognos Controller.

16. In the Database Conversion Utility dialog box, click Connect and then click Upgrade.
   
   The Database Conversion Utility upgrades the existing database.
   
   Note: To upgrade database versions lower than 789 use the old Database Conversion Utility tool in the c10\legacy directory.

17. Click Close.

18. From the Actions menu, click Check.
   
   If the database connection validation fails, review the database connection properties and fix any errors.

19. From the File menu, click Save.

20. In the Explorer window, under Web Services Server, click Report Server.

   
   The new database is now configured as a data source for Report Server, and is listed as a data source in IBM Cognos Connection.
Verifying connectivity to the Controller database

Test the connection to the IBM Cognos Controller database to ensure that the Application Tier Components that use the data source connections can access the database.

Procedure
1. From the Start menu, click Programs > IBM Cognos 10 Controller > IBM Cognos Controller > Controller Configuration.
2. In the Explorer window, expand Database Connections.
3. Select a connection that describes the location and type of database that you want to test.
4. From the Actions menu, click Check.
5. Repeat steps 3 - 4 for each database connection listed.

Results
The connection details are validated, and a message confirms that the connection succeeded. If the database connection validation fails, ensure that in the Data source box for the database, the database server computer name is not localhost.

Default Settings for IBM Cognos Controller

IBM Cognos Controller uses default ports and URI settings for the following:

- Gateway, Content Manager, and Report Server
- Controller Web Services Server and Controller Client Distribution Server

Default Settings for the Gateway, Content Manager, and Report Server

The following table lists the default ports and URI settings for the gateway, Content Manager, and Report Server.

After installation, you can use IBM Cognos Configuration to change the settings. You can also change them by editing the cogstartup.xml file in the ccr_location/configuration directory.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Manager URI</td>
<td><a href="http://localhost:9300/p2pd/servlet">http://localhost:9300/p2pd/servlet</a></td>
<td>The URI to Content Manager</td>
</tr>
<tr>
<td>Gateway URI</td>
<td><a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a></td>
<td>The URI to the gateway</td>
</tr>
<tr>
<td>Dispatcher URI (Internal, External)</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
<tr>
<td>Dispatcher URI for external applications</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
<tr>
<td>Dispatcher URIs for gateway</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch/ext">http://localhost:9300/p2pd/servlet/dispatch/ext</a></td>
<td>The URI to the primary dispatcher used by the gateway</td>
</tr>
</tbody>
</table>
Table 9. Default ports and URI settings for the gateway, Content Manager, and Report Server (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller URI for gateway</td>
<td><a href="http://localhost:80/ibmcognos/controllerserver">http://localhost:80/ibmcognos/controllerserver</a></td>
<td>The URI to Controller Web Services Server used by the gateway</td>
</tr>
<tr>
<td>Log server port</td>
<td>9362</td>
<td>The port used by the local log server</td>
</tr>
</tbody>
</table>

Default Settings for Controller Web Services Server and Controller Client Distribution Server

The following table lists default URI settings for Controller Web Services Server and Controller Client Distribution Server.

After installation, you can use IBM Cognos Controller Configuration to change the settings.

Table 10. Default URI settings for Controller Web Services Server and Controller Client Distribution Server

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Authentication, Dispatcher URI</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher used by Controller Web Services Server</td>
</tr>
<tr>
<td>Report Server URI</td>
<td><a href="http://localhost/ibmcognos/cgi-bin/cognos.cgi">http://localhost/ibmcognos/cgi-bin/cognos.cgi</a></td>
<td>The URI to the IBM Cognos Gateway for the Report Server</td>
</tr>
<tr>
<td>CASURL Client Distribution Server URI</td>
<td><a href="http://localhost/ibmcognos/controllerbin">http://localhost/ibmcognos/controllerbin</a></td>
<td>The Controller Client Distribution Server URI used by client downloads</td>
</tr>
<tr>
<td>WSSURL Web Services Server URI</td>
<td><a href="http://localhost/ibmcognos/controllerserver">http://localhost/ibmcognos/controllerserver</a></td>
<td>The Controller Web Services Server URI used by client downloads</td>
</tr>
<tr>
<td>Controller online help URL</td>
<td><a href="http://localhost/ibmcognos/controllerhelp">http://localhost/ibmcognos/controllerhelp</a></td>
<td>The URI to the IBM Cognos Controller online help used by client downloads. Only change this when you do not want use IBM Knowledge Center (<a href="https://www.ibm.com/support/knowledgecenter/">https://www.ibm.com/support/knowledgecenter/</a>).</td>
</tr>
</tbody>
</table>

Installing the client interfaces

You can install the following client interfaces:

  - IBM Cognos Controller Link for Microsoft Excel
  - Framework Manager
  - IBM Cognos Controller Financial Analytics Publisher
Enabling access to Cognos Controller from Cognos Business Intelligence

To access IBM Cognos Controller from the IBM Business Intelligence portal you must add Cognos Controller to IBM Cognos Connection.

Before you begin

You must have a Personal Information Exchange (.pfx) file that contains your security certificate. The security certificate can be self-signed or issued by a certificate authority.

About this task

In this task, you'll sign the CCR.application file using your security certificate.

Procedure

1. Go to \<controller installation location>\webcontent\ccr\app.publish.
2. Double-click CCRSignApp.exe.
3. Browse to the location of the .pfx file.
   You may be required to enter a password.
4. Click Sign application.
   A message appears saying that the CCR.application was successfully signed.
5. Click OK and close CCRSignApp.exe.

Install the IBM Cognos Controller Link for Microsoft Excel

IBM Cognos Controller provides an add-in for Microsoft Excel that is automatically downloaded, along with the Controller client, the first time that users access IBM Cognos Controller. Users must have administrative privileges for their computers so that IBM Cognos Controller Link for Microsoft Excel can be downloaded.

If your users do not have administrative privileges, you can install the IBM Cognos Controller Link for Microsoft Excel remotely for them. For users who have slow network connections, you might prefer to copy the complete client installation package to a CD and then distribute the CD for users to install.

To facilitate the installation of IBM Cognos Controller on the client computer, you can run the CCRLocalClient executable file. If users are installing the Controller client on a Windows 7 computer and the User Account Control (UAC) is turned on, users are prompted to consent to running the application as elevated. The operating system identifies the IBM Cognos Controller Client as an administrative application.

As an administrator, the CCRLocalClient32.msi and CCRLocalClient64.msi files are available if you want full control over the deployment process. For example, the .msi installation program allows you to automate the installation or uninstallation, and standard logging. By using the .msi program, you can also customize the installations and resolve configuration problems.

Procedure

1. On the computer where Controller Client Distribution Server is installed, go to the ccr_location \webcontent\ccr directory.
2. To distribute the IBM Cognos Controller Link for Microsoft Excel remotely to the IBM Cognos Controller client computers, run the ControllerExcelLinkSetup_x64 or the ControllerExcelLinkSetup file on IBM Cognos Controller client computers by using Active Directory or Patchlink.
3. To copy the complete client installation package to a CD or USB drive for installation by users, copy the CCRLocalClient32.exe or CCRLocalClient64.exe files from the ccr directory to your transportable media.

Users with administrative privileges can then copy the client installation package from the media to their IBM Cognos Controller client computer. This procedure allows users to run the CCRLocalClient32.exe or CCRLocalClient64.exe files.
Set Up the Data Source Environment for Framework Manager

The IBM Cognos modeling tools create and manage metadata. Framework Manager creates and manages metadata for the reporting functions. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for Framework Manager. Commonly, these things depend on the other technology you use for your data or import source.

If you use a Sybase data source, these steps are not necessary.

If you upgraded from an older version of Framework Manager, you are not required to set up anything in the data source environment. You must set up the data source environment only if you installed Framework Manager in a different location from the older version.

Before you begin

Install IBM Cognos Framework Manager. For information on how to install Cognos Framework Manager, refer to the IBM Cognos Analytics or IBM Cognos Business Intelligence installation procedures.

Ensure that you install the appropriate fonts to support the character sets and currency symbols you use.

Procedure

1. Set the environment variable for multilingual support:

   • For Oracle, set the NLS_LANG (National Language Support) environment variable on each computer where Framework Manager is installed by typing the following command:

   ```
   NLS_LANG = language_territory.character_set
   ```

   Examples are:

   ```
   NLS_LANG = AMERICAN_AMERICA.UTF8
   NLS_LANG = JAPANESE_JAPAN.UTF8
   ```

   The value of the variable determines the locale-dependent behavior of IBM Cognos. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.

   • For DB2, set the DB2CODEPAGE environment variable to a value of 1252.

   For more information about whether to use this optional environment variable, see the DB2 documentation.

   No settings are required for SAP BW. SAP support only a single code page on non-Unicode SAP BW systems.

2. For Oracle, add $ORACLE_HOME/lib to your LD_LIBRARY_PATH.

   When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the $ORACLE_HOME/lib directory or the $ORACLE_HOME/lib32 directory if you installed a 64-bit Oracle client.

3. For Oracle, copy the ojdbc14.jar file from ORACLE_HOME/jdbc/lib to the ccr_location/webapps/p2pd/WEB-INF/lib directory. For Oracle 11 g, copy the ojdbc5.jar file from ORACLE_HOME/jdbc/lib to the ccr_location/webapps/p2pd/WEB-INF/lib directory.

   If the directory contains the classes12.jar file, delete it before installing the ojdbc14.jar or ojdbc5.jar file.

4. For SAP BW, configure the following authorization objects so that the modeling tool can retrieve metadata.

   Some of the values shown, such as *, are default values that you may want to modify for your environment.
### Table 11. Authorization objects to configure for SAP BW when you set up the data source environment for Framework Manager

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>Activity</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Name of RFC to be protected</td>
<td>SYST, RSOB, SUGU, RFC1, RS_UNIFICATION, RSAB, SDTX, SU_USER</td>
</tr>
<tr>
<td></td>
<td>Type of RFC object to be protected</td>
<td>FUGR</td>
</tr>
<tr>
<td>S_TABU_DIS</td>
<td>Activity</td>
<td>03</td>
</tr>
<tr>
<td></td>
<td>Authorization Group</td>
<td>&amp;NC&amp;</td>
</tr>
<tr>
<td>S_RFC</td>
<td>Activity</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Name of RFC to be protected</td>
<td>SYST, RSOB, SUGU, RFC1, RS_UNIFICATION, RSAB, SDTX, SU_USER</td>
</tr>
<tr>
<td></td>
<td>Type of RFC object to be protected</td>
<td>FUGR</td>
</tr>
<tr>
<td>S_TABU_DIS</td>
<td>Activity</td>
<td>03</td>
</tr>
<tr>
<td></td>
<td>Authorization Groups</td>
<td>&amp;NC&amp;</td>
</tr>
<tr>
<td>S_USER_GRP</td>
<td>Activity</td>
<td>03, 05</td>
</tr>
<tr>
<td></td>
<td>User group in user master main</td>
<td>*</td>
</tr>
<tr>
<td>S_RS_COMP</td>
<td>Activity</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Info Area</td>
<td>InfoArea Technical Name</td>
</tr>
<tr>
<td></td>
<td>Info Cube</td>
<td>InfoCube Technical Name</td>
</tr>
<tr>
<td></td>
<td>Name (ID) of reporting components</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Type of reporting components</td>
<td>*</td>
</tr>
<tr>
<td>S_RS_COMP1</td>
<td>Activity</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Name (ID) of reporting components</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Type of reporting components</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Owner (Person Responsible)</td>
<td>*</td>
</tr>
<tr>
<td>S_RS_HIER</td>
<td>Activity</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Hierarchy Name</td>
<td>Hierarchy Name</td>
</tr>
<tr>
<td></td>
<td>InfoObject</td>
<td>InfoObject Technical Name</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>Hierarchy Version</td>
</tr>
</tbody>
</table>
**Table 11. Authorization objects to configure for SAP BW when you set up the data source environment for Framework Manager (continued)**

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RS_ICUBE</td>
<td>Activity</td>
<td>03</td>
</tr>
<tr>
<td></td>
<td>InfoCube sub-object</td>
<td>DATA DEFINITION</td>
</tr>
<tr>
<td></td>
<td>Info Area</td>
<td>InfoArea Technical Name</td>
</tr>
<tr>
<td></td>
<td>InfoCube</td>
<td>InfoCube Technical Name</td>
</tr>
</tbody>
</table>

&NC& represents any table that does not have an authorization group. For security reasons, create a new authorization group and assign the table RSHIEDIR to it. The new authorization group restricts the user’s access to the table only, which is needed by the modeling tool. Create the new authorization group as a customization in the SAP system.

For more information about SAP BW authorization objects, see Transaction SU03.

**Installing Cognos Controller Financial Analytics Publisher**

IBM Cognos Controller includes an integration component, IBM Cognos Financial Analytics Publisher, that automates the process of extracting data in close to real time from Cognos Controller into IBM Cognos TM1.

IBM Cognos Financial Analytics Publisher uses a temporary storage area before populating the TM1 cube. Once the initial publish operation is started, the TM1 cube is updated continuously, and you can define how often the service should run. From the TM1 cube, the IBM Cognos Controller data can be accessed by a number of reporting tools, including IBM Cognos BI studios. For more information about using Cognos Controller Financial Analytics Publisher, see *Using Financial Analytics Publisher*.

**Schematic overview**

Because the installation of IBM Cognos Controller Financial Analytics Publisher includes several different server components, there are a number of installation options.

The following diagram shows one of these options and how it relates to the IBM Cognos Controller application and database servers. The Cognos Controller Financial Analytics Publisher Client (that is, the admin console) is installed on the Cognos Controller application server, the Financial Analytics Publisher database on a separate database server, finally the Financial Analytics Publisher Server and TM1 on the TM1 application server.
In addition to the server components, you need access to the cube. There are a number of reporting tools you can use, including IBM Cognos BI studios.

**Setting up the IBM Cognos Controller Financial Analytics Publisher environment**

Before you can run IBM Cognos Controller Financial Analytics Publisher you must set up resources in your environment so that the components can operate.

If you install all Controller components on one computer the Financial Analytics Publisher Client and Financial Analytics Publisher Server components are installed by default.

Use the following checklist to guide you through the setup process:

- Configure the IBM Cognos Controller Database and the System Audit Log
- Create a Financial Analytics Publisher Database
- Configure the Financial Analytics Publisher Server
- Install TM1

**Enabling data transfer to Financial Analytics Publisher**

You must configure the IBM Cognos Controller Database to enable integration with IBM Cognos Controller Financial Analytics Publisher.

**Note:** The Controller database must be upgraded with a dbconv step corresponding to the IBM Cognos Controller 10.3.0 release, or later. For more information, see “Upgrading your application databases” on page 44.

You enable data transfer when you connect to a data source in Cognos Controller Financial Analytics Publisher and the data source status is flagged as Active. When you disconnect from a data source, the data transfer for FAP is disabled and the trickle tables are purged. The System Audit log and the data transfer to FAP are two separate functions. Therefore, you can enable or disable them separately.

For more information about the Audit Trail function, see *Using Controller*. 
Create a Cognos Controller Financial Analytics Publisher database
When you install IBM Cognos Controller Financial Analytics Publisher, you must create an empty Financial Analytics Publisher database. This is because Financial Analytics Publisher requires a database to publish data from the Controller database.

Procedure
1. From the Start menu, start IBM Cognos Controller Configuration.
   If you are using a Microsoft Windows 2008 or Microsoft Windows 2012 computer, installed the product to the Program Files directory, and the User Account Control (UAC) is turned on, IBM Cognos Controller Configuration is identified as an administrative application; therefore, you must run it with elevated administrative privileges. To properly save the configuration settings, the UAC prompts for credentials if you are using a standard account.
2. In the Explorer window, click Database Connections, and then click File > New.
3. In the Properties window, select the database type.
   You can choose DB2, Oracle, or SQL Server.
4. Type a name for the database connection.
5. In the Provider field, type the name of the database provider, for example SQLNCLI11.1 for SQL Server.
   To obtain the database provider information, see the DB2, Oracle or SQL Server documentation.
6. Type the user name and password for the Cognos Controller database.
7. In the Initial catalog field, type the Cognos Controller database name.
8. In the Data source field, type the database server computer name.
   Do not use localhost.
9. Click File > Save.
10. In the Explorer window, expand Database Connections, and browse to the location of the UDL file for the FAP database you want to upgrade.
11. Browse to the location of the UDL file for the FAP database you want to upgrade.
12. Click Actions > Run.
   The Database Conversion Utility opens.
13. If no Java is found, browse to and select the Java 7 JRE in the installdir\bin64\jre\7.0\ directory.
14. If you have more than one Oracle version installed a message appears, select the same Oracle version that you are using with Controller.
15. Click FAP DB.
16. In the Database Conversion Utility window, click Connect, and then Create Db.
   The Database Conversion Utility initializes the database.
17. To update an existing database, click Connect, and then Upgrade.
   The Database Conversion Utility upgrades the existing database.
18. Click Actions > Check.
   If the database connection validation fails, review the database connection properties and fix any errors.
19. Click File > Save.

Configure the Financial Analytics Publisher Server and start the service
Before you configure the Financial Analytics Publisher Server and start the service, ensure that your Java Runtime Environment is updated. However, if JAVA_HOME is not set, the JRE that is packaged with IBM Cognos Controller is used by default.
**Procedure**

1. Go to the `c:\location\server\FAP` directory, and open the `FAPService.properties` file in a text editor.

2. Edit the following values to connect to your FAP database.
   a) Set the value for `db` to the name of your FAP database. For example, `db=FAP`.
   b) Set the value for `host` to the name of your database server. For example, `host=servername:port`.
   c) Set the value for `dbType` to the type of database.
      For example:
      
      ```
      dbType=sqlserver
      dbType=db2
      dbType=oracle
      ```
   d) Set the value for `user` to the user name for your database. For example, `user=username`.
   e) Set the value for `password` to the password for you user. For example, `password=password`.

   You can optionally add the following parameters to the file, depending on your database type:
   
   ```
   db2DbConnectionType=Db2_connection_type, the default is db2.
   db2DbProvider=Db2_provider, the default is com.ibm.db2.jcc.DB2Driver.
   sqlserverDbConnectionType=SQLServer_connection_type, the default is sqlserver.
   sqlserverProvider=SQLServer_provider, the default is com.microsoft.sqlserver.jdbc.SQLServerDriver.
   oracleDbConnectionType=Oracle_connection_type, the default is oracle.
   oracleProvider=Oracle_provider, the default is oracle.
   ```

   • All settings are case sensitive.
   • If you are using Microsoft SQL Server, and your database uses an instance name, please refer to http://www-01.ibm.com/support/docview.wss?uid=swg21417314 for further instructions.
   • If you are using Oracle but not using the default port number 1521, please refer to http://www-01.ibm.com/support/docview.wss?uid=swg21415196 for further instructions.

3. Click **Start** > **Control Panel** > ** Administrative Tools** > **Services**.
4. Select **IBM Cognos FAP Service**, and click **Start**.

**Install the TM1 Client**

This procedure can be skipped when the Financial Analytics Publisher service and the TM1 application server reside on the same server and TM1 is a 32-bit installation.

The TM1 client includes the dll files that are required for the Financial Analytics Publisher server to communicate with the TM1 server.

When installing the TM1 Server on a 64-bit server it is necessary to install the 32-bit TM1 client on the server where the Financial Analytics Publisher service is installed.

For more information about installing and configuring the TM1 client, see the *IBM Cognos TM1 Installation Guide*.

**Procedure**

1. In Windows Explorer, right-click **My Computer**, and select **Properties**.
2. On the **Advanced** tab, click **Environment Variables**.
3. Under **System Variables**, select **Path**, and click **Edit**.
4. Copy the path to the `TM1\bin64` directory on your client, and paste it in at the end of the shown path.
Installing IBM Cognos TM1
After you have installed the Financial Analytics Publisher as a Windows server, you must install IBM Cognos TM1, create a TM1 server and set up the IBM Cognos Security.

For information on how to install IBM Cognos TM1, see the IBM Cognos TM1 Installation Guide.

Creating a new TM1 Server
To be able to run the Financial Analytics Publisher, you need to create a local TM1 Server on the TM1 application server (the admin host server).

For information on how to create a TM1 server, see the IBM Cognos TM1 Installation Guide.

Note: If you are using TM1 10.2 or earlier, you specify the maximum number of groups by editing the Tm1s.cfg file and setting the GroupsCreationLimit according to your requirements. The default value is 20. The maximum number of groups for GroupsCreationLimit is 65535. If you are using TM1 10.2.2 or later, you do not need to set the GroupsCreationLimit parameter.

Financial Analytics Publisher and IBM Cognos Security
Both Controller users who are designated as IBM TM1 Users and Controller authorization groups are published to TM1. Authorization groups are assigned prefixes to avoid naming conflicts.

The following security modes are available for Cognos Controller and Cognos Controller Financial Analytics Publisher in TM1:

• For TM1 9.5.x, Cognos Controller users and authorization groups are published and can be leveraged if CAM authentication is not used to access the Cognos Controller Financial Analytics Publisher cube (for example from the TM1 Excel plug-in, but not from BI).

  Note: Both Controller users who are designated as IBM TM1 Users and Controller authorization groups are cleared in TM1 during the initial publish operation.

• For TM1 9.5.2 and later, there is integrated security between Controller and TM1. This means that both Controller users who are designated as IBM TM1 Users and Controller authorization groups are published to TM1. Then for all CAM users present in TM1, the CAM user ID will be connected to the Controller user ID (provided the CAM information has been maintained in Controller) and get the appropriate authorization groups.

• TM1 Security Mode Settings that are not supported by Controller will result in the initial publish process being aborted and the datamart being set to Error. The following TM1 API security modes are not supported:
  – Distributed
    Implies that the TM1 server is a distributed server that accepts connections without specifying any credentials.
  – Mixed
    Implies that the TM1 server accepts user authenticating either using Basic authentication or Windows Integrated Authentication.
  – WIA
    Implies that the TM1 server accepts connections that can authenticate based on Windows Integrated Authentication.

Configuring CAM security mode
You need to configure the CAM security mode.

Procedure
1. In the IBM Cognos Controller Financial Analytics Publisher dialog box, click the Data Marts tab.
2. Enter the following credentials:
   • Client - <CAM user as 'namespace\user'>
• Password - <CAM password>

This user must exist in Controller.

3. The CAM user must be created on the TM1 server and associated with the ADMIN group.

4. For TM1 9.5.2 and later, all CAM users in IBM Cognos Controller who are designated as IBM TM1 Users and who should be managed by the FAP Service security must be added to the TM1 server. This is done manually in TM1 Architect. To add users, follow the instructions in the IBM Cognos TM1 Operations Guide. All the existing users in Controller that you want to provide access to TM1 for, must be imported.

5. In the FAPService.properties file, add the new property clientcamuri, for example clientcamuri=http://Cam Server Name/IBM Cognos/cgi-bin/cognos.cgi. This parameter should have the CAMURI value as Controller and TM1.

   **Note:** In the Tm1s.cfg configuration file, the IntegratedSecurityMode parameter must be set to the following value by the administrator (default value is 1) when performing an initial publish:

   1 = BASIC, 5 = CAM

**Results**

For more information about setting up a TM1 server to use CAM, see the *IBM Cognos TM1 Operations Guide*.

**Note:** In the next initial publish, users already present in TM1 will be re-used, therefore only new CAM users must be added.

*Creating an ODBC Data Source for TM1*

You need to create an ODBC Data Source, named FAP, pointing to the Financial Analytics Publisher database. The client software for your relational database must be installed on the same computer you are creating the FAP ODBC Data Source and TM1 server on.

---

**Enable Access to the COM+ Server**

When you install IBM Cognos Controller, a Controller COM+ application is created. After you install IBM Cognos Controller, you must confirm that network access to the COM+ Server is enabled.

By default, installations of Windows Server 2008 restrict the functionality of network and communication components. You must enable the COM+ Server before IBM Cognos Controller can operate.

**Procedure**

1. In the Windows Control Panel, click Add or Remove Programs, and then click Add/Remove Windows Components.
2. Click Application Server, and then click Details.
3. Click Enable network COM+ Access, and then click OK.
4. Click Next, and then click Finish.

---

**Test the IBM Cognos Controller Installation and Configuration**

After you configure the Controller database connection and COM+ Server, test your configuration settings to confirm that you can start IBM Cognos Controller and connect to a Controller database.

You can test your IBM Cognos Controller installation and configuration on a client computer by starting IBM Cognos Controller from IBM Cognos Connection or from a URL, and by running the IBM Cognos Controller Link for Microsoft Excel. You can test from IBM Cognos Connection only if you are using IBM Cognos Controller native authentication.
If you installed Framework Manager for use with the Publish to Data Mart Framework Manager model, you can also test the connection to Framework Manager.

**Before you begin**

Before you can run IBM Cognos Controller from a client computer, you must set up the local environment. To set up the local environment for IBM Cognos Controller, you must install and configure the Microsoft .NET Framework.

**Tip:** To view the IBM Cognos Controller user interface in optimal conditions, we recommend that you set the Display Properties for your monitor to a screen resolution of 1024 X 768 and a DPI setting of 96.

**Procedure**

1. Start Microsoft Internet Explorer.
2. Start IBM Cognos Connection by typing one the following, where ibmcognos is the virtual directory you created when you configured the Web server:
   - For the CGI gateway: type `http://host_name:port/ibmcognos`
   - For an ISAPI gateway: type `http://host_name:port/ibmcognos/isapi`
   
   It may take a few minutes for the Web page to open.
3. In the IBM Cognos Connection **Welcome** page, click the IBM Cognos Controller link.
   
   The Select Database window opens.
4. Select a database in the list, and click the check mark.
5. Enter your logon credentials:
   
   In the IBM Cognos Controller - Login window, type the User ID, Password, Actuality, and Period, and then click the check mark.

   **Tip:** For new databases, the default User ID is **ADM** and the default Password is **kbs**.

   If IBM Cognos Controller opens, your IBM Cognos Controller installation is working.

**Run IBM Cognos Controller from a URL**

After you configure the Controller database connection and COM+ Server, test your configuration settings to confirm that you can start IBM Cognos Controller and connect to a Controller database.

You can test your IBM Cognos Controller installation and configuration on a client computer by starting IBM Cognos Controller from IBM Cognos Connection or from a URL, and by running the IBM Cognos Controller Link for Microsoft Excel. You can test from IBM Cognos Connection only if you are using IBM Cognos Controller native authentication.

**Procedure**

1. On a client computer, start Microsoft Internet Explorer.
2. Type the following URL, where `servername` is the computer where IBM Cognos Controller Client Distribution Server is installed:
   
   `http://servername/ibmcognos/controller`

   The Select Database window opens.
3. Select a database in the list, and click the check mark.
4. Enter your logon credentials:
   
   In the IBM Cognos Controller - Login window, type the User ID, Password, Actuality, and Period, and then click the check mark.

   **Tip:** For new databases, the default User ID is **ADM** and the default Password is **kbs**.

   If IBM Cognos Controller opens, your IBM Cognos Controller installation is working.
Run the IBM Cognos Controller Link for Microsoft Excel

After you configure the Controller database connection and COM+ Server, test your configuration settings to confirm that you can start IBM Cognos Controller and connect to a Controller database.

You can test your IBM Cognos Controller installation and configuration on a client computer by starting IBM Cognos Controller from IBM Cognos Connection or from a URL, and by running the IBM Cognos Controller Link for Microsoft Excel. You can test from IBM Cognos Connection only if you are using IBM Cognos Controller native authentication.

**Procedure**

1. On a client computer, start Microsoft Excel.
   - You must have accessed IBM Cognos Controller at least once from the client computer.
2. From the **Controller** menu, click **Log on**.
3. In the **Select Database** dialog box, select a database and click the check mark.
4. Enter your logon credentials:
   - In the **IBM Cognos Controller - Login** dialog box, type the User ID, Password, Actuality, and Period, and click the check mark.
   - **Tip:** For new databases, the default User ID is **ADM** and the default Password is **kbs**.
   - From the **Controller** menu, the IBM Cognos Controller Link for Microsoft Excel features are available.

Run Framework Manager

After you configure the Controller database connection and COM+ Server, test your configuration settings to confirm that you can start IBM Cognos Controller and connect to a Controller database.

You can test your IBM Cognos Controller installation and configuration on a client computer by starting IBM Cognos Controller from IBM Cognos Connection or from a URL, and by running the IBM Cognos Controller Link for Microsoft Excel. You can test from IBM Cognos Connection only if you are using IBM Cognos Controller native authentication.

**Procedure**

1. Start the IBM Cognos service.
2. To start Framework Manager, from the **Start** menu, click **Programs, IBM Cognos, Framework Manager**.
   - If you see the **Welcome** page of Framework Manager, your installation is working.

Verifying functionality in IBM Cognos Controller client interfaces

You can test relevant functionality in the IBM Cognos Controller client interfaces by accessing various menu commands, including those commands that connect to the IBM Cognos Business Intelligence components.

**Before you begin**

IBM Cognos Controller must be installed and configured before verifying the functionality within the application. For information about testing the installation, see “Test the IBM Cognos Controller Installation and Configuration” on page 65.

**About this task**

To ensure that the installation of the IBM Cognos Controller Client interfaces were completed successfully, you can take additional actions.
Procedure
1. To test the setup of the client distribution server, and that the authentication method used is working, start IBM Cognos Controller and log on.
2. To test basic navigation in the application, from the Maintain menu, click Company Structure.
3. To test IBM Cognos BI integration, access a standard report.
   You can choose to access the report from the Company or Group menu, or from the Transfer or Maintain menu.
4. To test the IBM Cognos Controller Link for Microsoft Excel installation, open the IBM Cognos Controller Link for Microsoft Excel in one of the following ways:
   • Click Company > Data Entry - Reported Values.
     The Data Entry - Reported Values window is displayed and Microsoft Excel is opened in the background.
   • On the Reports menu, click the IBM Cognos Controller Link for Microsoft Excel.
     Microsoft Excel opens and you are logged on to IBM Cognos Controller.
5. To test the connection to the IBM Cognos Controller Help system and launch the appropriate Help files from within the user interface, click Help.

Enabling Security
IBM Cognos Controller is operating with the minimum security level. We recommend that you use a higher level of security than the default authentication settings.
For more information, see Chapter 10, “Configuring Authenticated Access,” on page 73.

Uninstall IBM Cognos Controller
If you no longer require IBM Cognos Controller, uninstall all IBM Cognos Controller components.
It is not necessary to back up the configuration and data files on Windows. These files are preserved during the uninstallation.
We recommend that you close all programs before you uninstall IBM Cognos Controller. Otherwise, some files may not be removed.

Procedure
1. From the Start menu, click Programs, IBM Cognos, Uninstall IBM Cognos.
   The Uninstall wizard appears.
   Tip: Cognos is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.
2. Follow the instructions to uninstall the components.
   The cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files.
   Tip: To find the log file, look in the Temp directory.
3. Delete all temporary Internet files.
   For more information, see your Web browser documentation.
**Results**

Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them using Windows Explorer.
Chapter 9. Load balancing in IBM Cognos Controller

IBM Cognos Controller can use multiple Cognos Controller application servers to balance the load. If you balance the load, then the work of the Cognos Controller Server is divided between separate Microsoft Windows servers.

Load balancing can be achieved in the following ways:

• Scaling up: If you add more CPU cores or more memory to a Cognos Controller application server, then the Cognos Controller application server will use the improved hardware.

• Scaling out: If you add more separate Cognos Controller application servers, then you can spread the load between these separate servers. For more information, see “Load balancing with multiple IBM Cognos Controller application servers” on page 71.

Load balancing with multiple IBM Cognos Controller application servers

To increase the performance of IBM Cognos Controller, you can spread the workload between several Cognos Controller application servers.

Before you begin

If you want to use several Cognos Controller application servers, where some users use server 1 and others use server 2, then the following diagram shows how to set up these Cognos Controller application servers.
One application server acts as the master. The primary server hosts the active user manager. You can have several separate secondary servers. The secondary servers use the user manager that runs on the primary server.

**Procedure**

1. On the master system, install the Cognos Controller application server.
2. On the secondary system perform the following tasks:
   a) Install only the Cognos Controller server components.
   b) Use the same version of Cognos Controller on the primary and secondary system.
   c) Configure the Cognos Controller server on the secondary system in the same way as the primary application server. The master and secondary systems must contain the same database connections (same UDL files).
   d) Configure the Cognos Controller server on the secondary system to use the same Cognos BI server. This Cognos BI server might be the Cognos BI server on the primary system.
3. On each secondary system, configure the web.config file by performing the following tasks:
   a) In the ControllerProxyServer folder, open the web.config file.
      The default location of the ControllerProxyServer folder is C:\Program Files\ibm\cognos\ccr_64\ControllerProxyServer.
   b) In the <appSettings> section, add the following entry <add key="ccrRemoteServer" value="http://MASTERSERVER_NAME/ibmcognos/controllerserver" />
4. Save the changes and restart all servers.
Chapter 10. Configuring Authenticated Access

IBM Cognos Controller uses three methods of authenticated logon: native, IBM Cognos, and Microsoft Windows authentication. When you configure your IBM Cognos Controller environment to use a particular authentication method, you must configure a corresponding authentication level for the reporting components.

By default, IBM Cognos Controller uses native authentication. The corresponding default for the reporting components is anonymous access.

We recommend that you use a higher level of security than the default native authentication settings. If you want to use the IBM Cognos authentication method, you must use a Cognos namespace for authentication with the reporting components.

The first step for setting up IBM Cognos or Windows authentication is to configure the IBM Cognos Controller components with an authentication namespace for the type of authentication provider you want to use. If you installed IBM Cognos Controller in an environment that includes IBM Cognos Business Intelligence, the namespace is configured for IBM Cognos Business Intelligence. Unless you want to change authentication providers, you do not have to configure an authentication namespace now. For information about configuring a namespace for various other authentication providers, see “Configuring IBM Cognos Components to Use an Authentication Namespace” on page 77.

If you want to use the IBM Cognos authentication method, you must add the IBM Cognos Controller users to the IBM Cognos Controller roles. After you add the users to the roles, the first user to log on to Controller is automatically mapped to the Controller Administrative User account and inherits the privileges of that account.

For both the IBM Cognos and the Windows authentication methods, you must map the users that are defined in IBM Cognos Controller to the users that are defined in the Cognos namespace roles.

**Procedure**

1. Configure the IBM Cognos Controller authentication method.
2. Add IBM Cognos Controller users to IBM Cognos Controller roles, for the IBM Cognos authentication method only.
3. Map IBM Cognos Controller users to IBM Cognos users.

**Configure the IBM Cognos Controller Authentication Method**

After you configure the authentication provider, you must configure the Controller Web Services Server computers with IBM Cognos or Windows authentication. The default authentication method is Native authentication.

With native authentication, logon information is configured in the IBM Cognos Controller databases and in the IBM Cognos Controller user interface. Native authentication is the authentication method used in previous versions of IBM Cognos Controller. If you use Native authentication, when users log on to IBM Cognos Controller from IBM Cognos Connection or from a URL and have selected a database to log on to, they are prompted to log in. Users are prompted with the same logon window when they log on to IBM Cognos Controller using the IBM Cognos Controller Link for Microsoft Excel. If you want to use Native authentication in your IBM Cognos Controller environment, the reporting components must run under anonymous access. When the reporting components run under anonymous access, no logon is required. In IBM Cognos Connection, anonymous access is enabled by default. Native authentication provides minimal security in your IBM Cognos Controller environment.

IBM Cognos authentication is shared between IBM Cognos Controller and the reporting components. When you use the IBM Cognos authentication method, you can use the IBM Cognos built-in namespace to restrict access to defined users, or you can create an appropriate namespace for the type of authentication provider in your environment. Access is then restricted to users belonging to any group or...
role defined in the namespace. If you use the IBM Cognos authentication method, when users log on to IBM Cognos Controller from IBM Cognos Connection or from a URL and have selected a database to log on to, they are prompted to log on. Users are prompted with the same logon window when they log on to IBM Cognos Controller using the IBM Cognos Controller Link for Microsoft Excel. IBM Cognos authentication uses shared memory for passport IDs. However, if your company security policy prohibits the use of shared memory, you can disable the use of shared memory for passport IDs. If you disable shared memory for passport IDs, users must log on separately to IBM Cognos Controller and to the IBM Cognos Controller Link for Microsoft Excel.

Windows Authentication is the built-in authentication provided through the configuration of Internet Information Services (IIS). When Windows Authentication is enabled, user connections established with the Microsoft Internet Information Services Web server on Controller Web Services Server are validated, and then authenticated against the namespace configured in IBM Cognos Configuration. If Windows Authentication is enabled, after users log on to client computers with their Windows user name and password, they are not prompted with further logons when they run IBM Cognos Controller or the IBM Cognos Controller Link for Microsoft Excel.

Before you begin
Ensure that you have configured the appropriate namespace.

About this task
Perform this procedure on the Cognos Controller server.

Procedure
1. From the Start menu, start IBM Cognos Controller Configuration.
2. In the Explorer window, click Web Services Server, Server Authentication.
3. In the Select authentication method box, click the drop-down arrow, and then select the authentication method:
   - Click IBM Cognos to enable IBM Cognos authentication.
   - Click Windows Authentication to enable Windows Authentication.
4. In the Dispatcher URI box, type the URI for the Report Server dispatcher. For example, type:
   http://<servername> 9300/p2pd/servlet/dispatch
5. From the File menu, click Save.

Add IBM Cognos Controller Users to the IBM Cognos Controller Roles

Users, groups, and roles are created for authentication purposes. In IBM Cognos Controller, you can use users, groups, and roles created in other authentication providers, and groups and roles created in IBM Cognos Controller. The IBM Cognos Controller groups and roles created in IBM Cognos Controller are referred to as IBM Cognos Controller groups and IBM Cognos Controller roles.

When you use the IBM Cognos authentication method, you must add IBM Cognos Controller users to the IBM Cognos Controller roles.

About this task
Perform the steps in this task on the IBM Cognos Business Intelligence or IBM Cognos Analytics server.

Procedure
1. Launch IBM Cognos Administration.
3. Click the Cognos namespace.
4. In the **Actions** column, click the properties button for the **Controller Administrators** role.
5. Click the **Members** tab.
6. To add members, click **Add** and do one of the following to select members:
   - To choose from listed entries, click the appropriate namespace, and then select the check boxes next to the users, groups, or roles.
   - To search for entries, click **Search** and in the Search string box, type the phrase you want to search for. For search options, click **Edit > Find**, and click the entry you want.
   - To type the name of entries you want to add, click **Type** and type the names of groups, roles, or users using the following format, where a semicolon (;) separates each entry:
     
     namespace/group_name;namespace/role_name;namespace/user_name;
   
   For example: **Cognos/Authors;LDAP/scarter**;
7. Click the right-arrow button and when the entries you want appear in the **Selected entries** box, click **OK**.
8. On the **Members** tab, click the **Everyone** namespace, and then click **Remove**.
9. Click **OK**.
10. Close the **Properties** window to return to the Users, Groups, Roles tab.
11. Repeat steps 4 to 8 for the **Controller Users** role.
   
   **Tip:** The **Controller Administrators** role must be a member of the **Controller Users** role.
12. Click **OK**.

**Results**
After the users are added to the roles, the first user to log on to Controller is automatically mapped to the Controller Administrative User account and inherits the privileges of that account.

**Enable Controller Administrators and Users to View Standard Reports in Cognos Viewer**
To view standard reports, Controller Administrators and Controller Users require execute and traverse permissions for the Cognos Viewer capability.

**About this task**
Perform the steps in this task on the IBM Cognos Business Intelligence or IBM Cognos Analytics server.

**Procedure**
1. In **IBM Cognos Connection**, in the upper-right corner, click **Launch, IBM Cognos Administration**.
2. On the **Security** tab, click **Capabilities**.
3. Locate the **Cognos Viewer** capability, click its actions button, and then click **Set properties**.
4. On the **Permissions** tab, click **Add**.
5. Click the **Cognos** namespace.
6. Select the check boxes for the **Controller Administrators** and **Controller Users**.
7. Click the right-arrow button, and when the entries appear in the **Selected entries** box, click **OK**.
8. Click **OK** again.
9. Select the check boxes for the **Controller Administrators** and **Controller Users** roles.
10. In the box next to the list, select the **Execute** and **Traverse** check boxes.
    
    The icons for **Execute** and **Traverse** appear in the **Permissions** column.
11. Click **Apply**.
Map IBM Cognos Controller Users to IBM Cognos Users

When you use the IBM Cognos or Windows authentication method, you must create an association between the users defined in the IBM Cognos Controller application and those defined in the Cognos namespace roles.

IBM Cognos Controller supports logons to only one namespace.

Before you begin

Important: The first user who logs on to IBM Cognos Controller using IBM Cognos Authentication is automatically mapped to the IBM Cognos Controller Administrative User, the named user defined by default in Controller. Associations between users can be created only by a user who was configured in IBM Cognos Connection as a member of the Controller Administrators role. It is important, therefore, that the first user who logs on was configured to be a member of the Controller Administrators role. Otherwise, the automatic mapping to the IBM Cognos Controller Administrative User will not occur and the user's logon will fail.

For more information about setting user rights and limitations in IBM Cognos Controller, see Using Controller.

About this task

Perform this procedure on the Cognos Controller server.

Procedure

1. Start IBM Cognos Controller.
   
   Note: You must be a member of the Controller Administrators role in IBM Cognos Connection.
2. From the Maintain menu, click Rights, Users.
3. Select the user as defined in the IBM Cognos Controller database.
4. Next to the CAM User box, click Show Valid Choices and then select the user as defined in the Cognos namespace roles.
5. Click Save.

Create an IBM Cognos Controller User Based on an IBM Cognos User

When you use the IBM Cognos or Windows authentication method, you must create an association between the users defined in the IBM Cognos Controller application and those defined in the Cognos namespace roles.

About this task

Perform this procedure on the Cognos Controller server.

Procedure

1. Start IBM Cognos Controller.
   
   Note: You must be a member of the Controller Administrators role in IBM Cognos Connection.
2. From the Maintain menu, click Rights, Users.
3. Click New.
4. Next to the CAM User box, click Show Valid Choices, and then select the user as defined in the Cognos namespace roles.
5. Change the default values for Name and E-Mail Address, as required.
6. Next to the User Group box, click the browse button, and then click the user group for the IBM Cognos Controller user.
7. Under **Options**, select the appropriate check box to identify the user:
   - IBM Cognos Controller User
   - IBM Cognos Controller Administrator

   If you select IBM Cognos Controller Administrator, ensure that the user is a member of the Controller Administrators role in IBM Cognos Connection.

   You can add other optional information.

8. Click **Save**.

---

**Configuring IBM Cognos Components to Use an Authentication Namespace**

When authenticated access is enabled and configured, user authentication is managed by other authentication providers. You must configure IBM Cognos components with an appropriate namespace for the type of authentication provider in your environment.

You can configure multiple namespaces for authentication and then choose which namespace you want to use. IBM Cognos Controller supports logons to only one namespace. For more information, see the *IBM Cognos Administration and Security Guide*.

After you configure new namespaces, you can test namespaces.

You can also delete namespaces that you added if they are no longer required. “Delete an Authentication Provider” on page 84. After you delete a namespace using IBM Cognos Configuration, you must complete the process by deleting it in the portal.

**Important:** You must not delete the Cognos namespace. It contains authentication data that pertains to all users and is required to save the configuration.

After IBM Cognos Controller is connected to a namespace, you cannot change the connection to another namespace.

IBM Cognos components support the following types of servers as authentication sources:

- Active Directory Server
- Custom Authentication Provider
- Netegrity SiteMinder

If you enable security, you must configure security settings immediately after you complete the installation and configuration process. For more information, see the *IBM Cognos Administration and Security Guide*.

**Important:** We recommend that you do not disable security after you enable it. If you delete a namespace, the user preferences, My Folders, and My Pages entries are permanently lost. Existing permission settings will refer to users, groups, or roles that no longer exist. While this does not affect how the permissions work, a user administrating the permission settings may see entries that are marked as unknown. Because these entries refer to users, groups, and roles which no longer exist, you can safely delete them.

After you configure an authentication provider for IBM Cognos components, you can enable single signon between your authentication provider environment and IBM Cognos components. This means that a user logs on once and can then switch to another application without being asked to log on again.

**Before you begin**

Some authentication providers require libraries external to the IBM Cognos Controller environment to be available.

**About this task**

Perform the steps in this task on the IBM Cognos Business Intelligence or IBM Cognos Analytics server.
Procedure
1. Enable single signon
2. Disable anonymous access
3. Configure IBM Cognos components to use the appropriate namespace:
   - Active Directory Server
   - Custom authentication provider
   - Netegrity SiteMinder

Enable Single Signon
If you want users to log on once to IBM Cognos Controller and then be able to switch to another IBM Cognos product without logging on again, you can enable single signon.

Single signon in IBM Cognos Controller is supported between the Controller client and Controller Excel client only.

Procedure
1. On each computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Security, click Authentication.
3. In the Properties window, set the value of Allow session information to be shared between client applications to True.

Disable Anonymous Access
You can use both anonymous and authenticated logon with your IBM Cognos components installation. If you choose to use only authenticated logon, you can disable anonymous access.

By default, IBM Cognos reporting components do not require user authentication. Users can log on anonymously. If you want to use authenticated logon only, you can use IBM Cognos Configuration to disable anonymous access.

To support single signon in IBM Cognos Controller, you must disable anonymous access.

Procedure
1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Security, Authentication, click IBM Cognos.
   The IBM Cognos resource represents the Cognos namespace. The Cognos namespace stores information about Cognos groups, such as the Anonymous User, contacts, and distribution lists, and refers to objects in other security namespaces. For more information, see the IBM Cognos Administration and Security Guide.
3. In the Properties window, click the box next to the Allow anonymous access property and then click False.
4. From the File menu, click Save.

Results
Now, users are required to provide logon credentials when they access IBM Cognos resources.

Restrict User Access to the Cognos Namespace
Access can be restricted to users belonging to any group or role defined in the IBM Cognos built-in namespace. By default, all users belong to several built-in groups or roles. To restrict access, you must:
   • enable the property to restrict access
   • remove the Everyone group from the IBM Cognos built-in roles and groups
   • ensure that authorized users belong to at least one IBM Cognos role or group
**Procedure**

1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, click **Authentication**.
3. In the **Properties** window, change the value of **Restrict access to members of the built-in namespace** to **True**.
4. From the **File** menu, click **Save**.

**Results**

You must now use the portal to remove the Everyone group from the IBM Cognos built-in roles and groups and then ensure that authorized users belong to at least one IBM Cognos built-in role or group.

For information about adding or removing members of an IBM Cognos group or role, see the **IBM Cognos Administration and Security Guide**.

**Configuring IBM Cognos Components to Use Active Directory Server**

When you install Content Manager on a Windows computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

If you want to use Microsoft SQL Server as a data source and use single signon for authentication, you must use Active Directory as your authentication source.

To use an Active Directory Server namespace and to set up single signon, do the following:

- Configure IBM Cognos Controller components to use an Active Directory Server namespace.
- Enable single signon between Active Directory Server and IBM Cognos Controller components.

**Configure an Active Directory Namespace**

You can use Active Directory Server as your authentication provider.

You also have the option of making custom user properties from the Active Directory Server available to IBM Cognos Controller components.

**Note:** For IBM Cognos components to work properly with Active Directory Server, ensure that the Authenticated users group has Read privileges for the Active Directory folder where users are stored.

**Before you begin**

If you are configuring an Active Directory namespace to support single signon with a Microsoft SQL Server data source, the following configuration is required:

- The IBM Cognos gateway must be installed on an IIS Web server that is configured for Windows Integrated Authentication.
- Content Manager must be installed on a Windows 2008 server.
- Content Manager, Report Server (Application Tier Components), IIS Web server, and the data source server (Microsoft SQL Server) must belong to the Active Directory domain.
- The data source connection for Microsoft SQL Server must be configured for **External Namespace** and that namespace must be the Active Directory namespace.

For more information about data sources, see the **IBM Cognos Administration and Security Guide**.

**Procedure**

1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, right-click **Authentication**, and then click **New resource, Namespace**.
3. In the **Name** box, type a name for your authentication namespace.
4. In the **Type** list, click the appropriate namespace and then click **OK**.
The new authentication provider resource appears in the Explorer window, under the Authentication component.

5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.

6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.

7. Specify the values for the Host and port property.

8. If you want to be able to search for details when authentication fails, specify the user ID and password for the Binding credentials property.

   Use the credentials of an Active Directory Server user who has search and read privileges for that server.

9. From the File menu, click Save.

10. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Results
IBM Cognos Controller loads, initializes, and configures the provider libraries for the namespace.

Make Custom User Properties for Active Directory Available to IBM Cognos Controller Components
You can use arbitrary user attributes from your Active Directory Server in IBM Cognos components. To configure this, you must add these attributes as custom properties for the Active Directory namespace.

You can also use custom properties inside command blocks that are used to configure Oracle sessions and connections. The command blocks can be used with Oracle light-weight connections and virtual private databases. For more information, see the IBM Cognos Administration and Security Guide.

Procedure
1. On the computer where you installed Content Manager, start IBM Cognos Configuration.

2. In the Explorer window, under Security, Authentication, click the Active Directory namespace.

3. In the Properties window, click in the Value column for Custom properties and click the edit button.

4. In the Value - Custom properties window, click Add.

5. Click the Name column and enter the name you want IBM Cognos components to use for the session parameter.

6. Click the Value column and enter the name of the account parameter in your Active Directory Server.

7. Repeat the preceding two bulleted steps for each custom parameter.

8. Click OK.

9. From the File menu, click Save.

Include or Exclude Domains Using Advanced Properties
When you configure an authentication namespace for IBM Cognos components, users from only one domain can log in. By using the Advanced properties for Active Directory Server, users from related (parent-child) domains and unrelated domain trees within the same forest can also log in.

If you set a parameter named chase_referrals to true, users in the original authenticated domain and all child domains of the domain tree can log in to IBM Cognos. Users above the original authenticated domain or in a different domain tree cannot log in.

If you set a parameter named multi_domain_tree to true, users in all domain trees in the forest can log in to IBM Cognos.

Procedure
1. On the computer where you installed Content Manager, start IBM Cognos Configuration.

2. In the Explorer window, under Security, Authentication, click the Active Directory namespace.
3. In the **Properties** window, specify the **Host and port** property:
   - For users in one domain, specify the host and port of a domain controller for the single domain.
   - For users in one domain tree, specify the host and port of the top-level controller for the domain tree.
   - For users in all domain trees in the forest, specify the host and port of any domain controller in the forest.

4. Click in the Value column for **Advanced properties** and click the edit button.

5. In the **Value - Advanced properties** window, click **Add**.

6. Specify two new properties, **chaseReferrals** and **MultiDomainTrees**, with the following values:

<table>
<thead>
<tr>
<th>Authentication for</th>
<th>chaseReferrals</th>
<th>MultiDomainTrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>One domain</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td>One domain tree</td>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>All domain trees in the forest</td>
<td>True</td>
<td>True</td>
</tr>
</tbody>
</table>

7. Click **OK**.

8. From the **File** menu, click **Save**.

**Enabling Single Signon Between Active Directory Server and IBM Cognos Controller Components**

By default, the Active Directory provider uses Kerberos delegation and integrates with the IIS Web server for single signon if Integrated Authenticated (formerly named NT Challenge Response) is enabled on the IIS Web server.

If Integrated Authenticated is enabled, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the Active Directory namespace.

If you do not want Kerberos delegation, the provider can be configured to access the environment variable REMOTE_USER to achieve single signon. You must set the advanced property singleSignonOption to the value IdentityMapping. Microsoft sets REMOTE_USER by default when you enable Windows Integrated Authentication.

**Configuring IBM Cognos to Use a Custom Authentication Provider**

If you implemented a custom Java authentication provider with your existing security infrastructure, you can configure IBM Cognos components to use it.

You can use a custom authentication provider to access and authenticate users to an alternate authentication source. You can also use it as a single signon mechanism to integrate IBM Cognos components with your security infrastructure.

For more information, see the Custom Authentication Provider **Developer Guide**.

**Configure a Custom Authentication Namespace**

You can configure IBM Cognos components to use a custom authentication namespace. Any additional configuration for authentication source access, single signon, or custom attributes are dependent on the custom authentication provider implementation.

**Procedure**

1. On every computer where you installed Content Manager, open IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, right-click **Authentication**, and click **New resource**, **Namespace**.
3. In the **Name** box, type a name for your authentication namespace.
4. In the **Type** list, click **Custom Java Provider** and then click **OK**.

   The new authentication provider resource appears in the **Explorer** window, under the **Authentication** component.

5. In the **Properties** window, for the **NamespaceID** property, specify a unique identifier for the namespace.

   **Tip:** Do not use colons (:) in the Namespace ID property.

6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication provider.

7. From the **File** menu, click **Save**.

8. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource and click **Test**.

**Results**

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

**Configuring IBM Cognos components to use eTrust SiteMinder**

You can configure IBM Cognos components to use a Netegrity SiteMinder namespace as the authentication source, provided that you installed Content Manager on a non-Linux computer.

To configure an authentication provider in an eTrust SiteMinder environment, you configure an LDAP, NTLM, or Netegrity SiteMinder namespace depending on your eTrust SiteMinder configuration. Supported eTrust SiteMinder configurations are LDAP, Active Directory Server, and NTLM user directories.

**Note:** The authentication provider uses an eTrust SiteMinder SDK to implement a custom agent, and the custom agent deployment requires that the Agent Properties in the eTrust SiteMinder Policy server administration console be set to be able to support 4.x agents.

If you configured eTrust SiteMinder for more than one user directory, you must use the Netegrity SiteMinder namespace. After configuring the Netegrity SiteMinder namespace in IBM Cognos, you must also add a corresponding LDAP, Active Directory Server, or NTLM namespace to the IBM Cognos configuration for each user directory defined in eTrust SiteMinder.

When configuring a corresponding LDAP namespace, you must ensure that the External identity mapping property is enabled and that you include the token REMOTE_USER in the value for the property. This does not mean that eTrust SiteMinder must be configured to set REMOTE_USER. The IBM Cognos Netegrity SiteMinder namespace passes user information internally to the corresponding LDAP namespace when it receives successful user identification from the eTrust SiteMinder environment.

When configuring a corresponding Active Directory namespace, you must ensure that the singleSignonOption property is set to IdentityMapping. The IBM Cognos Netegrity SiteMinder namespace passes user information internally to the corresponding LDAP namespace using the REMOTE_USER environment variable when it receives successful user identification from the eTrust SiteMinder environment. For more information, see “Enabling Single Signon Between Active Directory Server and IBM Cognos Controller Components” on page 81.

If eTrust SiteMinder is configured with only one user directory, the Netegrity SiteMinder namespace is not required. You can use the user directory as your authentication source by configuring the appropriate namespace, or you can configure the eTrust SiteMinder provider with one user directory. For example, if the eTrust SiteMinder user directory is NTLM, you can configure IBM Cognos components with an NTLM namespace or configure IBM Cognos components with one Netegrity SiteMinder namespace, referring to one user directory that is an NTLM namespace.

If the eTrust SiteMinder user directory is Active Directory, you can use an Active Directory namespace or an LDAP namespace that is configured for use with Active Directory.

If you want to use the user directory as your authentication source directly instead of configuring a Netegrity SiteMinder namespace, configure the appropriate namespace. In this case, you must verify the Agent Configuration Object properties in eTrust SiteMinder Policy Server. Ensure that SetRemoteUser is activated.
When configuring the LDAP namespace, in this case, you must ensure that the External identity mapping property is enabled and that you include the token REMOTE_USER in the value for the property.

When configuring the Active Directory namespace, in this case, you must ensure that the singleSignonOption property is set to IdentityMapping. For more information, see “Enabling Single Signon Between Active Directory Server and IBM Cognos Controller Components” on page 81.

Procedure
1. Configure IBM Cognos components to use a Netegrity SiteMinder namespace
2. Enable secure communication to the eTrust SiteMinder user directory
3. Enable single signon between eTrust SiteMinder and IBM Cognos
4. Protect the IBM Cognos Web alias

Configure a Netegrity SiteMinder Namespace
If you configured eTrust SiteMinder for more than one user directory, you must use the Netegrity SiteMinder namespace. After adding the Netegrity SiteMinder namespace, you must also add a corresponding LDAP or NTLM namespace for each user directory.

You can also configure an Netegrity SiteMinder namespace if users are stored in

- an LDAP server
- an NTLM server
- an Active Directory server

Procedure
1. On the computer where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and click New resource, Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the Netegrity SiteMinder namespace and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   Tip: Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. In the Explorer window, under Security, Authentication, right-click the namespace and click New resource, SiteMinder Policy Server.
8. In the Name box, type a name for the policy server and click OK.
9. In the Properties window, specify the Host property and any other property values you want to change.
10. In the Explorer window, right-click the new SiteMinder Policy Server and click New resource, User directory.
    Tip: Configure a user directory for each user directory in the SiteMinder policy server.
11. In the Name box, type a name for the user directory and click OK.
    Important: The name of the user directory must match the name that appears on the policy server.
12. In the Properties window, type a value for the Namespace ID reference property.
13. From the File menu, click Save.
14. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.
15. Configure a corresponding LDAP, Active Directory, or NTLM namespace for each LDAP, Active Directory, or NTLM user directory.

**Important:** Ensure that you use the same value for the **Namespace ID** property that you use for the **Namespace ID** property for the Netegrity SiteMinder namespace.

**Enabling Secure Communication to the eTrust SiteMinder User Directory**
If you use an SSL connection to the directory server, you must appropriately configure the Cognos namespace for the user directory.

**Enable Single Signon Between eTrust SiteMinder and IBM Cognos**
By configuring single signon, you are not prompted to reenter authentication information.

IBM Cognos components automatically refer to the eTrust SiteMinder session cookie for user session data.

If the eTrust SiteMinder user directory is LDAP or Active Directory, you must configure the eTrust SiteMinder user directory to use external identity mapping to the REMOTE_USER environment variable.

If the eTrust SiteMinder user directory is NTLM, Integrated Windows Authentication is used for single signon and no additional configuration is required.

**Protecting the IBM Cognos Web Alias**
eTrust SiteMinder must be configured correctly to protect the IBM Cognos Web alias.

Use the test tool provided with eTrust SiteMinder to verify that the resource is protected, authenticated, and authorized. For more information, see your eTrust SiteMinder documentation.

**Test the Namespaces**
After you configure one or more new namespaces for IBM Cognos components, you can test the namespaces. The test can occur before or after you start the IBM Cognos service. You can test all namespaces at the same time or test them individually.

**Procedure**
1. To test all namespaces, in the **Explorer** window, right-click **Authentication** and click **Test**.

   IBM Cognos Controller components load, initialize, and configure the provider libraries for one namespace before testing the next namespace.

   **Tip:** To cancel a namespace test, click **Cancel**. The test stops when the current namespace test is complete.

2. To test a single namespace, in the **Explorer** window, under **Authentication**, right-click the new authentication resource and click **Test**.

   IBM Cognos Controller components load, initialize, and configure the provider libraries for the namespace.

**Delete an Authentication Provider**
If they are no longer required, you can delete namespaces that you added or unconfigured namespaces that IBM Cognos Controller components detected after an upgrade.

**Important:** You must not delete the Cognos namespace. It contains authentication data that pertains to all users and is required to save the configuration.

When you delete a namespace, you can no longer log on to the namespace. Security data for the namespace remains in Content Manager until you permanently delete it in the portal. For more information, see the *IBM Cognos Administration and Security Guide*.

After you delete a namespace, it appears as Inactive in the portal.
Procedure
1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Security, Authentication, right-click the namespace and click Delete.
3. Click Yes to confirm.
   The namespace disappears from the Explorer window and you can no longer log on to the namespace on that computer.
4. From the File menu, click Save.

Results
You must now log on to the portal and permanently delete the data for the namespace. For more information, see the IBM Cognos Business Intelligence Administration and Security Guide.
Chapter 11. Additional Configuration Options

After you install one or more IBM Cognos Controller components on your computer, you must configure them to work in your IBM Cognos environment.

Initially, default property settings chosen by IBM Cognos are used to configure the IBM Cognos Controller components. However, you may want to change these default settings if existing conditions make the default choices inappropriate, or to better suit your environment.

Other configuration tasks are optional and depend on your IBM Cognos environment. Use these optional configuration tasks to customize your configuration so that IBM Cognos Controller integrates easily into your existing environment. You can also configure IBM Cognos Controller to use other resources. For example, you can use an authentication provider and then enable single signon for the database connection and the users.

Use IBM Cognos Configuration to configure your IBM Cognos Environment URIs and to specify the database connection properties to the content store. When you change the value of a property, you must save the configuration and then restart the IBM Cognos service to apply the new settings to your computer.

Use IBM Cognos Controller Configuration to configure your Controller data source and Controller data mart connections, the COM+ Server, and server authentication. When you change the value of a property, you must save the configuration.

Import the IBM Cognos Controller Standard Reports Package

Before you can run IBM Cognos Controller and view reports in Cognos Viewer, you must import the IBM Cognos Controller standard reports package into Content Manager.

Procedure

1. Launch IBM Cognos Administration.
2. Click the Configuration tab, and then click Content Administration.
3. On the toolbar, click the New Import button. The New Import wizard appears.
4. In the Deployment archive box, click the Controller package, and then click Next.
5. Type the name and an optional description and screen tip for the deployment specification, select the folder where you want to save it, and then click Next.
6. Select the content that you want to include in the import.
7. Select the options you want, along with your conflict resolution choice for options that you select.
8. In the Specify the general options page, select whether to include access permissions and references to external namespaces, and who should own the entries after they are imported in the target environment.
9. Click Next.

The summary information appears.

10. Review the summary information and click Next.
11. In the Select an action page, select Save and run once, and then click Finish.

Results

After you run the import, the IBM Cognos Controller reports package appears in your IBM Cognos Connection content.
Verifying the import of the standard reports package

Test the import of the standard reports package. The Report Server can use the information in the package to determine the structure of data in the IBM Cognos Controller database.

About this task
The Report Server renders IBM Cognos Controller reports, in PDF and HTML formats, using information provided in the Controller standard reports package.

IBM Cognos software keeps history information each time an entry runs in the background. The run history for an entry includes information such as the request time, start time, completion time, and whether the deployment import ran successfully. You can look at a more detailed run history for the entry, which includes general, error, and warning messages related to the entry and any actions that you can take.

Procedure
1. In IBM Cognos Connection, click Launch, IBM Cognos Administration.
2. On the Configuration tab, click Content Administration.
3. Locate the package that you imported, under Actions, click More, and then click View run history.
4. Under Statuses, ensure that All statuses is selected.
   The View run history details page shows run details, such as start time and completion time, run status, and error messages for a failed run. Verify that the status of the import shows as Succeeded.
5. If you want to view the run history details for an import that has failed, in the Actions column, click the View run history details icon next to the entry.

Set Import Directories for Flat Files
If a Controller user intends to import external data contained in flat files, you must specify the directories that contain the files so that they are available for selection when importing the data. This step is necessary only if the files are not located on the client computer so that the Controller user can select the Server option for Import file provider.

You set these directories on the Web services server.

Procedure
1. From the Start menu, start IBM Cognos Controller Configuration.
2. In the Explorer window, click Import Directories.
3. In the Properties window, click the browse button and go to the folder that contains the text files to be imported into IBM Cognos Controller, and click OK.
4. Repeat the previous step to add more than one folder.
5. From the File menu, click Save.

Schedule a Performance Optimization Procedure for an Oracle Controller Database
IBM Cognos Controller provides an SQL procedure that analyses the schema in the Controller database and gathers the appropriate statistics, which Oracle requires for optimal performance. This procedure can be run by the Controller user, but we recommend that you create a job to run it automatically on a weekly basis.
Procedure

1. Create a file and add the following command lines:

```sql
SQL> DECLARE JOB BINARY_INTEGER;
BEGIN
DBMS_SCHEDULER.create_job (    job_name => 'Analyze_Controller_Schema_week',
job_type => 'PLSQL_BLOCK',
job_action => 'BEGIN PRC_ANALYZE_SCHEMA; END;',
start_date => SYSTIMESTAMP,
repeat_interval=> 'freq=weekly; byday=sat; byhour=9; byminute=0; bysecond=0;',
end_date => NULL,
enabled => TRUE,
comments => 'Analyze schema job to be run Saturdays 9:00 AM');
END;
```

2. Run the file on a weekly basis.

Using the Controller Data Mart

To use the Publish to Data Mart Framework Manager model provided with IBM Cognos Controller, do the following tasks:

1. Create a Controller data mart database.
2. Set database connection properties for the data mart.
3. Extract and publish the data mart.

Create a Controller Data Mart Database

If you want to use the Publish to Data Mart Framework Manager model provided with IBM Cognos Controller, you must create an additional database to use for the Controller data mart.

Before you begin

The Controller data mart database must be created using DB2, Oracle or Microsoft SQL Server.

To see an up-to-date list of environments supported by Cognos Controller, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, run the Software Product Compatibility Reports (http://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/prereqsForProduct?deliverableId=AF89C710264211E98D5DA703D189F003).

Create a Controller Data Mart Database for DB2

If you want to use the Publish to Data Mart Framework Manager model provided with IBM Cognos Controller, you must create an additional database to use for the Controller data mart. Here are the steps you must follow for DB2.

Procedure

1. Determine whether the database is Unicode.
   
   To check if the database is Unicode, type the following at the command prompt:
   
   ```bash
   Db2 get db cfg for <databasename here> | find "code set"
   ```
   
2. If the result set returns a code set that is not Unicode, create a new database that uses a Unicode code set.
3. Set the territory identifier to the correct language.
4. In Windows, add the user account to both the DB2ADMNS and DB2USERS groups.
5. The user account that accesses the data should be the same that owns the database objects (tables, indexes).
6. Grant the following privileges to the user account that owns and accesses the database:
To be able to connect to the data mart from the Controller database, the data mart server and database need to be cataloged.

Type the following at the command prompt:

- catalog the server;
  
  catalog tcpip node <Node name> remote <hostname> server <port>;

- catalog the database;
  
  catalog database <databasename> as <alias> at node <node name> authentication server

To list nodes and databases, type the following at the command prompt:

- Db2 list node directory
- Db2 list database directory

For more information about cataloging the database, see the DB2 Database Administration Concepts and Configuration Reference.

Results

Performance in a DB2 database will often change over time, and it is crucial to keep track of this. For database maintenance, contact your database administrator.

Create a Controller Data Mart Database for Microsoft SQL Server

If you want to use the Publish to Data Mart Framework Manager model provided with IBM Cognos Controller, you must create an additional database to use for the Controller data mart. Here are the steps you must follow for Microsoft SQL Server.

Procedure

1. If you performed a Typical installation of Microsoft SQL Server, after you install you must change the authentication mode to SQL Server and Windows.

   For more information, see the related knowledge base article on the Microsoft Web site.

2. Create the database.

   Ensure that the database collation sequence is case insensitive.

3. Determine which user account Controller Web Services Server will use to access the database.

4. Grant create table privileges for the database to the user account.

   Ensure that the user account is a member of the db_owner role.

Create a Controller Data Mart Database for Oracle

If you want to use the Publish to Data Mart Framework Manager model provided with IBM Cognos Controller, you must create an additional database to use for the Controller data mart. Here are the steps you must follow for Oracle.
Procedure

1. Determine whether the database is Unicode.
   
   Tip: One method is to type the following select statement:
   
   ```sql
   select * from NLS_DATABASE_PARAMETERS
   ```
   
2. If the result set returns an NLS_CHARACTERSET that is Unicode, create a database that uses a Windows 1252 character set such as WE8MSWIN1252 (non-unicode).

3. Determine which user account Controller Web Services Server uses to access the database.

4. Grant the following privileges to the user account that accesses the database:
   
   - create session
   - alter session
   - create table
   - create database link
   - create sequence
   - create trigger
   - create view
   - create procedure
   - create materialized view
   - create synonym
   - create job
   - select_catalog_role
   - unlimited tablespace

5. Create a tablespace and set it as the default tablespace for exclusive use by the user account that accesses the Controller data mart database.

Results

You can increase the performance of your Oracle database by changing the default setting of the optimizer_index_cost_adj parameter in the init.ora file. We recommend that you change the default setting of 100 to a much smaller number, for example: `set optimizer_index_cost_adj = 5`.

Set Database Connection Properties for the Controller Data Mart

To prepare for using the Publish to Data Mart Framework Manager model, provided with IBM Cognos Controller, you must create a database connection to the empty Controller data mart database, which you previously created.

Before you begin

Before you configure the Publish to data mart connection, you must have set the connection properties for the Controller database. The Controller database contains the data to be published to the data mart.

Procedure

1. From the Start menu, start Controller Configuration.

2. In the Explorer window, click Database Connections for publish to data mart.

3. In the Properties window, select the Controller database that will be used to publish to the data mart.

4. In the Provider box, type the name of the database provider that is appropriate for the database type that is hosting the data mart.

   For information about the database provider, see the DB2, Oracle or SQL Server documentation.
5. In the **User ID** and **Password** boxes, type the user name and password for the data mart database.
6. In the **Initial catalog** box, type the data mart database name.
7. In the **Data source** box, type the name of the server computer that hosts the data mart database. 
   Do not use localhost.
8. Click **File > Save**.
9. Click **Actions > Check**.
   If the database connection validation fails, review the database connection properties and fix any errors.
10. In the **Explorer** window, under **Database Connections**, click the Controller database that will be used to publish to the data mart.
11. Click **Actions > Run**.
12. If no Java is found, browse to and select the Java 7 JRE in the `installdir\bin64\jre\7.0\` directory.
13. If you have more than one Oracle version installed a message appears, select the same Oracle version that you are using with Controller.
14. Click **Data Mart DB**.
15. In the **UDL File** box, browse to the location of the UDL file for the Controller data mart database at `ccr_location \DMData` and click **Open**.
16. Click **Create DB**.
   The Database Conversion Utility creates the data mart tables.
17. Click **Close**.
18. Click **File > Save**.
19. In the **Explorer** window, under **Web Services Server**, click **Report Server**.
   If the repair button is unavailable, the data mart database is already known to Content Manager. The new data mart database is now configured as a data source for Report Server, and is listed as a data source in IBM Cognos Connection.

**Define a Data Source for the Controller Data Mart**

If you are preparing to use the Publish to Data Mart Framework Manager model provided with IBM Cognos Controller, you must define a new data source so that Framework Manager can communicate with the Controller data mart database. You can define data sources in IBM Cognos Administration or in Framework Manager. The data source appears in both places, regardless of where it was defined. Existing data source connections can be edited only in the portal.

**Procedure**

1. Launch IBM Cognos Administration.
2. On the **Configuration** tab, click **Data Source Connections**.
3. Click the **New Data Source** button.
4. In the **Name** box, type **CCR82_DM**, the name of the Controller data mart database.
5. In the **Description** box, type text to describe the database, and then click **Next**.
6. In the **Type** box, select the appropriate database type for the data mart database.
   The connection string page for the selected database appears.
7. Enter any parameters that make up the connection string, and specify any other settings, such as a signon or a timeout.
   **Note:** If you are using DB2, you need to add `MapDecimalFloatDescribe=3` into the DB2 connect string text box.
Tip: To test whether parameters are correct, click Test. If prompted, type a user ID and password or select a signon, and then click OK.

8. Click Finish.

The data source appears as an entry in the Directory tool in the portal, and can be selected when using the import wizard in IBM Cognos Framework Manager.

Extract the Publish to Data Mart Model and Publish It to IBM Cognos Connection

You must unzip the Publish to Data Mart Framework Manager model and publish it to IBM Cognos Connection so that a report author can use the model in Report Studio for creating custom reports.

Before you begin

You must have IBM Cognos Framework Manager installed and configured before you can open the Publish to Data Mart model.

Procedure

1. Copy the CCR82_DM.zip file from the ccr_location/deployment directory to a location that is accessible by Framework Manager.
2. Unzip the CCR82_DM.zip file to extract the CCR82_DM.cpf model.
3. In IBM Cognos Framework Manager, from the File menu, click Open and go to the location of CCR82_DM.cpf project file and then click Open.
4. In the Project Viewer, expand the CCR82_DM folder, under Packages, click CCR82_DM, and from the Actions menu, click Package and then select Publish Packages.
5. Click Publish.
   A message informs you that the model is published under Public Folders CCR82_DM in IBM Cognos Connection.
6. Click Finish and then click Close.
7. Close Framework Manager.

Changing IBM Cognos Controller Default Configuration Settings

When you install IBM Cognos Controller components, the installation uses default configuration settings. If you have any reason not to use these default values, such as a port is being used by another process, use the IBM Cognos Controller configuration tools to change the value.

If you change the value of a property using IBM Cognos Controller Configuration, you must save the configuration to apply the new setting to your computer.

Using IBM Cognos Controller Configuration, you can do the following things:

- Add or remove Controller database Connections
- “Change the COM+ Server Configuration” on page 95
- “Enabling the batch service” on page 95
- “Enable Enhanced Reporting Optimization” on page 95
- “Change the Default Installation of the IBM Cognos Controller Link for Microsoft Excel” on page 97

Add or Remove Controller Database Connections

You must set up a Controller database connection during the IBM Cognos Controller installation and configuration process. After the installation and configuration process is complete, you can add additional data source connections, or delete data source connections.
Add a Controller Database Connection
You must set up a Controller database connection during the IBM Cognos Controller installation and configuration process.

Procedure
1. From the Start menu, start Controller Configuration.
2. In the Explorer window, click Database Connections, and then click File > New.
3. In the Properties window, click the Database type box, and then use the drop-down arrow to select the database type.
   You can choose DB2, Oracle or SQL Server.
4. In the Name box, type a name for the database.
   Choose a name that is meaningful for IBM Cognos Controller users.
5. In the Provider box, type the name of the database provider.
   To obtain the database provider information, see the DB2, Oracle or SQL Server documentation.
6. In the User ID and Password boxes, type the user name and password for the Controller database.
7. In the Initial catalog box, type the Controller database name.
8. In the Data source box, type the database server computer name.
   **Tip:** Do not use localhost.
9. Click File > Save.
10. In the Explorer window, expand Database Connections.
11. Select the database that you want to upgrade.
12. Click Actions > Run.
13. If no Java is found, browse to and select the Java 7 JRE in the installdir\bin64\jre\7.0\ directory.
14. If you have more than one Oracle version installed a message appears, select the same Oracle version that you are using with Controller.
15. Click Connect, and then Upgrade.
   The Database Conversion Utility upgrades the existing database.
16. Click Close.
17. Click Actions > Check.
   If the database connection validation fails, review the database connection properties and fix any errors.
18. Click File > Save.
   The new database is now configured as a data source for Report Server, and is listed as a data source in IBM Cognos Connection.

Delete a Database Connection
After the installation and configuration process is complete, you can add additional data source connections, or delete data source connections.

Procedure
1. From the Start menu, start Controller Configuration.
2. In the Explorer window, click Database Connections, and then click the database connection you want to delete.
3. Click File > Delete.
4. Click **File > Save**.

**Change the COM+ Server Configuration**

You configure the COM+ Server during the initial IBM Cognos Controller installation and configuration. However, you can change the account under which the COM+ service runs at any time.

**Procedure**

1. From the **Start** menu, start IBM Cognos Controller Configuration.
2. In the **Explorer** window, click **COM+ Server**.
3. In the **COM+ Server** window, click the **Shutdown** button.
4. In the **COM+ Server** window, configure the COM+ Server:
   - Select **System Account** to configure the COM+ server with the computer’s system account.
   - Select **Specify Account** to configure the COM+ server with a user account that has administrator privileges on the computer.
5. If you selected **Specify Account**:
   - In the **User** box, type the user name for the account.
   - In the **Password** and **Confirm Password** boxes, type the password for the account.
6. From the **File** menu, click **Save**.

**Enabling the batch service**

When you install and configure IBM Cognos Controller, you must start the Cognos Controller Batch Service.

**Procedure**

1. On the computer where Cognos Controller is installed, click the **Start** menu, and then click **Controller Configuration**.
2. In the **IBM Cognos Controller Configuration** window, click **Client Distribution Server Configuration**.
3. In the **WSSUrl** field, enter the URI for your IBM Cognos Controller Web Service Server (IIS server).
4. Click **Save**.
5. Click **Batch Services**.
6. From the **Actions** menu, click **Run**.

**Enable Enhanced Reporting Optimization**

When IBM Cognos Controller Microsoft Excel reports contain a significant amount of data, the Enhanced Reporting Optimization feature provides for faster data transfer from the IBM Cognos Controller client to the Controller database.

When a report is run using Enhanced Reporting Optimization, Microsoft Excel sends a string to a file share on the database server. The file is inserted in the Controller database using bulk insert technology, and the report runs from that location.

Enhanced Reporting Optimization uses one of two methods: File Copy or File Transfer (FTP). Use the File Copy method for Microsoft SQL Server databases or for Oracle databases when the Oracle server is installed on a Windows operating system. Use the FTP method for Oracle databases when the Oracle server is installed on an operating system other than Windows, for example a Linux or UNIX operating system.

**Configure the File Copy Method**

Use the File Copy method for Microsoft SQL Server databases or for Oracle databases when the Oracle server is installed on a Windows operating system.
Before you begin

Before you configure the File Copy method, you must

• create a shared directory on the database server
• provide the IBM Cognos Controller administrator with read and write access permissions to the shared folder on the database server, or create a local account with read and write access permissions to the shared folder on the database server
• set read and write access permissions on the shared folder for the database server
• for Microsoft SQL Server databases, enable the Bulk Insert Administrators server role for the Controller database owner

In addition, set the Controller database owner as the owner of tempdb and model.

• for Oracle databases, set the UTL_FILE_DIR parameter to point to the local path of the shared directory
• configure reports to use Enhanced Reporting Optimization

Procedure

1. To configure reports to use enhanced reporting optimization, in Microsoft Excel, in the first worksheet in the report, position your cursor in cell A1.
2. From the Insert menu, click Name, Define.
3. In the Define Name box, under Names in workbook, type Optimise2, and then click OK.

You are now ready to configure the file copy method.

4. To configure the file copy method, from the Start menu, start IBM Cognos Controller Configuration.
5. In the Explorer window, click Enhanced Reporting Optimizations.
6. In the Enhanced Reporting Optimizations window, in the Select Connection drop-down list, select a database.
7. Under Connection Optimizations, in the File Mode box, click the drop-down arrow and select File Copy.
8. In the Server box, type the computer name for the server on which you created the shared directory.
9. In the Share box, type the name of the share you created in Step 1.
10. For Oracle databases, in the Server Directory box, type the path to the shared directory that will be used by the Oracle database.

Example: e:\oracle\ora92\utlfile

Note: The name of the shared directory is case sensitive. Use the same value that you set for the UTL_FILE_DIR parameter.
11. If the database is in another domain, in the User ID and Password boxes, type the logon user name and password for the domain user.

The password is encrypted with IBM Cognos Controller standard encryption.
12. From the File menu, click Save.

Configure the File Transfer Protocol (FTP) Method
Use the FTP method for Oracle databases when the Oracle server is installed on an operating system other than Windows, for example a Linux or UNIX operating system.

Before you begin

Before you configure the FTP method, you must:

• set up an FTP server on the database server
• create a shared directory on the database server with a user that has read and write access permissions
• set read and write access permissions on the shared folder for the database server
• for Oracle databases, set the UTL_FILE_DIR parameter to point to the local path of the shared directory
• configure reports to use Enhanced Reporting Optimization

Procedure

1. To configure reports to use enhanced reporting optimization, in Microsoft Excel, in the first worksheet in the report, position your cursor in cell A1.
2. From the Insert menu, click Name, Define.
3. In the Define Name box, under Names in workbook, type Optimise2, and then click OK.
4. To configure the file transfer protocol (FTP) method, from the Start menu, start IBM Cognos Controller Configuration.
5. In the Explorer window, click Enhanced Reporting Optimizations.
6. In the Enhanced Reporting Optimizations window, in the Select Connection drop-down list, select a database.
7. Under Connection Optimizations, in the File Mode box, click the drop-down arrow and select File Transfer (FTP).
8. In the Server box, type the computer name for the FTP Server.
9. In the FTP Sub Directory box, type the name of the FTP sub-directory.
10. In the Server Directory box, type the path to the shared directory that will be used by the Oracle database.

   Example: e:\oracle\ora92\utlfile

   Note: The name of the shared directory is case sensitive. Use the same value that you set for the UTL_FILE_DIR parameter.
11. In the User ID and Password boxes, type the FTP account user name and password.

    The password is encrypted with IBM Cognos Controller standard encryption.
12. In the Access Type box, click the drop-down arrow and select the FTP access type.

    Select Direct, Proxy, or Windows Standard.
13. In the Passive Mode box, click the drop-down arrow and choose whether to enable passive mode:

    • Select True to enable passive mode when connecting to the FTP server.
    • Select False to disable passive mode when connecting to the FTP server.
14. In the Port box, specify the port for the FTP connection.
15. If you selected the Proxy access type, in the Proxy box, type the name for the FTP proxy computer.
16. If you selected the Proxy access type, in the Proxy bypass box, type the names of the FTP proxy computers to avoid.
17. From the File menu, click Save.

Change the Default Installation of the IBM Cognos Controller Link for Microsoft Excel

When users first run the IBM Cognos Controller client, the IBM Cognos Controller Link for Microsoft Excel is installed automatically. If you installed the IBM Cognos Controller Link for Microsoft Excel remotely for users by using Active Directory or Patchlink, you may want to disable the automatic installation.

Procedure

1. On the computer where Controller Client Distribution Server is installed, from the Start menu, start IBM Cognos Controller Configuration.
2. In the Explorer window, expand IBM Cognos Controller Configuration, Client Distribution Server.
3. Click Client Distribution Server Configuration.
4. Click Install IBM Cognos Controller Link for Microsoft Excel.
5. Change the value to False.
6. From the File menu, click Save.
Configure the Router to Test Dispatcher Availability

If you use a router to distribute requests to IBM Cognos dispatchers, and the router can test the availability of a server using a test URL, you can configure the router to test the availability of an IBM Cognos dispatcher.

**Procedure**

Configure the router to use a URL with the path `/p2pd/servlet/ping`.

If the dispatcher is not ready, the following response is returned:

503 Service Unavailable

If the dispatcher is ready, the following response is returned:

200 OK

Configuring IBM Cognos Controller to Work with Other IBM Cognos Products

Some IBM Cognos products provide functionality that is not available in IBM Cognos Controller. You can continue to use these products in the same environment. Additional configuration tasks may be required to ensure that IBM Cognos Controller can access objects that were created using other IBM Cognos products. Additional requirements for access depend on how you choose to run the two products.

Accessing Product Documentation in an Integrated Environment

The documentation for IBM Cognos components is installed with the gateway component. If you integrate different IBM Cognos products, you can either use the same gateway or use separate gateways. If you want to use the same gateway, all gateway components must be of the same product version, and you should install the IBM Cognos gateway component for each product into the same location on the same computer. This ensures that all of the product documentation is available to all users. If you want to use separate gateways for each product, you can install the IBM Cognos gateway component for each product on separate computers, but the product documentation on each gateway will be specific for the IBM Cognos product you installed.

For example, you have IBM Cognos Business Intelligence and IBM Cognos Controller installed using separate gateways but sharing the same content store. When users access IBM Cognos Connection, both Report Studio and Controller are available, assuming they have permission for both components. If users access Report Studio through the IBM Cognos Business Intelligence gateway, they are able to use the component and access the documentation for that component. However, if users access Report Studio through the IBM Cognos Controller gateway, they are able to use the component but do not have access to the Report Studio documentation.

If you want users to access each IBM Cognos product through separate gateways, yet still be able to access documentation for all components, you can install each product’s gateway component into the same location as your other IBM Cognos gateway components.
Chapte..._12. Setting Up an Unattended Installation and Configuration

Set up an unattended installation and configuration to

• install an identical configuration on several computers on your network
• automate the installation and configuration process by specifying options and settings for users

Unattended installations for IBM Cognos Controller can only be set up for single-computer installations.

**Important:** All configuration tasks using IBM Cognos Controller Configuration must be completed manually.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all other products are installed and configured.

To set up an unattended installation and configuration, you must complete these tasks:

__ • Configure a transfer specification file (.ats) to specify installation options.
__ • Run the installation tool in silent mode.
__ • Use a preconfigured IBM Cognos Controller configuration file from another computer.
__ • Run IBM Cognos Configuration in silent mode.

After you complete these tasks, you must also do the following:

__ • Ensure that the IBM Cognos Controller installation directory on all computers is protected from unauthorized or inappropriate access.
__ • Import the IBM Cognos Controller Framework Manager package.
__ • Configure the IBM Cognos Controller Configuration settings manually.

You are now ready to use IBM Cognos Controller.

### Set Up an Unattended Installation

Use a transfer specification file (.ats) to copy IBM Cognos Controller components to your computer without being prompted for information.

By default, each time you install Cognos Controller components using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed Cognos Controller components on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

**Procedure**

1. Use the installation wizard to install Cognos Controller components on your computer.
2. Go to the `ccr_location/instlog` directory.
3. Locate the transfer specification file (.ats) that was generated.

   The file name is `ts-CONTRL-version-yyyymmdd_hhmm.ats`.
4. Copy the transfer specification file to the computer where you are installing Cognos Controller.
5. Copy the contents of the Cognos directory from the original computer to the computer where you are installing the software.
6. Install Cognos. From the Start menu, click Programs, Command Prompt to open a Command Prompt window, and then type the following command, where location is the directory where you copied filename, the transfer specification file:

```bash
isssetup -s location/filename.ats
```

**Results**
If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the installation directory in the following log file:

```text
 tl-CONTRL-version-yyyyymmd-hhmm_summary-error.txt
```

If errors occur before sufficient initialization occurs, log messages are sent to one of the following log files in the Temp directory:

```text
 tl-CONTRL-version-yyyyymmd-hhmm.txt
```

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended IBM Cognos Controller configuration.

**Set up an unattended installation using the response.ats file**
If you do not use the installation wizard to install components, you can use the default transfer specification response.ats file. You must modify the response.ats file for your environment before you can use it for an unattended installation.

**Procedure**

1. Copy the Controller installer package download location/win32 directory from the computer where you downloaded Cognos Controller to the computer where you want to do the unattended installation.
2. Go to the win32 directory and open the response.ats file in a text editor.
   
   Each section in the response.ats file corresponds to a dialog box in the installation wizard.
3. Type the installation location of the program files for IBM Cognos Controller:
   ```text
   appPath=location
   ```
   
   **Tip:** There should be no space on either side of the equal (=).
4. For the server components of IBM Cognos Controller, in the section named Component List, next to each component do one of the following:
   - To install the component, type 1.
   - To not install the component, type 0.
5. For the APPFOLDER= property, type the name of the Start menu folder that contains your program shortcuts.
   
   **Tip:** To ensure that the shortcut folder is visible to all users, type 1 for the VISIBLETOALL= property.
6. For the install information in the [Install Conditions] section:
   - To specify the condition is true, type 1
   - To specify the condition is false, type 0
7. Save the response.ats file to a local directory after you make the necessary changes.
8. Go to the win32 directory.
9. At the command prompt type the following command, where location is the directory where you copied the response.ats file:

```bash
isssetup -s location/response.ats
```
Results
If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the installation directory in the following log file:

`tl-CONTRL-version-yyyymmdd-hhmm_summary-error.txt`

If errors occur before sufficient initialization occurs, log messages are sent to one of the following log files in the Temp directory:

`tl-CONTRL-version-yyyymmdd-hhmm.txt`

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended IBM Cognos Controller configuration.

Set Up an Unattended Configuration

Before you set up an unattended IBM Cognos Controller configuration, you must export a configuration from another computer that has IBM Cognos Controller installed. You can then run IBM Cognos Configuration in silent mode.

The exported configuration contains the properties of the IBM Cognos Controller components that you installed on the source computer. If you made changes to the global configuration, you must also copy the global configuration file from the source computer to the computer where you plan to run an unattended configuration. Global configuration includes such settings as content locale, product locale, and cookie settings.

Ensure that the configuration settings on the local computer are appropriate to use to configure another IBM Cognos Controller computer with the same installed components. For example, if you changed the host name portion of the Gateway URI property from local host to an IP address or computer name, ensure this setting is appropriate for the new computer's configuration.

You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Procedure
1. In IBM Cognos Configuration, from the File menu, click Export as.
2. If you want to export the current configuration to a different folder, in the Look in box, locate and open the folder.
   
   Ensure that the folder is protected from unauthorized or inappropriate access.
3. In the File name box, type a name for the configuration file.
4. Click Save.
5. Copy the exported configuration file from the source computer or network location to the `ccr_location/configuration` directory on the computer where you plan to do an unattended configuration.
6. Rename the file to cogstartup.xml.
7. If you changed the global configuration on the source computer, copy the coglocale.xml file from the source computer to the `ccr_location/configuration` directory on the computer where you plan to do an unattended configuration.
8. Go to `ccr_location/bin`.
9. Type the configuration command:
   
   `cogconfig.bat -s`

   **Tip:** To view log messages that were generated during an unattended configuration, see the cogconfig_response.csv file in the `ccr_location/logs` directory.
Results
IBM Cognos Configuration applies the configuration settings specified in the local copy of cogstartup.xml, encrypts credentials, generates digital certificates, and if applicable, starts IBM Cognos Controller services or processes.

Import the IBM Cognos Controller Standard Reports Package
Before you can run IBM Cognos Controller and view reports in Cognos Viewer, you must import the IBM Cognos Controller standard reports package into Content Manager.

Procedure
1. Start IBM Cognos Connection.
2. On the portal toolbar, click Tools, and then click Content Administration.
3. On the toolbar, click the New Import button. The New Import wizard appears.
4. In the Deployment archive box, click the Controller package, and then click Next.
5. Type an optional description and screen tip for the deployment specification, select the folder where you want to save it, and then click Next.
6. Select the content that you want to include in the import.
7. Select the options you want, along with your conflict resolution choice for options that you select.
8. In the Specify the general options page, select whether to include access permissions and references to external namespaces, and who should own the entries after they are imported in the target environment.
9. Click Next.

The summary information appears.
10. Review the summary information and click Next.
11. In the Select an action page, select Save and run once, and then click Finish.

Results
After you run the import, the IBM Cognos Controller reports package appears in your IBM Cognos Connection content.

Configure Start Configuration Settings Manually
After you run an unattended installation and configuration, you must configure the IBM Cognos Controller Configuration settings manually.

Procedure
1. Configure the IBM Cognos Controller database connection.
2. Configure the COM+ Server.

Set Database Connection Properties for the Controller Data Source
Before you can run IBM Cognos Controller, you must configure a Controller database connection. IBM Cognos Controller databases must be created using either DB2, Oracle or Microsoft SQL Server.

To run reports against IBM Cognos Controller data sources, the data sources must be configured for Report Server and appear in IBM Cognos Connection.

If you are installing IBM Cognos Controller for the first time, or if you do not want to connect to an existing Controller database, you can create a database connection to an empty Controller database.
Before you begin

If you want to create a connection to an existing Controller database, we recommend that you create a backup of your database before you create the Controller data source connection. This is because the Controller Database Conversion Utility, which runs against the database during the data source connection process, updates the database tables for use with IBM Cognos Controller.

Procedure

1. From the Start menu, start Controller Configuration.
2. In the Explorer window, click Database Connections, and then click File > New.
3. In the Properties window, click the Database type box, and then use the drop-down arrow to select the database type.
   You can choose DB2, Oracle or SQL Server.
4. In the Name box, type a name for the database connection.
5. In the Provider box, type the name of the database provider.
   To obtain the database provider information, see the DB2, Oracle or SQL Server documentation.
6. In the User ID and Password boxes, type the user name and password for the Controller database.
7. In the Initial catalog box, type the Controller database name.
8. In the Data source box, type the database server computer name.
   Do not use localhost.
9. Click File > Save.
10. In the Explorer window, expand Database Connections.
11. Select the database you want to upgrade.
12. Click Actions > Run.
13. If no Java is found, browse to and select the Java 7 JRE in the installdir\bin64\jre\7.0\ directory.
14. If you have more than one Oracle version installed a message appears, select the same Oracle version that you are using with Controller.
15. If this is an empty Controller database, in the Database Conversion Utility window, click Create Db.
   The Database Conversion Utility initializes the database.
   Note: When you create a new database, by default the database version is 813. You then need to perform database upgrade to the latest version of IBM Cognos Controller.
16. In the Database Conversion Utility dialog box, click Connect and then click Upgrade.
   The Database Conversion Utility upgrades the existing database.
   Note: To upgrade database versions lower than 789 use the old Database Conversion Utility tool in the c10\legacy directory.
17. Click Close.
18. From the Actions menu, click Check.
   If the database connection validation fails, review the database connection properties and fix any errors.
19. From the File menu, click Save.
20. In the Explorer window, under Web Services Server, click Report Server.
   The new database is now configured as a data source for Report Server, and is listed as a data source in IBM Cognos Connection.
Configure the COM+ Server

After you configure network access to the COM+ Server, you must configure the Controller COM+ Server to run under a dedicated user.

Procedure

1. From the Start menu, start IBM Cognos Controller Configuration.
2. In the Explorer window, click COM+ Server.
3. In the COM+ Server window, click Specify Account to configure the COM+ Server with a user account that has administrator privileges on the computer.
4. In the User box, type the user name for the account.
5. In the Password box, type the password for the account.
6. In the Confirm Password box, retype the password for the account.
7. Click in the space under COM+ Role, and then from the File menu, click New.
8. Under COM+ Role, type ControllerUsers.
9. Under COM+ User, type IUSR_XXX, where XXX is the ID configured in IIS for anonymous access.
   This ID must be the same ID under which you configured the Web aliases.
   To locate the IIS anonymous access ID, in IIS, right-click the ibmcognos Web alias, and then click Properties. On the Directory Security tab, click the Edit button. Copy the Anonymous AccessID in the User name box.
10. From the File menu, click New.
11. Under COM+ Role, type ControllerUsers.
12. Under COM+ User, type IWAM_XXX, where XXX is the ID configured in IIS for anonymous access.
13. From the Actions menu, click Check to validate each user.
14. From the File menu, click Save.
Chapter 13. Financial Statement Reporting integration for Cognos Controller

IBM Cognos Financial Statement Reporting (FSR) is a unified financial governance solution that focuses on improving financial processes and controls, particularly in the final stages before disclosure.

**Note:** IBM Cognos FSR was renamed to IBM Cognos Disclosure Management. You can integrate either product with Controller. For more information, see Chapter 15, “Cognos Disclosure Management integration for Cognos Controller,” on page 115.

Cognos FSR helps the finance department improve the timeliness and quality of financial management processes and reporting. It also facilitates audits, extends enterprise resource planning (ERP) transactional controls, and improves financial risk management.

With Cognos FSR, formatted statutory financial reports, including commentary and supplementary notes, are dynamically generated from a central database. Cognos FSR provides a collaborative environment that incorporates workflow and audit trails that contribute to data accuracy and provide effective internal controls for corporate governance.

When you integrate IBM Cognos Controller Link for Microsoft Excel with Cognos FSR, the following functions and capabilities of Cognos FSR will help you to build and collaborate on a report:

- **Data Integration**
  - This feature provides an easy-to-use method to pull data from various data sources, including leading ERP systems, leading consolidation systems, relational databases, OLAP databases, and Microsoft Excel.

- **Output capability**
  - Cognos FSR supports various output options, including Microsoft Word, Microsoft Excel, PDF, XBRL (with any taxonomy), and EDGAR-ready documents (for filing to the SEC).

- **User security**
  - Cognos FSR provides controlled access to sensitive information and helps to maintain privacy.

For more information about Cognos FSR, see the *IBM Cognos Financial Statement Reporting End User Guide*.

**Cognos FSR access to Cognos Controller**

You can configure IBM Cognos Financial Statement Reporting (FSR) to access IBM Cognos Controller accounts under several of the supported authentication environments.

Cognos Controller supported versions include Cognos Controller 8.5.1 IF7, Cognos Controller 8.5.1 IF14, and Cognos Controller 10.1 IF1 through to 10.1 IF6.

If you need support for languages other than English, use Cognos FSR 6.6.1 and Cognos Controller 10.1.1 or Cognos Controller 10.1 IF 8.

**Important:** In Cognos FSR, you must enable macro security when you use Cognos Controller. For more information about macro security, see the *IBM Cognos Financial Statement Reporting (FSR) Administration Guide*.
Cognos authentication services
Authentication is the process of identifying individuals before you allow them to log on.

Authentication in Cognos Controller is managed by using Cognos Controller native or local security, Cognos security with other authentication providers, or Windows authentication.

You can configure one of the following authentication services to include Cognos FSR.

- **Native security**
  Native security is the default authentication method. When you start IBM Cognos Controller, you are prompted to choose a database and log on. When you provide the appropriate credentials, you are allowed to log on to Cognos Controller. If you use native security to secure the Controller database, you must configure anonymous access to the reporting components by using Cognos security.

- **IBM Cognos security**
  Cognos security allows anonymous access to reporting components when native security is defined for the Controller components or authenticated access to both Controller and reporting components.
  
  For authenticated access, when you attempt to access Cognos Controller, you are prompted to log on to the application. When you provide the appropriate application credentials, you are allowed to access Cognos Controller.

- **Windows authentication**
  Windows Authentication is the built-in authentication that is provided through the configuration of Microsoft Internet Information Services (IIS) and Microsoft .NET Framework.
  
  When Windows Authentication is enabled, user connections that are established with IIS on the Controller Web Services Server are validated and authenticated against the Cognos Namespace. If you meet the logon requirements for Windows, you are not prompted to provide logon credentials when you start Cognos Controller.

- **Cognos namespace**
  Cognos has its own namespace, which is in addition to the external namespaces that represent other authentication providers. The Cognos Namespace does not replicate the groups and roles that are defined in your authentication provider. Instead, you might want to use the Cognos Namespace to define groups and roles that can span multiple other authentication providers.

Integration of Controller with Cognos FSR using anonymous access authentication
You can integrate with IBM Cognos FSR if you set up IBM Cognos security as your authentication method.

IBM Cognos security allows anonymous access to reporting components when native security is defined for the IBM Cognos Controller components or authenticated access to both Controller and reporting components.

For authenticated access, when users attempt to access the following components, they are prompted to log on to the application. Only users who provide the appropriate application credentials are allowed access to IBM Cognos Controller.

- **Log on to IBM Cognos Controller Link for Microsoft Excel.**
  When you start Microsoft Excel and click **Log on** from the **Controller** menu, you must select the database, and enter your logon credentials.

- **Log on to IBM Cognos Controller Link for Microsoft Excel while hosted from Cognos FSR**
  When you log on to the IBM Cognos Controller Link for Microsoft Excel in an Excel object from Cognos FSR, the same **IBM Cognos Controller** and **Select Database** windows are displayed as if you were logging on from the stand-alone add-in.

- **Log on from Cognos FSR**
  In Cognos FSR, in the **Set Cognos Controller Account** window, you must specify the following properties:
– The user ID for the account on the Cognos Controller server.
– The password for the Cognos Controller account.
– The name of the Universal DataLink file that you are using for storing connection information.

Ensure that the following conditions are set when you use Cognos FSR in Anonymous Access authentication mode:

• IBM Cognos BI is configured to allow anonymous access.
• In Cognos Controller Configuration, the server authentication is set to Native.
• Microsoft Internet Information Services (IIS) is configured to accept anonymous login for the Cognos website (default: Default Web Site).

Related tasks
“Configure the IBM Cognos Controller Authentication Method” on page 73
“Run the IBM Cognos Controller Link for Microsoft Excel” on page 67

Configuring Cognos FSR to access a Controller account
You can configure IBM Cognos FSR to access an account on an IBM Cognos Controller server. Use the Set Cognos Controller Account window to configure access to the Cognos Controller account.

Before you begin
Before you load Cognos FSR, the IBM Cognos Controller Link for Microsoft Excel must be installed on the client computer and enabled in Microsoft Excel.

Procedure
1. In Cognos FSR, open a report.
2. Click Tools > Set Cognos Controller Account.

   Important: After you log in to Cognos FSR, the Cognos Controller Account window opens automatically. You can connect to one Controller server at a time. Enter the following information to connect to the Cognos Controller server and to ensure that you are not prompted twice when you load an object that contains Cognos Controller formulas.
3. In the User ID field, type the user ID for the account on the Cognos Controller server.
4. In the Password field, type the password for the Cognos Controller account.
5. In the UDL Name field, type the name of the Universal DataLink file that you are using for storing connection information. This file is configured on the Controller server.

   Tip: You can find the UDL file in the Controller root\Data directory.

Integration of Controller with Cognos FSR using Cognos Access Manager authentication
You can integrate with IBM Cognos Financial Statement Reporting (FSR) if you configured IBM Cognos Active Manager (CAM) as your authentication method and you are using Active Directory as your data source.

When an IBM Cognos Controller user attempts to access Cognos FSR data, the connection algorithm first determines whether an existing connection can be used. It then determines whether a previously logged-in user with an active connection shares a CAM group definition with the designated user. These user classes are given access privileges to the required application servers.

Ensure that the following configurations are set when users of Cognos FSR and Cognos Controller authenticate against CAM:

• On the computer where you installed Content Manager, in IBM Cognos BI Configuration, disable anonymous access.
• On the Cognos Controller server, in IBM Cognos Configuration, set up a valid Active Directory namespace.
Under **Environment**, ensure that the **Gateway namespace** property specifies the Active Directory namespace that you configured.

- In IBM Controller Configuration, set the authentication mode to **Windows Authentication**.
- You are unable to specify the CAM namespace in the Cognos FSR **Cognos Controller Account** window. Therefore, you must specify the namespace in the web.config file in the ControllerProxyServer folder; for example, `<add key="crnNameSpace" value="testAD"/>

- In the Microsoft IIS Manager console, disable anonymous access and enable Integrated Windows authentication.
- Add the URL of the Cognos Controller server to the trusted zone in Microsoft Internet Explorer, and configure this zone to use the current user name and password.

**Related tasks**

- “Disable Anonymous Access” on page 78
- “Configure an Active Directory Namespace” on page 79

### Disabling anonymous access to the Cognos Controller website

Use Microsoft Internet Information Services (IIS) Manager to disable anonymous access to the Cognos Controller website and enable Microsoft Windows authentication.

**Procedure**

1. In the **Internet Information Services (IIS) Manager** console, under **Connections**, expand **Sites**, and select the IBM Cognos website.

   **Tip:** To access the Microsoft Internet Information Services (IIS) Manager console, if you are using Microsoft Windows 7, click **Start** > **Control Panel** > **System and Security** > **Administrative Tools**.

2. To disable anonymous authentication and negotiate Kerberos, on the home page, under **IIS**, double-click **Authentication**, right-click **Anonymous Authentication**, and click **Disabled**.


### Configuring Internet Explorer to support Cognos FSR integration

You can have your credentials passed automatically to certain intranet sites so that you can use IBM Cognos FSR with the IBM Cognos Controller Link for Microsoft Excel. To enable this capability, you must add those intranet sites to the Local intranet zone in Microsoft Internet Explorer.

**Procedure**

1. Open Microsoft Internet Explorer, and click **Tools** > **Internet Options**.

2. Click the **Advanced** tab and, under **Security**, select the **Enable Integrated Windows Authentication** check box.

3. On the **Security** tab, in the **Select a zone to view or change security settings** group, select the **Local Intranet zone** icon, and click **Sites**.

4. In the **Local Intranet** window, select the **Automatically detect intranet network** check box, and click **Advanced**.

5. In the **Local Intranet** window, in the **Add this website to the zone** text box, enter the URL for the Cognos Controller server web application that is participating in the single signon configuration, and click **Add**. To add more than one, separate each name with a comma.

   If you use fully qualified domain names (FQDNs) to access the Cognos Controller web applications, ensure that the FQDNs are included in the intranet zone. You can do this either explicitly or by wildcard inclusion.

6. Click **Close**, and then click **OK**.

7. On the **Security** tab, in the **Select a zone to view or change security settings** group, select the **Local Intranet zone** icon.

8. In the **Security level for this zone** group, click **Custom Level**.
9. In the Security Settings window, under User Authentication, select Automatic logon with current user name and password, and click OK, and OK to close the window.

10. To apply the configuration changes, restart the web browser.

Integration of Controller with Cognos FSR using Cognos Controller native authentication

You can integrate with IBM Cognos Financial Statement Reporting (FSR) if you configured IBM Cognos Controller native security as the authentication method and you use Active Directory as your authentication provider.

Ensure that the following configurations are set when users of Cognos FSR and Cognos Controller authenticate against native security:

• On the computer where you installed Cognos Content Manager, in IBM Cognos BI Configuration, disable anonymous access.
• On the Cognos Controller server, in IBM Cognos Configuration, set up a valid Active Directory namespace.

Additionally, in the Explorer window, under Authentication, ensure that the IdentityMapping value is selected in the Advanced properties box.

Under Environment, ensure that the Gateway namespace box specifies the Active Directory namespace that you configured.

• In Cognos Controller Configuration, set the authentication mode to Windows Authentication.
• In the Microsoft IIS Manager console, disable anonymous access and enable Integrated Windows authentication.
• In Microsoft Internet Explorer, add the URL of the Cognos Controller server to the trusted zone, and configure this zone to use the current user name and password.

Related tasks
“Disable Anonymous Access” on page 78
“Configure an Active Directory Namespace” on page 79
“Disabling anonymous access to the Cognos Controller website” on page 108
Use Microsoft Internet Information Services (IIS) Manager to disable anonymous access to the Cognos Controller website and enable Microsoft Windows authentication.

“Configuring Internet Explorer to support Cognos FSR integration” on page 108
You can have your credentials passed automatically to certain intranet sites so that you can use IBM Cognos FSR with the IBM Cognos Controller Link for Microsoft Excel. To enable this capability, you must add those intranet sites to the Local intranet zone in Microsoft Internet Explorer.
Chapter 14. Configuring Cognos Controller Web

You must configure two IBM Cognos Controller Web components.

Before you begin

Install IBM Cognos Controller and select the check boxes for Controller Web and Controller Web Frontend.

Procedure

1. Find the server.env file in the installation directory.
   The default directory path is C:\Program Files\ibm\cognos\ccr_64\fcmweb\wlp\etc\.
2. Open server.env and set the JAVA_HOME installation directory to the location of the jre folder. The default location of the jre folder is JAVA_HOME=C:/Program Files/ibm/cognos/CCR_64/fcmweb/jre.
3. Open a command prompt window and run SyncDBConf.bat with the following parameters:
   **UDL files folder**
   Path to the folder that contains the UDL files (specifying database connections) defined for Cognos Controller
   **Data source folder**
   Output path for the folder that contains the data sources that are generated from the UDL files
   
   **Note:** You must have administrator permission to run this file.
   This file synchronizes Cognos Controller Web with the Uniform Data Language (UDL) files that are defined for databases used by Cognos Controller Web.
   For example, C:\Program Files\ibm\cognos\ccr_64\fcmweb\SyncDBConf.bat ..\Data wlp\usr\shared\config\datasources.
5. Open com.ibm.cognos.fcm.web.properties and set the following values:
   • ccrwsUrl=<the WSSUrl to which "/ccrws.asmx" is appended>. For example, ccrwsUrl=http://myControllerServer/ibmcognos/controllerserver/ccrws.asmx.
   • loginMode=NATIVE
6. Optional: You can change the available memory by doing the following steps:
   a) Find the jvm.options file in the C:\Program Files\IBM\cognos\ccr_64\fcmweb\wlp etc\ folder.
   b) Change the Xms/Xmx settings.
7. Open the Microsoft Windows Service Manager console, find IBM Cognos Controller Web, and start the service.
8. Find the config.js file in C:\Program Files\IBM\cognos\ccr_64\frontend.
9. Open the file in a text editor and make the following changes:
   a) Change the "proxies" – "options" – "target" – "host" parameter to the FQDN of the application server that is running Cognos Controller Web
      The parameter "proxies" – "options" – "target" refers to the connection to Controller Web Backend.
      For example, "host": "myhost.domain.com".
   b) Change the "expressJs" – "host" parameter to the address through which you want to access Cognos Controller Web (FQDN/IP/machine name)
      The "expressJs" parameter configures the way the Controller Web UI service is exposed.
For example, "host": "myhost.domain.com".

10. Save the file.
11. Open the Microsoft Windows Service Manager console, find IBM Cognos Controller Web UI, and start the service.
12. Open a web browser, enter the following URL, and log in to Cognos Controller Web:
http://[servername]:9080/

Modifying UDL files

When you need to add or modify Uniform Data Language (UDL) files, after the initial configuration of IBM Cognos Controller Web, then you need to stop the Cognos Controller Web Windows service, before you run SyncDBConf.bat with the new database definitions.

Before you begin

If you want to add or modify Uniform Data Language (UDL) files, perform the next steps.

Procedure

1. In the Windows Services console, find IBM Cognos Controller Web and stop the service. The service is set to start automatically after for example server re-boots.
2. Add or modify UDL files.
3. Run SyncDBConf.bat as an administrator from the command line.
4. In the Windows Services console, find IBM Cognos Controller Web and start the service.

CAM Authentication

You can configure IBM Cognos Controller Web to log on with Cognos Access Management (CAM) authentication.

Before you begin

You must configure IBM Cognos BI to not allow for anonymous authentication. You must also specify the Cognos Controller Web settings.

Procedure

1. In the Cognos BI installation folder, &lt;BI_installation_folder&gt;/templates/ps/portal/, create a file with the name variables_CCRWeb.xml.
2. The content of the file variables_CCRWeb.xml must be as follows:

```xml
<CRNenv c_cmd="http://{host_name}:{port_number}/#!/CamLogin">
  <cookies>
    <param name="cam_passport"/>
  </cookies>
</CRNenv>
```

3. Locate the file com.ibm.cognos.fcm.web.properties in the C:\Program Files\IBM\cognos_ccr_64\fcmservlet\usr\servers\fcmservlet\fcm.web folder.
4. Open the file com.ibm.cognos.fcm.web.properties and set the following properties:
   a) biUrl: the URL that the user must go to when CAM authentication is needed. The default location is http://$&lt;BI_host&gt;:80/ibmcognos/cgi-bin/cognos.cgi. This property is only valid for CAM login mode.
   b) biDispatchEndpoint: the endpoint to which Cognos Controller Web connects to validate CAM users and CAM passports. The default location is http://$&lt;BI_host&gt;:9300/p2pd/servlet/dispatch. This property is only valid for CAM login mode.
c) loginMode: the authentication type. The accepted values are: CAM and NATIVE.
Chapter 15. Cognos Disclosure Management integration for Cognos Controller

IBM Cognos Disclosure Management (CDM) is a unified financial governance solution that focuses on improving financial processes and controls, particularly in the final stages before disclosure.

The IBM Cognos Disclosure Management interface is used to produce and output financial reports.

Cognos Disclosure Management contains the following functionality and capabilities:

• **Performance.** The document rendering mechanism is fast because rendered output is put into a cache that then is shared by all users that work on the same part of the report.

• **Collaboration.** Users can check out multiple report objects simultaneously.

• **Workflow.** Users can easily see the status of each part of a financial document and determine which parts are overdue and who is responsible. Workflow includes automatic email notification to quickly contact the persons responsible for items that are overdue.

• **Internal control.** Cognos Disclosure Management provides a comprehensive set of internal controls to ensure that the proper steps are followed in the creation, submission, and approval of each document.

• **Audit trail.** Users can easily compare any two versions of the document to see what was changed, who changed it, and when it was changed. Audit trails are divided into the following sections:
  – Login audit: Records every authentication request to the Cognos Disclosure Management database via the web service
  – Report properties: Records any changes that occurred in a report
  – Report object properties: Records any changes that occurred in an object

• **Data Sourcing.** This feature provides an easy-to-use method to pull data from various data sources that include the leading ERP systems, the leading consolidation systems, relational databases, OLAP databases, and Microsoft Excel.

• **Ease of use.** If users already know how to use Microsoft Excel, Microsoft Word, and Microsoft PowerPoint, using Cognos Disclosure Management is intuitive and easy. It provides a user interface that leverages all the calculation abilities of Excel, the formatting capabilities of Word, and the presentation abilities of PowerPoint.

• **Data collection for operational data.** Cognos Disclosure Management provides functionality so that the user can write back to Cognos TM1 for data collection. External financial documents often include data that might not exist in your ERP or consolidation system.

• **User security.** Cognos Disclosure Management provides controlled access to sensitive information and helps to maintain privacy.

• **Business rules and validation.** In some organizations, data might come from various sources. Cognos Disclosure Management business rules ensure that summary data in one area of the document always ties to detailed data that exists elsewhere in the document.

• **PowerPoint integration.** Users can create PowerPoint objects to output presentations that uses existing data in the report.

• **Report and Object level commentary.** Gives users insight on the creation process for reports and report objects.

• **Dashboards.** Users can present financial information in the form of charts, graphs, and grids by creating widgets in the dashboard.

• **Integration with IBM and IBM Cognos products.**

• **Single sign-on.** Ability to support Single sign-on via Cognos Access Manager (CAM).

For more information about Cognos Disclosure Management, see the *Cognos Disclosure Management User Guide*. 

© Copyright IBM Corp. 2007, 2019
IBM Cognos Controller and IBM Cognos Disclosure Management

You can use the IBM Cognos Controller Link for Microsoft Excel to connect to a Cognos Controller repository in Cognos Disclosure Management.

The IBM Cognos Controller Link for Microsoft Excel provides an alternative method for converting a Cognos Controller repository to a Cognos TM1 cube and then creating a Cognos TM1 OLAP data source in Cognos Disclosure Management Administration.

If you use the IBM Cognos Controller Link for Microsoft Excel, then you do not have the dynamic refresh and locking capabilities available with a Cognos TM1 OLAP data source.

The Cognos Disclosure Management client can optionally be deployed on a Citrix server as an alternative deployment strategy. If you are using a Citrix server, install IBM Cognos Controller (the IBM Cognos Controller Link for Microsoft Excel) on that computer.

OLAP data sources in Cognos Disclosure Management

If you are an administrator for IBM Cognos Disclosure Management, you can define an OLAP data source that can be queried and reported on in IBM Cognos Disclosure Management.

After you define a data source as a TM1 cube, you can view IBM Cognos Controller data as a TM1 cube that was created using the Financial Analytics Publisher (FAP). For more information, see Using Financial Analytics Publisher.

You must create a TM1 data source connection before Cognos Disclosure Management users can create queries. After you add a data source, an icon with the name of the data source appears in the Data Source Connectivity work area. You should then inform users that the data source is available for them to perform queries and run reports. You can optionally export the list of data sources into a CSV file by right-clicking in the working space and clicking Export as .csv.

Adding a TM1 data source in IBM Cognos Disclosure Management

You can add a TM1 data source so that IBM Cognos Disclosure Management users can query OLAP data that was published from an IBM Cognos Controller relational database.

For more information, see Using Financial Analytics Publisher.

Before you begin

On the IBM Cognos Disclosure Management application server, download and install the TM1 client.

Tip: To connect to TM1 10.1 data, you must install the same version of the TM1 client library on the IBM Cognos Disclosure Management application server.

About this task

Users with the appropriate permissions can do this task.

Procedure

1. Click the Home tab and, in the Navigation pane, click Administration.
2. In the Navigation pane, expand External Data, and then double-click Data Source Connectivity. The Data Source Connectivity work area opens.
3. Click Add > OLAP Data Source.
4. Specify the connection parameters for IBM Cognos TM1.

   Name
   Enter a unique name.
Description
Optional: Specify a description for the data source.

Expiration Policy
Select an expiration policy. Expiration policies determine when the cached data must be refreshed from the underlying external data sources.

Provider
Select TM1.

Server
Enter the name of the Cognos TM1 server. For example, tm1server.

Authentication Type
Select Basic Authentication to authenticate against the server account using standard Cognos TM1 credentials.

Select Cognos Access Manager to authenticate using an existing Cognos Access Manager user account. The credentials will be passed to Cognos TM1 and only data that the user is authorized to view will be returned. When you use this option, you no longer need to create additional accounts to use Cognos TM1 data sourcing.

Select CAM - Interactive User (user_name) to authenticate against Cognos Access Manager, where user_name is the name of the user according to the credentials that the user is currently logged in with. The credentials will be passed to Cognos TM1 and only data that the user is authorized to view will be returned.

It is important to note the following considerations when leveraging CAM - Interactive User as an authentication type:

- When using CAM - Interactive User data queries, objects will refresh based on the specified user's level of access in the Cognos TM1 Cube. The level of cube content that can be viewed or edited can vary between users. When a user generates a report, it shows only data that the user is entitled to see. The appropriate View Report and Workflow Filter permissions should be applied. For example, only a user with full access to the information should be granted the Generate Report permission.

- After a report is locked, any user who opens an object will see the query results that were saved in the database at lock time. These results have been pulled from the cube using another data source's user credentials. Therefore, users opening the object after the report is locked will see query results that they are not entitled to see. Ensure that the appropriate view report or workflow view filter is applied so that data is not exposed to unauthorized users.

- Caching per user is done not just for these queries, but also for ##D variables which pull data from those query results. For all objects which hold such queries, the system checks if there are ##S variables defined. If there are, caching of all corresponding ##D variables is done per user, also for any other ##R and ##WR variables in the same object with ##D variables.

- The use of CAM - Interactive User as an authentication type also affects report validation because results are returned based on which user runs the validation report. Different validation results may occur if the ##R variables generate different results for different users.

- Varying authorization levels can also cause an object's workflow rules to evaluate ##WR variables differently. Ensure that you consider different authorization levels when you define workflow rules as this will affect a user's ability to advance to the next workflow state.

- Ensure that queries created using this method are utilized effectively due to the per-user cache architecture. The cache database may grow larger in size based on the amount of queries in the report.

User Id
Enter the username of the TM1 server account if you are using Basic authentication.

Password
Enter the password of the account that you are using for Basic authentication.
Locking User
When using Cognos Access Manager authentication, specify the username of the user to use when refreshing report contents after locking the report.

Locking Password
When using Cognos Access Manager authentication, specify the password of the user to use when refreshing report contents after locking the report.

Namespace ID
When using Cognos Access Manager authentication, specify the namespace ID of the user to use when refreshing report contents after locking the report.

Application
Enter the name of the application on the server that is hosting the TM1 cube.

Cube
Enter the name of the cube that is defined in TM1.

5. Click Test Connection.

• If the connection succeeds, the Connection successful icon is displayed beside the Test Connection button.

• If the connection fails, the The connection test has failed icon is displayed beside the Test Connection button. Check with the database administrator to ensure that the database server is running and that you have the correct parameters.

Results
Users can now create and edit queries based on the newly defined OLAP data source. They can also associate their queries with reports, allowing query results to be used by the reports.

Loading data into Excel objects from Cognos Controller

You can import data in an Excel object in IBM® Cognos® Disclosure Management from IBM Cognos Controller.

Before you begin
A data query must be defined before you can load data. When the query is defined, it must be associated with a report.

About this task
Users with the appropriate permissions can do this task. You need permission to create and associate queries and to load data into an Excel object.

Cognos Controller uses the IBM Cognos Controller Link for Microsoft Excel. Data from Cognos Controller, cannot update automatically if the source data changed. You must click the Refresh button on the add-in to update the data.

Note: Dynamic refreshing is not supported in Cognos Disclosure Management when you use data from the IBM Cognos Controller Link for Microsoft Excel.

Cognos Disclosure Management can directly access an OLAP or relational data source and retrieve data from the source into the report. Data can also be imported from an Excel file into Cognos Disclosure Management.

Multiple ranges, for example A1:B20, C10:F30, can be imported from the same file. As well, Cognos Disclosure Management dynamically refreshes the data directly from the source file. You can also add specific named ranges. When data is retrieved from the underlying data source, it is imported into the default Database worksheet in the Excel object.
In Cognos Disclosure Management, one worksheet can have multiple data sources that are contained in it, for example, an OLAP source and a relational source. After the data is retrieved, it can then be referenced by any other Microsoft Word or Microsoft Excel object in the report by using variables.

**Note:** Depending on how your security is set up, you might need to select a namespace and specify credentials.

**Procedure**

1. Install IBM Cognos Controller client.
2. In IBM® Cognos® Disclosure Management, open the report that you want to work with.
3. Open and check out the report object that you want to edit.
4. Click the **Section View Mode** icon on the status bar of the application window.
5. On the **Add-ins** tab, click **Controller > Log on**.
6. Select the data query that you want to insert in the report object.
7. Specify the name of the worksheet that contains the query.
8. If you want to override report object query variables in the query, specify the variables, the values, and a comment if necessary.
9. Save your changes to the Excel object.
10. Click the **Default View Mode** icon on the status bar of the application window.
11. Save your changes to the report and check in the Excel object.
Appendix A. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

See the IBM Accessibility Center (http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.

Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software. The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

**Note:** The following keyboard shortcuts are based in US standard keyboards. The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX or Linux operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
</tbody>
</table>
Table 15. Keyboard shortcuts for main tasks in the License Agreement page of the installation wizard (continued)

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>
Appendix B. Troubleshooting

Use this troubleshooting reference information as a resource to help you solve specific problems you may encounter during or after the installation of IBM Cognos Controller components.

Problems are characterized by their symptoms. Each symptom can be traced to one or more causes by using specific troubleshooting tools and techniques. After being identified, each problem can be fixed by implementing a series of actions.

When you cannot resolve a problem, the final resource is your IBM Cognos technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Troubleshooting checklist

Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine why something does not work as expected and how to resolve the problem.

Review the following checklist to help you or customer support resolve a problem.

__ • Apply all known fix packs, or service levels, or program temporary fixes (PTF).

A product fix might be available to resolve your problem.

__ • Ensure that the configuration is supported.

To see an up-to-date list of environments supported by Cognos Controller, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, run the Software Product Compatibility Reports (http://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/prereqsForProduct?deliverableId=AF89C710264211E98D5DA703D189F003).

__ • Look up error messages by selecting the product from the IBM Support Portal, and then typing the error message code into the Search support box on the right vertical menu bar.

Error messages give important information to help you identify the component that is causing the problem.

__ • Reproduce the problem to ensure that it is not just a simple error.

If samples are available with the product, you might try to reproduce the problem by using the sample data.

__ • Check the installation directory structure and file permissions.

The installation location must contain the appropriate file structure and the file permissions.

For example, if the product requires write access to log files, ensure that the directory has the correct permission.

__ • Review all relevant documentation, including release notes, technotes, and proven practices documentation.

Search the IBM knowledge bases to determine whether your problem is known, has a workaround, or if it is already resolved and documented.

__ • Review recent changes in your computing environment.

Sometimes installing new software might cause compatibility issues.

If the items on the checklist did not guide you to a resolution, you might need to collect diagnostic data. This data is necessary for an IBM technical-support representative to effectively troubleshoot and assist you in resolving the problem. You can also collect diagnostic data and analyze it yourself,
Troubleshooting resources

Troubleshooting resources are sources of information that can help you resolve a problem that you are having with a Cognos product. Many of the resource links provided in this section can also be viewed in a short video demonstration.

To view the video version, search for "Cognos troubleshooting" through either Google search engine or YouTube video community.

Support Portal

The IBM Support Portal is a unified, centralized view of all technical support tools and information for all IBM systems, software, and services.

The IBM Support Portal lets you access all the IBM support resources from one place. You can tailor the pages to focus on the information and resources that you need for problem prevention and faster problem resolution. Familiarize yourself with the IBM Support Portal by viewing the demo videos.

Find the Cognos content that you need by selecting your products from the IBM Support Portal.

Searching and navigating Cognos products

Access to IBM Cognos product information can now be configured in the IBM Support Portal, which provides the ability to see all of your links on a single page.

Best practices for searching and navigating for Cognos product information are available on the IBM Cognos Support Portal and Technote Search Best Practices page.

Gathering information

Before contacting IBM Support, you will need to collect diagnostic data (system information, symptoms, log files, traces, and so on) that is required to resolve a problem. Gathering this information will help to familiarize you with the troubleshooting process and save you time.

Information on what data to collect is available in the form of MustGather technotes.

If you want to troubleshoot unexpected behavior that resulted in an error message, you can click Details in the message window for more diagnostic information. You can copy this information to send to IBM Support.

You can also specify the level of detail that is displayed in the Details section of an error message. The setting for the level of detail is included in the web.config configuration file. For more information, see “Specifying the level of detail displayed in error messages” on page 124.

Specifying the level of detail displayed in error messages

You can specify the level of details that are displayed in an error message to help you troubleshoot your problem. Change this setting by modifying the properties in the Web.config file.

About this task

Error messages include details that can help IBM Support diagnose the problems and trace the events that led up to the failure. As a system administrator, you might want to restrict the type and quantity of information that is displayed in the error message as a security precaution. Errors can contain sensitive information that you do not want users to see.

You can change the level of details shown in the error messages by setting the ControllerWebServiceException property in the ASP.NET Web.config configuration file. The Web.config file specifies configuration information that is specific to IBM Cognos Controller.

Procedure

1. In a text editor, open the web.config file.

   The default location of the Web.config file is `ccr_location/ControllerProxyServer`
2. Go to the ControllerWebServiceException property and change the detail setting based on the following values:

```xml
<!--Return error to client, Levels: 0=None, 1=Normal, 2=All-->
<add key="ControllerWebServiceException" value="1"/>
```

The property value is set to 1 by default. When the property is set to 0, no details are provided except for the instruction to contact the system administrator. If you set the property to 2, users can send the information in the Details section of the message to IBM Support for further investigation.

3. Save the changes and close the editor.

**Results**

You are not required to restart the web server after modifying the Web.config file. For performance reasons, Internet Information Services (IIS) monitors the Web.config file for changes and caches the contents.

**Problem determination**

Several IBM Cognos problem determination tools are available to diagnose and troubleshoot common problems.

These tools can be downloaded from the Cognos Diagnostic Utilities page. IBM Education Assistant provides video and other training resources on some of these diagnostic tools on the IBM Education Assistant Problem Determination website.

**Service requests**

Service requests are also known as Problem Management Reports (PMRs). Several methods exist to submit diagnostic information to IBM Software Technical Support.

To open a PMR or to exchange information with technical support, view the IBM Software Support Exchanging information with Technical Support page. PMRs can also be submitted directly by using the Service requests (PMRs) tool, or one of the other supported methods detailed on the exchanging information page.

**Cognos Customer Center**

The IBM Cognos Customer Center provides Cognos-specific information, updates, and troubleshooting resources.

To view Cognos troubleshooting information, access the Cognos Customer Center, and view the information under "Contacting Support" or "Troubleshooting Resources".

**Fix Central**

Fix Central provides fixes and updates for your system's software, hardware, and operating system.

Use the pull-down menu to navigate to your product fixes on Fix Central. You may also want to view Getting started with Fix Central.

**Knowledge bases**

You can find solutions to problems by searching IBM knowledge bases.

You can use the IBM masthead search by typing your search string into the Search field at the top of any ibm.com page.

**IBM Knowledge Center**

IBM Knowledge Center includes documentation for each release. This documentation is also available through product help menus.

You can access the documentation at IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter/SS9S6B/welcome).

To find links to the latest known problems and APARs, access the release notes available on the Knowledge Center.
IBM Redbooks provide in-depth guidance about such topics as installation and configuration and solution implementation.

Proven Practices documentation
Created by Cognos experts from customer experiences, Cognos Proven Practices provides verified technical information in specific technology environments.

As a troubleshooting resource, Proven Practices provides easy access to the most popular practices for Business Intelligence and Financial Performance Management, in addition to videos and other information: Cognos Proven Practice documentation.

Software support and RSS feeds
IBM Software Support RSS feeds are a quick, easy, and lightweight format for monitoring new content added to websites.

After you download an RSS reader or browser plug-in, you can subscribe to IBM product feeds at IBM Software Support RSS feeds.

Forums and communities
IBM Cognos product forums offer a place to share ideas and solutions with your peers in the IBM Cognos community.

Active Cognos forums are available at Cognos forums and communities.

Log Files
When you are troubleshooting, several files can help you:

The ccr.log file
This file records technical information about activities performed in IBM Cognos Controller. The ccr.log file is located in the C:\Program Files\ibm\cognos\ccr_64\log directory. You can use this file to troubleshoot technical problems, and when contacting technical support.

The Transfer Log File
This file records the activities that the installation wizard performed while transferring files. The transfer log file is located in the C:\Program Files\ibm\cognos\ccr_64\instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

tl-CNTRL-10.3-1100.213-20171027_0956.txt

The Transfer Summary-Error Log File
This file records the components you installed, disk space information, the selections you made in the transfer dialogs, and any errors the installation wizard encountered while transferring components. The transfer summary-error log file is located in the C:\Program Files\ibm\cognos\ccr_64\instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

tl-CNTRL-10.3-1100.213-20171027_0956_summary_error.txt
**The Startup Configuration File**

This file records your configuration choices each time you save your property settings. The file name is cogstartup.xml. If you are unable to save your configuration, or are having problems you can revert to a previously saved configuration file. The backup configuration files are located in the C:\Program Files\ibm\cognos\analytics\configuration directory. The following is an example of the file name format for backup configuration files:

cogstartup_200211231540.xml

**The Locale Configuration File**

This file records the configuration choices you make in Cognos Configuration for product and content locales, locale mapping, and currency support. If you experience problems with language support in the user interface or in reports, use these files to track your changes. The backup configuration files are located in the C:\Program Files\ibm\cognos\analytics\configuration directory. The following is an example of the file name format:

coglocale_200211231540.xml

**The Run-Time Log File**

The default Cognos log file named cogserver.log file, or other log files that you configure to receive log messages from the log server, record information after you start the IBM Cognos service. They are located in the ca_or_bi_install_path\logs directory. If you configured another destination for log messages, check the appropriate file or database.

Some log messages indicate problems. Most messages provide information only, but others can help you to diagnose problems in your run-time environment.

**The Uninstallation Log File**

This file records the activities that the Uninstall wizard performed while uninstalling files. You can use the log file to troubleshoot problems related to uninstalling IBM Cognos components. The location for the file varies with the type on uninstall. If you do a partial uninstall, the file is in controller_install_path\instlog. If you do a full uninstall, the files is in %temp% and the file name is cognos_unist_log.txt.

**Windows Event Viewer**

Windows Event Viewer provides information about program, security, and system events. For example, if the IBM Cognos service fails to start, this fact is recorded in the event log.

For information about how to use Windows Event Viewer, see the Windows help.

**Microsoft Internet Information Services (IIS) Log File**

This file records Microsoft Internet Information Services (IIS) activities. The log file is found in the installation_location/windows/system32/logFiles/W3SVC1 directory. You can use this log file to troubleshoot problems related to your IIS Web server. For example:

- Code 404 is a page not found error.
  
  Your virtual directory may not be configured correctly.
• Code 304 is a security credential error.
  Your directory security may not be configured correctly.
• Code 200 indicates that IIS is working correctly.
  The problem you are encountering is not related to your IIS Web server.
For more information, see the Microsoft Internet Information Services help.

Problems Starting IBM Cognos Controller
You may encounter problems when you try to start IBM Cognos Controller or log on to IBM Cognos Controller. Solutions are provided for specific problems.

The Controller Link Is Missing in IBM Cognos Connection
You completed a distributed installation integrating IBM Cognos Controller with IBM Cognos Business Intelligence. When you access IBM Cognos Connection to start IBM Cognos Controller, the Controller link does not appear on the IBM Cognos Connection start page or on the studio bar.

Ensure that you installed the Gateway Integration Enabler on the IBM Cognos Gateway computer, and the IBM Cognos Connection Integration Enabler on the IBM Cognos application servers.

If you started the IBM Cognos service before the IBM Cognos Connection Integration Enabler was installed, you must restart the IBM Cognos service.

You may also need to verify that the URI for IBM Cognos Connection is correct. The URL parameter in the ControllerLaunch.xml file sets the link associated with Controller in IBM Cognos Connection. For a distributed installation, this must be the full URL for the Controller Client Distribution Server.

Procedure
1. Start IBM Cognos Configuration.
2. From the Actions menu, if the service is currently running, click Restart, or if the service is stopped, click Start.
3. To Verify That the IBM Cognos Connection Integration Enabler Is Installed, in the ccr_location/webapps/p2pd/WEB-INF/service directory, verify that the ControllerStudio.xml file exists.
4. To Verify the URI for IBM Cognos Connection, if the Report Server and Controller Client Distribution Server are on different computers, set the URL to point to Controller Client Distribution Server:
   • In the ccr_location/templates/ps/portal/launch directory, open the ControllerLaunch.xml file in a text editor.
   • Change the value of the URL parameter from ../controller to the fully-qualified URI of the computer where Controller Client Distribution Server is installed, such as http://servername/cognos/controller
   • Save and close the file.

Warning! You Are About to Navigate Away from This Page
When you try to start IBM Cognos Controller, an error message may state that you are about to leave this page. There may be an error in the Code Group settings of the Microsoft .NET Framework runtime security policy that you configured.

Verify that you have installed the supported version of Microsoft .NET Framework that is listed in the “System requirements” on page 21 section. Ensure that the URL to the Controller Client Distribution Server is correct.

You Receive No Response When Starting IBM Cognos Controller
When you start IBM Cognos Controller, you receive no response. There may be an error in the configuration of the Microsoft .NET Framework runtime security policy that you configured.
Verify that you have installed the supported version of Microsoft .NET Framework for your version of Cognos Controller as listed on IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter/SS9S6B/welcome). You can also delete the security policy on the client computer, reconfigure the security policy, and then deploy a new package to the client computer.

**Error - Page Cannot Be Found When Starting IBM Cognos Controller**
When you try to start IBM Cognos Controller, an error message may state that the page cannot be found.

Ensure that the ControllerServer virtual directory is defined on the Controller Web Services Server, that it points to the `ccr_location/ControllerProxyServer` folder, and that you have access privileges for that folder.

You may also want to verify that you installed the supported versions of Microsoft .NET Framework as listed on IBM Cognos Knowledge Center (http://www-01.ibm.com/support/knowledgecenter/) and that ASP.NET is installed and configured.

**Procedure**
1. In **Administrative Tools**, start **Internet Information Services (IIS) Manager**.
2. Expand **Internet Information Services (local computer)**, **Web Sites**, **Default Web Site** and verify that the aspnet_client folder exists.
3. If this folder is missing, complete the steps “Install server roles and features” on page 28 to install and configure ASP.NET.
4. Expand **Internet Information Services (local computer)**, and then click **Web Services Extensions**, and verify that ASP.NET V2.0.50727 is set to **Allowed**.

**After Upgrading, You Cannot Start IBM Cognos Controller**
After upgrading your version of IBM Cognos Controller, you experience problems with starting Controller that are not documented elsewhere.

You may need to delete some leftover files from the Microsoft .NET Framework cache on the Controller client computer.

**Procedure**
1. Close all instances of Internet Explorer.
2. Run Windows Task Manager and stop any `iexplore.exe` process that is running.
3. In the C:`\documents and settings\username\application data\Cognos` directory, delete the ccr folder.
4. In Internet Explorer, return to IBM Cognos Connection, and then restart IBM Cognos Controller.
5. In Internet Explorer, from the **Tools** menu, click **Internet Options**.
6. On the **General** tab, under **Temporary Internet files**, click **Delete Files**, select the **Delete all offline content** check box, and then click **OK**.

**Error - VMWare Can't Run the ccr.exe File**
You are trying to start IBM Cognos Controller in a VMWare environment and a message prompts you to confirm that you want to run the ccr.exe file.

When you click **Run**, an error occurs. Because VMWare cannot resolve the host name of an IP address, you must add it to the hosts file.

**Procedure**
1. On the VMWare virtual computer, in a text editor, open the C:`\windows\system32\drivers\etc\hosts` file.
2. Add the IP address and the name of each server computer that you are using in your distributed installation to the hosts file.

**Tip:** Use the other entries in the hosts file as an example of correct syntax.
An Error Occurred While Trying to Access the Server

While trying to start or log on to IBM Cognos Controller, a message states that an error occurred while trying to access the server.

This error can occur for several reasons:

• The Controller Web Services Server may not be running.
• The COM+ Server may not be running.
• The Controller database connection logon credentials may need to be reset.
• There may be errors with the configuration of authenticated access.

Tip: If the error occurs after you start IBM Cognos Controller, then in Administrative Tools use the Event Viewer on both the IBM Cognos Controller client computer and the Controller Web Services Server computer for internal errors.

Verifying That the Controller Web Services Server Is Running

Verify that the Controller Web Services Server is running.

Procedure

1. On the Controller Web Services Server computer, start Internet Explorer and go to http://computername/ibmcognos/controllerserver/ccrws.asmx
2. If the CCRWS operations page does not appear, verify that ASP.NET is installed and configured “Error - Page Cannot Be Found When Starting IBM Cognos Controller” on page 129. If it is not, install and configure ASP.NET “Install server roles and features” on page 28 and then repeat steps 1 and 2.
3. On the CCRWS operations page, click the ConnectionBusiness SelectDB method link.
4. Click Invoke.
5. If a Web page containing XML data with the list of databases does not appear, ensure that the directory security settings in Microsoft Internet Information Services (IIS) are configured correctly so that remote users can connect and verify that the COM+ Server is running. Then repeat steps 1 to 4 on a client computer.

If this still fails, it may be a network connection problem.

Verify That the COM+ Server Is Running

Verify that the COM+ Server is running.

Procedure

3. Expand COGNOSCONTROLLER, and also expand the next level of COGNOSCONTROLLER.

If components are listed under this level, the COM+ Server is running.

Reset the Microsoft SQL Server Logon Credentials

Reset the Microsoft SQL Server Logon Credentials.

Procedure

In SQL*Plus, type the following command to run a stored procedure that resets the database user name and password:

`sp_change_users_login 'Update_one', 'username', 'password'

Test the Database Connection

Use IBM Cognos Controller Configuration to test the database connection.
Procedure
1. From the **Start** menu, start IBM Cognos Controller Configuration.
2. In the **Explorer** window, under **Web Services Server**, click **Database Connections** and select the problem connection for the Controller database.
3. From the **Actions** menu, click **Run**.
   The Database Conversion Utility opens.
4. Verify that the **Current Version** is the same as the **Upgrade to** version of the database.

**Map an IBM Cognos Controller User to an IBM Cognos User**
Map an IBM Cognos Controller user to an IBM Cognos user.

Procedure
1. Start IBM Cognos Controller.
   You must be a member of the Controller Administrators role in IBM Cognos Connection.
2. From the **Maintain** menu, click **Rights, Users**.
3. Select the user you defined for the IBM Cognos Controller database.
4. Next to **CAM User** box, click **Show Valid Choices** and then select the user you mapped to the Cognos namespace roles.
5. Click **Save**.

**Error - No Database Configured**
While trying to log on to IBM Cognos Controller, a message states that no database is configured. This is the result when the Controller Web Services Server cannot find any UDL files.
Verify that you created a database connection for the Controller database.

**Error - The File Is Not a Valid Compound File**
While trying to log on to IBM Cognos Controller, a message states that the file is not a valid compound file. This can occur when the UDL file for the Controller database is corrupted.
You can try to repair the database connection, or delete it and create a new one.

**Procedure**
1. From the **Start** menu, start IBM Cognos Controller Configuration.
2. In the **Explorer** window, under **Web Services Server**, click **Database Connections** and select the problem connection for the Controller database.
3. From the **Actions** menu, click **Check**.
4. If the database connection validation fails, review the database connection properties and fix any errors.
5. From the **File** menu, click **Save**.
6. In the **Explorer** window, under **Web Services Server**, click **Report Server**.

**Error - Another Session of IBM Cognos Controller Is Already Running**
While trying to log on to IBM Cognos Controller, a message states that another session of Controller is already running. You can only run one session of IBM Cognos Controller at a time.
Verify that another session of IBM Cognos Controller is already running, and use this session instead.
Error QE-DEF-0288 - Unable to find the data source

When you run a standard report in IBM Cognos Controller that uses DB2 and you manually set the TCP port, then the following error message is shown.

QE-DEF-0288

Unable to find the data source
'IBMDADB2.DB2COPY1:<servername>:TCPport:DATABASECONNECTION:<username>' in the content store.

In Controller Configuration, the database connection contains the TCP port (for example, 50000) in the Location field.

Resolve the problem by renaming the data source in IBM Cognos Connection.

Procedure

2. Click Administer IBM Cognos content > Configuration > Data Source Connections.
3. On the relevant data source, click the Set properties icon.
4. In the Name field, add the TCP port to the name.

For example: IBMDADB2.DB2COPY1:VBRACONTDB2:50000:RCTST04A:fastnet.

Problems Starting the IBM Cognos Controller Link for Microsoft Excel

You may encounter problems during your testing of the IBM Cognos Controller Link for Microsoft Excel. Solutions are provided for specific problems.

If the specific problems identified do not include your issue, you can use the Control Panel, Add or Remove Programs window to uninstall the IBM Cognos Controller Link for Microsoft Excel, and then restart the Controller client computer.

After Upgrading, ControllerXLPusher Error Occurs When Starting Microsoft Excel

You accessed IBM Cognos Controller at least once from the same client computer, and are now trying to start Microsoft Excel. An error message states that the ControllerXLPusher.dll file or one of its dependencies was not found. The registry may have more than one version listed for the ControllerXLPusher.dll file.

You must verify that the version used by the registry key is the current version of the ControllerXLPusher.dll file. First identify the current version of the ControllerXLPusher.dll file and then verify the version used by the registry key.

Procedure

1. On the client computer, in the ccr_location\webcontent\ccr directory, right-click the ControllerXLPusher.dll file, and then click Properties.
2. Click the Version tab and record the File version number for comparing against the registry key.
3. Open the Registry Editor and search for ControllerXLPusher using the registry Find feature.

   The key HKEY_CLASSES_ROOT\CLSID\id_number should be found.
4. Click the InprocServer32 key and check whether only the version number that matches the current version of the ControllerXLPusher.dll file exists.
5. If more than one version exists, delete all entries except the current version, which you recorded earlier.
Problems configuring IBM Cognos Controller Financial Analytics Publisher

You may encounter problems when you are configuring IBM Cognos Controller Financial Analytics Publisher (FAP).

**JCAM_Crypto_JNI-dll is not a valid Win32 application**

You are upgrading to IBM Cognos TM1 10.2.2 and an error message appears when you start IBM Cognos Configuration.

The text of the message is as follows:

A fatal error occurred. Unable to run the application. An application error occurred. Java.lang.UnsatisfiedLinkError:JCAM_Crypto_JNI (C:\Program Files\IBM\cognos\tm1_64\bin \JCAM_Crypto_JNI-dll is not a valid Win32 application.)

**Procedure**
1. Click Start > Control Panel > System and Security > System.
2. Click Advanced system settings.
3. Click Environment Variables.
4. Edit the Path system variable to include the following text:
   C:\Program Files\ibm\cognos\tm1_64\bin64
5. Click OK.

**NGTM1JNI.dll is not a valid 32-bit application**

You are starting the Data Mart on the FAP Server and the Initial Publish (IP) fails.

The following error message appears:

NGTM1JNI.dll is not a valid 32-bit application

**Procedure**
1. Click Start > Control Panel > System and Security > System.
2. Click Advanced system settings.
3. Click Environment Variables.
4. Edit the Path system variable to include the following text:
   C:\Program Files\ibm\cognos\tm1_64\bin64
5. Click OK.

**Slow performance of Cognos Controller**

The IBM Cognos Controller client runs slowly if there is no internet connection.

The Cognos Controller client must have access to the internet to check the certificates. If the certificate checking fails, Cognos Controller runs slowly.

The solution for this problem is to provide internet access to the Cognos Controller client.

If that is not possible, then disable the checking of .NET certificates for all applications. For more information, see “Disabling .NET certificate checking for all applications” on page 134.

If it is not possible to disable the checking of .NET certificates for all applications, then disable the checking of the certificates for the following applications:

- Microsoft Excel
Disabling .NET certificate checking for all applications

When the IBM Cognos Controller 10.1 client does not have internet access, Cognos Controller runs slow.
The solution for this problem is to provide internet access to the Cognos Controller client.
If that is not possible, then disable the checking of the .NET certificate for all applications.

Procedure

1. Log on to the system that runs the Cognos Controller client.
2. Start Microsoft Internet Explorer.
3. Click Tools > Internet Options > Advanced.
4. Clear the Check for publisher's certificate revocation check box.

Disabling certificate checking for Microsoft Excel

When the IBM Cognos Controller 10.1 client does not have internet access, Cognos Controller runs slow.
The solution for this problem is to provide internet access to the Cognos Controller client.
If it is not possible to provide internet access to the Cognos Controller client, then disable the checking of the .NET certificate for all applications.
If it is not possible to disable the checking of the .NET certificate for all applications, then disable the checking of the certificate for Microsoft Excel, Cognos Controller, and Microsoft ASP.NET.

Perform the next steps to disable the certificate checking for Microsoft Excel.

Procedure

1. Log on to the system that runs the Cognos Controller client.
2. In a text editor, such as Microsoft Notepad, open the excel.exe.config file that is in a location such as: C:\Program Files\Microsoft Office\Office12.
3. In the file add the line <generatePublisherEvidence enabled="false"/> as follows:

   ```xml
   <configuration>
   <startup>
   <supportedRuntime version="v2.0.50727"/>
   </startup>
   <runtime>
   <generatePublisherEvidence enabled="false"/>
   </runtime>
   </configuration>
   ``
4. Save and close the file.

Disabling certificate checking for Cognos Controller

When the IBM Cognos Controller 10.1 client does not have internet access, Cognos Controller runs slow.
The solution for this problem is to provide internet access to the Cognos Controller client.
If it is not possible to provide internet access to the Cognos Controller client, then disable the checking of the .NET certificate for all applications.
If it is not possible to disable the checking of the .NET certificate for all applications, then disable the checking of the certificate for Microsoft Excel, Cognos Controller, and Microsoft ASP.NET.
Perform the next steps to disable the certificate checking for Cognos Controller.

**Before you begin**

The following procedure assumes that you start Cognos Controller from a local hard disk. For example, from `C:\Program Files\IBM\IBM Cognos Controller` or `C:\Program Files\Cognos\ccr.exe`.

**Procedure**

1. Log on to the system that runs the Cognos Controller client.
2. In a text editor, such as Microsoft Notepad, open the `ccr.exe.config` file that is in a location such as: `C:\Program Files\IBM\IBM Cognos Controller` or `C:\Program Files\Cognos\ccr`.
3. In the file add the line `<generatePublisherEvidence enabled="false"/>` before the `</configuration>` tag as follows:
   ```xml
   <configuration>
   <runtime>
   <generatePublisherEvidence enabled="false"/>
   </runtime>
   </configuration>
   ```
4. Save and close the file.

**Disabling certificate checking for Microsoft ASP.NET**

When the IBM Cognos Controller 10.1 client does not have internet access, Cognos Controller runs slow. The solution for this problem is to provide internet access to the Cognos Controller client.

If it is not possible to provide internet access to the Cognos Controller client, then disable the checking of the .NET certificate for all applications.

If it is not possible to disable the checking of the .NET certificate for all applications, then disable the checking of the certificate for Microsoft Excel, Cognos Controller, and Microsoft ASP.NET.

Perform the next steps to disable the certificate checking for Microsoft ASP.NET.

**Procedure**

1. Log on to the system that runs the Cognos Controller application server.
2. In a text editor, such as Microsoft Notepad, open the `Aspnet.config` file that is in a location such as: `C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727`.
3. In the file add the line `<generatePublisherEvidence enabled="false"/>` as follows:
   ```xml
   <configuration>
   <runtime>
   <generatePublisherEvidence enabled="false"/>
   </runtime>
   </configuration>
   ```
4. Save and close the file.
This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:
Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.

**Trademarks**

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

• Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

• Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

• Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

• UNIX is a registered trademark of The Open Group in the United States and other countries.

• Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
This glossary provides terms and definitions for the IBM Cognos Controller software and products. The following cross-references are used in this glossary:

• *See* refers you from a nonpreferred term to the preferred term or from an abbreviation to the spelled-out form.
• *See also* refers you to a related or contrasting term.

For other terms and definitions, see the [IBM Terminology website](https://www.ibm.com) (opens in new window).

**A**

**access right**
A designation of the rights that users have, such as read, modify, create, delete, and admin (RMCDCA).

**actuality**
A set of data that can be collected, such as forecast, budget, or actuals. An actuality often defines a period.

**adjustment dimension**
A dimension that is used to eliminate intercompany balances or internal profit.

**advanced formula calculation account (AFC account)**
An account used for complex calculations including built-in logic and formulas.

**AFC account**
See advanced formula calculation account.

**allocation**
The distribution of data, specified at a summary level of a dimension, to lower levels. For example, the measures used to forecast quarterly sales revenue can be distributed to the month and day levels.

**audit log**
A log that maintains the history of all commands that modify metadata or configuration data and significant operations, including commands that would have made a change but failed to do so.

**audit trail**
The ability to track changes made to data and structures.

**automatic journal**
A set of rules and definitions connected to a control table. Automatic journals define which eliminations should be calculated in a consolidation, as well as how and when the consolidation should take place.

**B**

**base**
A predefined contribution version which contains no automatic journals.

**base value**
A reported value to which different adjustments are made.

**batch queue**
A queue that places batch jobs in sequence for execution. A batch queue's run limit controls how many jobs in the queue can run simultaneously.

**business rule**
A user-defined script to be included in the consolidation process.
calculation account
An account used for calculating rations and formulas in reports. The abbreviation for calculation account is CALC account.

change table
A table that is used to change company codes, account codes, extended dimension codes, or to merge accounts or dimensions.

closing version
A reporting version that contains the reported values for a given period, plus one or more journal types.

Command Center
A menu from which a user can carry out tasks and monitor the status for companies and groups.

consolidation structure
A legal or management structure that consists of a company structure and extended dimension structures.

contribution calculation
The ability to view a financial amount contributed from the top level in a company hierarchy.

contribution version
A summary of preferred automatic journal types that is used in reports.

control table
A pre-defined table used by automatic journals to eliminate acquisitions, intercompany balances and intercompany profit.

copy table
A table used to copy period values from one account to another in the same period and for the same company.

cube
A multidimensional representation of data needed for online analytical processing, multidimensional reporting, or multidimensional planning applications.

data mart
A subset of a data warehouse that contains data that is tailored and optimized for the specific reporting needs of a department or team. A data mart can be a subset of a warehouse for an entire organization, such as data that is contained in online analytical processing (OLAP) tools.

dimension
A broad grouping of descriptive data about a major aspect of a business, such as products, dates, or locations. Each dimension includes different levels of members in one or more hierarchies and an optional set of calculated members or special categories.

extended dimension
A dimension that can be defined by the user.
**F**

**fast formula**
A formula that can be used to calculate simplified, static values and store them on calculation accounts.

**form set**
A collection of forms.

**G**

**group**
A company type to which subordinate companies are connected; for example, subsidiaries, group companies, group adjustment companies, or legal units.

**group adjustment company**
A virtual company for system use only.

**I**

**integrated account**
A sub-account that is summed into accounts in the balance sheet or the income statement.

**investment adjustment**
One of the three consolidation models in Cognos Controller (used, for example, in the Netherlands and Denmark).

**investment elimination template**
A template used to reconcile eliminations of investments, such as subsidiaries and associated companies.

**J**

**job**
A method for describing which user-defined business rules, allocation definitions, or advanced formula calculations to include in the consolidation process (by steps or by status).

**journal type**
A user-defined journal category used for manual adjustments to reported values.

**L**

**legal unit**
In a company structure, one or more sub-units that are connected to a group company. A sub-unit may represent a specific geographical area in one consolidation structure, and in a parallel consolidation structure it can be included in a group representing the total of that geographical area.

**linked actuality**
An actuality used to perform a currency conversion at a new currency rate, but with existing period values in the local currency.

**linked structure**
A combination of selected structures that is used to limit the number of available objects, making it easier for individual users to make selections from menus.

**local preference**
A parameter that affects one workstation or client only.
lookup table
A table used to convert information from a file in an external system to correspond with the local system.

mapping table
A table for entering default jobs.

movement account
An account generated from a base account, or a manually defined account that reflects movement of equity or fixed assets between opening and closing balances.

movement extension
A suffix which together with a base account form a movement account.

OLAP
See online analytical processing.

online analytical processing (OLAP)
The process of collecting data from one or many sources; transforming and analyzing the consolidated data quickly and interactively; and examining the results across different dimensions of the data by looking for patterns, trends, and exceptions within complex relationships of that data.

period
A date interval that reported values are saved in. An example of a period is December 2000.

period locking
The process of restricting access to finished periods. An option exists to lock the period entirely, or to restrict data entry only.

REPO
See reported value.

report book
A set of reports which can be generated together, instead of individually.

reported value (REPO)
A value created by data entry or import, without any manual corrections. The abbreviation for reported value is REPO.

reverse journal
A function that allows the user to eliminate a journal without having to re-book values manually.

reversing journal
A journal that is used to copy company and group journals at year-end with alternative rules.

security group
A group defined for the purpose of providing access to applications and optionally to collections of data.
server preference
A parameter that affects all workstations and clients.

structure
A relationship that describes how accounts, companies, forms or extended dimensions are connected.

subgroup
The name of a company type group that is connected to another group.

submission
A collection of form sets reported during a specific period and actuality.

subset
A named collection of companies.

sub-unit
An operative unit, such as company or sub-group, that is summed with other sub-units to form a legal unit.

summation account
An account to which other accounts are summed.

T

task
A unit of work to be accomplished by a device or process.

transfer account
An equity account that is included in an opening or closing balance account structure.

W

weight
A factor that determines how much of the source value should be put on a specific target when using the allocation functionality.
Index

Special Characters

- .config configuration files 124
- .NET 133

A

- access permissions
  - granting 73
- accessibility features 121
- Active Directory Server
  - authenticating in multiple domains 80
  - enabling single signon 81
  - using for authentication 79
- add-in for Excel
  - integration with Cognos FSR 105
- adding
  - namespaces 73
- advanced properties
  - for Active Directory Server 80
- aliases
  - configuring on web servers 52
- anonymous access
  - disabling 77
  - disabling for Cognos website 108
  - integrating with Cognos FSR 106
- anonymous logon
  - disabling 78
- application data
  - backing up 42
  - upgrading 44
- application servers
  - enabling network COM+ access 65
- application tier components
  - testing data source connections 55
- ASP.NET
  - configuration settings 124
  - verifying whether installed 129
- authentication
  - Cognos Access Manager (CAM) 107
  - custom authentication providers 81
  - disabling anonymous logon 78
  - eTrust Siteminder 82–84
  - in domain trees for Active Directory Server 80
  - mapping Controller users to IBM Cognos users 76
  - single signon using eTrust SiteMinder 84
  - SSL for eTrust Siteminder 84
- authentication method
  - Controller native 109
  - Controller Web Services Server 73
- authentication namespaces
  - deleting 84
  - using 73
- authentication with single signon
  - for Active Directory Server 81

B

- backups
  - application data 42

C

- cache
  - deleting files from Microsoft .NET Framework 129
- CAM, See Cognos Access Manager (CAM)
- CAM authentication
  - setting local intranet 108
- CCR_JAVA_HOME 24
- ccr.exe
  - troubleshooting 129
- CCR82_DM.zip 93
- ccrws operations page
  - troubleshooting 130
- CGI gateway
  - starting Cognos Connection 88
- changing
  - Controller database connections 93
  - default configuration settings 93
- chase_referrals 80
- client computers
  - troubleshooting IBM Cognos Controller Link for Microsoft Excel 132
- client installation
  - IBM Cognos Controller Link for Microsoft Excel 57, 67
- client interfaces
  - verifying functionality 67
- code pages for data sources 58
- Cognos Access Manager (CAM)
  - Cognos FSR integration 107
  - disabling anonymous access 108
- Cognos Analytics
  - connecting to Cognos Controller 53
  - Cognos Business Intelligence
    - connecting to Cognos Controller 53
- Cognos Configuration
  - component description 7
  - Cognos Customer Center 125
- Cognos Diagnostic Utilities 125
- Cognos namespace
  - integrating with Cognos FSR 105
- COGNOSCONTROLLER process
  - troubleshooting 130
- COM+ Server
  - configuring 104
  - credentials 104
  - enabling 65
  - verifying whether running 130
- COM+ server configuration 5
- components
  - Controller Client Distribution Server 8
  - Controller data mart database 9
  - Controller Web Services Server 8
components (continued)
  distributing on multiple computers 12
  installing on one computer 11
  load balancing distribution example 14
  modeling 9
  role-based distribution example 12
  startup configuration 18
  third-party 7
  used by IBM Cognos Controller 7
configuration
  requirements for single signon with Microsoft Analysis Server or Microsoft SQL Server 79
  security 18
  startup 18
  upgrading 44
  using preconfigured files 99
  workflows 17
configuration changes to web server 5
configuration files
  ASP.NET application settings 124
  exporting 101
configuration settings
  changing 93
  default 55
configuration tools 99
configuring
  an Active Directory namespace 79
  COM+ Server 104
  Controller database connections 53, 102
  custom authentication providers 81
  Enhanced Reporting Optimization 95
  eTrust SiteMinder namespace 83
  IBM Cognos Controller 87
  routers 98
  transfer specification files (.ats) 99
  Web browsers 27
  web servers 52
connecting to IBM Cognos Controller
  from a Web browser 66
  from IBM Cognos Connection 65
  from Microsoft Excel 67
connections
  Controller database 53, 102
consolidation
  load balancing 14
  consolidation model 33
content store
  backing up 42
  creating 47
  deploying 35
  upgrading 44
Controller
  server components 7
Controller application
  verifying whether COM+ Server running 130
Controller Client Distribution Server components 8
Controller Configuration changes 5
Controller data
  upgrading 44
Controller data mart
  creating 89
  database connection properties 91
Controller data mart (continued)
  define data source 92
  installing JDBC driver 51
Controller database connections
  changing 93
  configuring 53, 102
Controller databases
  creating Microsoft SQL Server 26, 90
  creating Oracle 26, 90
Controller Framework Manager Model components 8
Controller standard reports package 8
Controller users
  mapping to IBM Cognos namespaces 76
Controller Web
  Configure 111, 112
Controller Web Services Server
  authentication method 73
  components 8
  verifying whether running 130
ControllerLaunch.xml file
  troubleshooting 128
ControllerProxyServer
  troubleshooting 129
ControllerStudio.xml 128
ControllerXLPusher.dll 132
cookies
  enabling in Web browsers 27
copying
  IBM Cognos Controller components 99
creating
  content store 47
  Controller data mart database 89
  IBM Cognos Controller database 24
credentials
  COM+ Server 104
  resetting for Microsoft SQL Server 130
custom authentication providers 81
custom user properties
  from Active Directory Server 80

data
  importing 39
  data integration 105
  data mart database
    define data source 92
    installing JDBC driver 51
    setting connection properties 91
  data source connections
    repairing 131
    testing connection to Controller database 55
    troubleshooting 131
  data sources
    adding OLAP 116
    for Framework Manager 58
    overview 116
    third-party components 9
  database connections
    troubleshooting 130
databases
    creating Controller tablespaces 26, 90
    creating for Controller data mart 89
databases (continued)
  creating for IBM Cognos Controller 24
  performance optimization for Oracle 88
  upgrading 44
DB2
  code pages 58
  default configuration settings 55, 93
  deleting
    authentication namespaces 84
  deploying
    configuration objects 39
    content store 35
    directory content 35
    exporting 37
    importing 39
    moving archives 38
    packages 35
    partial deployment 35
    Public Folders 35
    testing 40
  deployment
    permissions 35
    planning 35
  deployment archives
    moving 38
  deployments
    creating an export specification 37
  directories
    deploying content 35
  disabling
    anonymous access 77
  dispatchers
    importing 39
  distributed installations
    load balancing example 14
    role-based example 12
    scenarios 11
  domains
    authentication in domain trees for Active Directory Server 80

E

  enabling
    COM+ Server 65
    single signon 78
  Enhanced Reporting Optimization
    configuring 95
  environments
    supported 21
    supported operating systems 21
  error message
    another session of IBM Cognos Controller is already running 131
    QE-DEF-0288 - Unable to find the data source 132
  error messages
    An error occurred while trying to access the server 130
    ControllerXLPusher.dll 132
    No database configured 131
    Page cannot be found 129
    showing details 124
    The file is not a valid compound file 131
    VMWare cannot run the ccr.exe file 129
    You are about to navigate away from this page 128

eTrust SiteMinder
  configuring namespaces 83
  enabling single signon 84
  protecting the IBM Cognos Web alias 84
  SSL 84
  using for authentication 82
Excel
  installation of add-in 57
  remote installation of the IBM Cognos Controller Link for Microsoft Excel 97
exporting
  configuration files 101
  creating a specification 37

F

  files
    response.ats 100
    using a previous installation version 99
Financial Analytics Publisher
  configure Controller database 61
  create database 62
  install 60
  install and configure service 62
  set up environment 61
Fix Central 125
  fix pack
    installing 48
  flat files
    specify import directories 88
  folders
    deploying public 35
    forums and communities 126
Framework Manager
  setting up data sources 58
  testing installation and configuration 67
Framework Manager model
  extract and publish 93
FSR (Financial Statement Reporting), See IBM Cognos Financial Statement Reporting (FSR)

G

Gateway Integration Enabler
  component 8
  glossary 141
  granting
    access permissions 73
  groups
    IBM Cognos Controller 74

H

  histories
    deployment 40
  hosts file
    troubleshooting 129

I

  IBM Cognos authentication 73
  IBM Cognos Configuration
    running in unattended mode 101
IBM Cognos Connection
  importing standard reports packages 88
  troubleshooting missing Controller link 128
IBM Cognos Connection Integration Enabler component 8
  verifying whether installed 128
IBM Cognos Controller components 7
  configuring 18, 87
  connecting from a Web browser 66
  connecting from IBM Cognos Connection 65
  connecting from Microsoft Excel 67
  copying components 99
  default settings 47
  groups 74
  installation options 11
  problems starting 128
  problems starting under VMWare 129
  standard reports package 87, 102
  system requirements 21
  testing connection to database 55
  troubleshooting logons 131
  troubleshooting missing link in IBM Cognos Connection 128
  uninstalling 47, 68
IBM Cognos Controller Configuration 87
IBM Cognos Controller database creating 24
IBM Cognos Controller Link for Microsoft Excel
  access from Cognos FSR 107
  anonymous access 106
  configuring the default installation 97
  installing 57
  troubleshooting 132
  verifying installation 67
  Windows 7 57
IBM Cognos Disclosure Management (CDM)
  integration for Controller 115, 116, 118
IBM Cognos Financial Statement Reporting (FSR)
  accessing Cognos Controller accounts 105
  accessing the Controller account 107
  Controller native authentication 109
  enabling anonymous access 106
  integration for Controller 105
IBM Cognos service
  requirements for the user account that is used for the service 52
  restarting 128
IBM Cognos users
  mapping to Controller users 76
IBM Controller Configuration 18
IBM Redbooks 126
IIS Web server
  single signon with Active Directory 81
import directories
  for flat files 88
importing
  configurations 39
  Controller standard reports package 87, 88, 102
  data into target environment 39
Install
  Financial Analytics Publisher 60
installation
  all components on one computer 11
installation (continued)
  checklist 47
  workflows 17
installation files
  transfer specification file (.ats) 99
installation tools
  running 99
installing
  changing the default for IBM Cognos Controller Link for Microsoft Excel 97
  during an upgrade 43
  IBM Cognos Controller 47
  IBM Cognos Controller Link for Microsoft Excel 57
  Microsoft .NET Framework 28
integrating
  third-party components 7
integration with Cognos Analytics 16
integration with Cognos Business Intelligence 16
Internet Explorer
  browser settings 27
  connecting to IBM Cognos Controller 66
  local intranet settings 108
ISAPI gateway
  starting Cognos Connection 88
J
Java
  verifying client installation 67
Java Runtime Environment (JRE) 49
Java scripts
  enabling in Web browsers 27
JAVA_HOME 24
JDBC driver 51
JDBC drivers
  installing for Controller data mart 51
JRE 24
K
knowledge bases 125
L
load balancing
  for consolidation 14
Load balancing
  IBM Cognos Controller 71
log files
  locale configuration 127
  run-time 127
  startup configuration 127
  transfer 126
  transfer summary 126
  uninstallation 127
logons
  resetting for Microsoft SQL Server database 130
  troubleshooting 130, 131
M
messages
  You are about to navigate away from this page 128
Microsoft .NET Framework
- deleting files in cache 129
- installing 28
- upgrading 42
Microsoft Analysis Server
- namespace requirement 79
Microsoft Analysis Services
- setting up the data source environment 58
Microsoft Excel
- connecting to IBM Cognos Controller 67
- installation of IBM Cognos Controller Link for Microsoft Excel 57
- troubleshooting ControllerXLPusher.dll error 132
Microsoft SQL Server
- creating Controller databases 26, 90
- database connectivity 50
- namespace requirement 79
modifying
- response.ats file 99
moving
- deployment archives 38
Moving from trial upgrade to production environment 41
MSAS,. See Microsoft Analysis Services
multi_domain_tree 80
multiple computer installation 12

N
namespaces
- adding 73
- configuring custom authentication providers 81
- deleting 84
- mapping IBM Cognos users to Controller users 76
native authentication
- integrating with Cognos FSR 105
Netegrity SiteMinder 82
- See also eTrust SiteMinder
network COM+ access
- enabling 65
new features 3
No database configured - error 131

O
ODBC data source 65
OLAP data sources 116
Oracle
- creating Controller databases 26, 90
- creating Controller tablespaces 26, 90
- database connectivity 50
- multilingual support 58
- performance optimization job 88
other products
- upgrading 42

P
packages
- deploying 35
Page cannot be found - error 129
password (continued)
- resetting for Microsoft SQL Server database 130
performance
- Oracle optimization 88
permissions
- deployment 35
- for the user account that is used for the IBM Cognos service 52
- planning an upgrade 31
ports
- default configuration settings 55
Problem Management Reports
- logging 125
PMR, See Problem Management Reports
product versions 48
Public Folders
- deploying 35
Publish to Data Mart model
- extract and publish 93

R
remote installation
- IBM Cognos Controller Link for Microsoft Excel 57, 97
repairing database connections 131
reporting package
- importing 87, 102
reports
- testing before an upgrade 34
response files
- response.ats 99
- using 100
response.ats file
- modifying 99
restarting services 128
roles
- IBM Cognos Controller 74
routers
- configuring 98
running
- configuration tools 99
- installation tools 99

S
Safari 27
security
- configuration 18
security providers 77
server authentication
- IBM Cognos Controller 73
server components
- Controller 7
- server roles 28
- service pack
- installing 48
- service requests
- PMR 125
services
- restarting 128
Set up environment
- Financial Analytics Publisher 61
silent configurations,. See unattended configuration
silent installations, See unattended installations
silent mode, See unattended mode
single computer installations 11
single signon
  enabling 78
  eTrust SiteMinder user directory 84
  for an Active Directory namespace 81
software support and RSS feeds 126
SQL Server databases
  creating Controller databases 26, 90
  resetting logon credentials 130
SSL
eTrust SiteMinder user directory 84
staged upgrade 45
standard reports package
  importing 87, 102
  verifying the import 88
starting
  troubleshooting IBM Cognos Controller 128
  troubleshooting IBM Cognos Controller Financial Analytics Publisher 133
startup configuration 18
statutory financial reports
  data integration 105
studio bar
  troubleshooting missing IBM Cognos Controller link 128
Support Portal 124
supported environments 21
system requirements
  IBM Cognos Controller 47

tables
  creating for Controller database 26, 90
"technotes"
  best practices for searching 124
  troubleshooting
    technotes 124
testing
  deployment 40
  IBM Cognos Controller configuration 65
  IBM Cognos Controller database connection 130
text files
  specify import directories 88
third-party components
  data sources 9
TM1
  create new server 64
  create ODBC data source 65
  install as a windows service 64
  install client 63
transfer specification files (.ats)
  configuration 99
trial upgrade
  planning the move to the production environment 41
troubleshooting
  Cognos Customer Center 125
  forums and communities 126
  getting fixes 125
  IBM Redbooks 126
  identifying problems 123, 124
  logons 131
  MustGather information 124
troubleshooting (continued)
  proven practices documentation 126
  run standard report 132
  software support and RSS feeds 126
  Support Portal 124
  troubleshooting error during Initial Publish 133
  troubleshooting error when upgrading TM1 133

U
UAC (User Account Control)
  installing client applications 57
UDL
  troubleshooting corrupted file 131
  troubleshooting missing file 131
unattended configuration
  setting up 99, 101
unattended installations
  response files 100
  setting up 99
  transfer specification files 99
unattended mode
  running IBM Cognos Configuration 101
uninstalling
  before upgrading 43
  IBM Cognos Controller 47, 68
updater
  installing 48
  updating
    .jar files 49
upgrading
  application databases 44
  create test environment 35
  in a new directory 45
  Microsoft .NET Framework 42
  other products 42
  planning the move from test to production environment 41
  preparation 31
  resources 32
  troubleshooting subsequent problems 129
URI
  default configuration settings 55
User account
  requirements to run the IBM Cognos service 52
User Account Control (UAC)
  installing client applications 57
using
  JDBC driver 51

V
video documentation
  YouTube 125
virtual directories
  setting up 52
VMWare
  problems running ccr.exe file 129

W
warning messages
  You are about to navigate away from this page 128

152
web aliases
   setting up 52
Web browsers
   configuring 27
web server
   configuring 52
web server configuration changes 5
Web servers
   single signon with Active Directory and IIS Web server 81
Web.config file 124
Windows
   system requirements 47
Windows authentication
   enabling 108
   integrating with Cognos FSR 105
workflows
   installation and configuration 17

Y
You are about to navigate away from this page 128

Z
zip file CCR82_DM 93